Lire
la première partie
de la thèse
Chapter 3

Physics and modelling around two supercritical airfoils

Contents

3.1 Shock-vortex shear-layer interaction in transonic buffet conditions ........................................ 51
  3.1.1 Shock-vortex shear-layer interaction in the transonic flow around a supercritical airfoil at high Reynolds number in buffet conditions ........................................ 52
  3.1.2 Upscale turbulence modelling ................................................... 80

3.2 Laminar airfoil ................................................................. 81

In this chapter, the flow around two supercritical airfoils, designed in the context of two different European projects, is analysed near and in transonic buffet conditions.

3.1 Shock-vortex shear-layer interaction in transonic buffet conditions

The OAT15A is a supercritical airfoil designed by ONERA (Jacquin et al., 2005) in the context of the ATAAC European project (same as the tandem of cylinders, chapt. 2). The numerical aspects of the simulations of this test case, as well as some physical properties, in transonic buffet conditions, have been investigated by Fernando Grossi in our research team in the context of a Master’s and a Ph.D. theses (Grossi, 2010, 2014) and have been published in articles (Grossi et al., 2014) as well as proceedings from several oral communications (Grossi et al., 2011, 2012b,a). Enriched from all this work, new simulations have been performed and the physics of the interaction between the main phenomena developing around the airfoil has been analysed by mean of signal processing and proper orthogonal decomposition (POD). From the POD reconstruction, a localised stochastic forcing has been introduced in the transport equations of the initial turbulence model. This method, as well as the
results on the physical analysis, have been the subject of an article accepted in the Journal of Fluids and Structures in March 2015 Szubert et al. (2015b). This article is fully reproduced in this manuscript in the following section to present the results, in addition to details about the geometry and the numerical method. A discussion about the upscale turbulence modelling, in the context of the ensemble-averaged approaches, is given in section 3.1.2.

3.1.1 Shock-vortex shear-layer interaction in the transonic flow around a supercritical airfoil at high Reynolds number in buffet conditions
Shock-vortex shear-layer interaction in the transonic flow around a supercritical airfoil at high Reynolds number in buffet conditions

Damien Szubert\textsuperscript{a}, Fernando Grossi\textsuperscript{a}, Antonio Jimenez Garcia\textsuperscript{a}, Yannick Hoarau\textsuperscript{b}, Julian C.R. Hunt\textsuperscript{c}, Marianna Braza\textsuperscript{a}

\textsuperscript{a} Institut de Mécanique des Fluides de Toulouse, UMR No 5502 CNRS-INPT-UPS, Allée du Prof. Camille Soulé, F-31400 Toulouse, France
\textsuperscript{b} Laboratoire ICUBE, UMR No 7357, Strasbourg, France
\textsuperscript{c} Department of Earth Sciences, University College London, London WC1E 6BT, UK

\textbf{A B S T R A C T}

This paper provides a conceptual analysis and a computational model for how the unsteady ‘buffeting’ phenomenon develops in transonic, low incidence flow around a supercritical aerofoil, the OAT15A, at Reynolds number of 3.3 million. It is shown how a low-frequency buffet mode is amplified in the shock-wave region and then develops upstream and downstream interaction with the alternating von Kármán eddies in the wake past the trailing-edge as well as with the shear-layer, Kelvin–Helmholtz vortices. These interactions are tracked by wavelet analysis, autoregressive (AR) modelling and by Proper Orthogonal Decomposition. The frequency modulation of the trailing-edge instability modes is shown in the spectra and in the wall-pressure fluctuations. The amplitude modulation of the buffet and von Kármán modes has been also quantified by POD analysis. The thinning of the shear layers, both at the outer edge of the turbulent boundary layers and the wake, caused by an ‘eddy-blocking’ mechanism is modelled by stochastic forcing of the turbulent kinetic energy and dissipation, by small-scale straining of the higher-order POD modes. The benefits from thinning the shear-layers by taking into account the interfacial dynamics are clearly shown in the velocity profiles, and wall pressure distribution in comparison with the experimental data.

\section{Introduction}

Understanding the various mechanisms related to buffet instabilities in the transonic flow around a supercritical airfoil is the main objective of this paper. A detailed physical analysis is developed for the interactions between shock waves and the boundary layer over the aerofoil, as well as between wake vortices and the shock waves. A further complexity arises from the interactions between the wake vortices near the trailing edge and the fluctuating sheared interface that bounds the wake flow. Pioneering studies of Levy (1978) and Seegmiller et al. (1978), made evidence of a shock unsteadiness characterised by a low-frequency and high-amplitude, in the Mach number range 0.7–0.8 corresponding to aircraft’s cruise-speed. Several experimental

* Corresponding author.

http://dx.doi.org/10.1016/j.jfluidstructs.2015.03.005
0889-9746/© 2015 Elsevier Ltd. All rights reserved.
and numerical studies have been devoted to this flow phenomenon and its impact on the aerodynamic forces: McDevitt et al. (1976), Jacquin et al. (2005, 2009) and Brunet (2003).

Whereas the majority of the studies devoted to the transonic interaction deal with the high-Reynolds number range, the physical mechanisms of the buffet onset can be studied more easily in the lower Reynolds number range, allowing for Direct Numerical Simulation. For a NACA0012 airfoil, (Bouhadji and Braza, 2003a, 2003b) have analysed the successive states of the unsteadiness due to the compressibility effects in the Mach number range 0.3–1.0 by 2D and 3D Navier–Stokes simulations. The buffet instability was analysed in association with the von Kármán vortex shedding in the Mach number range 0.75–0.85, as well as the suppression of the buffet form Mach numbers beyond 0.85. The buffet mode has also been analysed by DNS of Bourdet et al. (2003), who used in addition the Stuart–Landau model (Landau, 1944) in order to quantify the linear and non-linear parts of the buffet instability.

These studies showed the sharp rise of the drag coefficient as the Mach number increases in the range 0.7–0.8, as well as the interaction of the shock wave with the von Kármán wake instability downstream of the trailing-edge. It was shown that this instability was formed in the wake and propagated towards the trailing-edge beyond a low-subsonic critical value of the Mach number, of order 0.2, for a NACA0012 airfoil at zero incidence and Reynolds number of 10 000 (Bouhadji, 1998). This instability (mode I) persists within the whole transonic speed interval, up to Mach number of order 0.85, independently on the appearance of the buffet. This second instability (mode II) was found to appear in the interval 0.75–0.8 and to strongly interact with mode I, where the buffet was sustained by mode I. Experimental evidence of mode I was made by the Schlieren visualisations of D.W. Holder (Fung, 2002), Fig. 7.

Numerical simulations in the high-Re range (Grossi et al, 2012b; Jimenez-Garcia, 2012), regarding a supercritical airfoil, the OAT15A, introduced a splitter-plate at the trailing edge, which suppressed the von Kármán mode. It was shown that in the cases where the von Kármán mode was remote (downstream of a critical length of the splitter plate), the buffet mode was considerably attenuated and disappeared. Therefore, it is worthwhile analysing the interaction of these two modes in the high-Reynolds number regimes for aerodynamics applications. In particular, there is little knowledge of this kind of interaction in the state of the art with regard to the high-Re range as well as more generally, of the trailing-edge dynamics feedback effect towards the shock-wave/boundary-layer interaction region (SWBLI) upstream of the trailing-edge. Lee (1990) reported a schematic explanation of the buffet interaction with Kutta waves coming from the trailing-edge, without a quantification of this interaction. Furthermore, it is worthwhile mentioning that the SWBLI is followed by separation of the boundary layer and by the formation of thin shear layers at the edges of the boundary layers and in the wake, where local Kelvin–Helmholtz (K–H) instabilities are observed.

In order to compute the interactions and feedback between the shear-layer and trailing-edge instabilities with the upward shock-buffet mode, new methods are needed. These have to overcome the tendency of the shear layers to thicken downstream of the SWBLI, because of the turbulent shear stress modelling near the interface is usually approximated by employing eddy-viscosity concepts based on equilibrium turbulence hypotheses and direct cascade. In the flow physics however, upscale phenomena occur that increase the energy of the turbulence spectrum from intermediate range towards the lower wavenumbers (Braza et al, 2006). These mechanisms are not yet sufficiently taken into account in the modelling equations. However, theoretical analysis (Hunt et al, 2008) and experimental studies (e.g. Ishihara et al, 2015) show that these stresses are generated by the inhomogeneous small-scale motions in the turbulent region near the interface and thence increase the local “conditional” shear and “eddy blocking effect” within the interface layer(Fig. 1). This influence of small scales on the whole flow is effectively an “upscale” process. The local turbulence adjacent to the interface tends to redissolve the Kelvin–Helmholtz instabilities into the Kelvin–Helmholtz–Hopf modes of the interface (Dritschel et al, 1990).

A new approach for modelling the interface regions is needed, which can be based on recent numerical and experimental research into turbulent interfacial shear flows, on the outer edges of jets, wakes and the outer parts of boundary layers with thickness L. The thin randomly moving interfaces which separate regions of strong and weak turbulence have a thickness \( \ell (\propto \xi) \). This general property of turbulent flows was in fact suggested and discussed by Prandtl in 1905, though he did not take it further once he became interested in the mixing length model of the mean properties of turbulent shear flows (see Bodenschatz and Eckert, 2011; Taveira and da Silva, 2014). Within these layers, the average shear (or in 2-dimensions the gradient of shear) is much stronger than that in the adjacent turbulent shear flows. At very high Reynolds numbers Re, determined by L and the R.M.S. turbulent velocity \( u_* \), the thickness \( \ell \) of these interface layers is of the order of the Taylor microscale \( \xi (i.e. L \text{Re}^{-1/2}) \), but within them very thin elongated vortices form with a thickness \( \xi_0 \) of the order of the Kolmogorov microscale (i.e. \( \xi_0 \sim L \text{Re}^{-1/4} \), Eames and Flor, 2011). Numerical simulations show that these sharp interfaces occur even in complex turbulent flows, such as flows over aircraft wings (Braza, 2011).

These interfaces have their own mean local dynamics that keep the mean gradients at the interface at a maximum, through eddy blocking and enhanced vortex stretching (Hunt et al., 2008). Similar bounding interfaces also occur at the edges of patches of turbulence, such as puffs or vortex rings (Holzner et al., 2008). These intensely sheared layers interact with the motions outside the layers by blocking external eddies (through shear sheltering), which leads to a balance between sharpening of the velocity gradients in the layer and the tendency to diffuse outwards (Hunt et al., 2008). The typical spacing between the interfacial layers is of order of the “dissipation integral length scale” (Hunt et al., 2014).

Thus, the overall high-Re dynamics of the interface has to be modelled in order to correctly represent the turbulent transfers through the rotational–irrotational regions either side of these interfaces that have to be kept thin. This modelling has to include the complex interactions between the developing instability modes and the fine-scale turbulence. It is necessary to have a comprehensive turbulence model that should include the effects of the low-frequency organized motion.
and the transfers due to the random turbulence. Such models should take sufficient account of the large and small motion effects, especially the shear–stress gradients as studied at high-Re atmospheric flows by Hunt et al. (1984). The turbulence modelling in the present case should also accurately predict the pressure distribution and the unsteady loads in fluid–structure interaction.

In this context, approaches such as standard URANS, derived from assumptions of turbulence in statistical equilibrium and using downscale cascade, tend to produce higher rates of the turbulence kinetic energy and to underestimate the global coefficients (drag, lift) and their amplitudes (Haase et al., 2009).

The Large Eddy Simulation uses a number of degrees of freedom being orders of magnitude higher than the grid size needed for URANS and hybrid approaches. For moderate Reynolds number flows (Re \(\text{O}(10^6)\)), LES can capture the major instabilities past bodies, whereas for the high-Reynolds number range (Re \(>10^7\)), for industrial designs, it is not practical with typical computational capacity to apply LES for aerodynamic flows around lifting structures. Furthermore, even with LES methods, improvements can be expected by reconsidering the classical downscale energy transfer models for the small-scale eddies in the dissipative wave-number range by using upscale transfer processes in the turbulence modelling of the thin interfaces.

Recent efforts in turbulence modelling are devoted to accurately reproduce the flow physics in respect of instability amplification, strong flow detachment and accurate prediction of the associated frequencies, unsteady loads and in particular, of pressure fluctuations, representing a crucial need for aeroacoustics.

Hybrid RANS-LES methods are quite suitable for this category of fluid–structure interaction problems, because they associate the benefits of URANS in the near-region and those of LES in the regions of flow detachment, as reported the proceedings of the 4th HRLM, ‘Hybrid RANS-LES Methods’ symposium (Fu et al., 2012). Hybrid methods can be considerably improved by using adapted URANS modelling in the near-wall region and adapted LES modelling in the flow detachment areas, in order to allow for modification of the turbulent scales accounting for non-equilibrium turbulence.

In this context, improved URANS approaches can be used to reduce the turbulent viscosity levels and allow the amplification of instabilities, as for example the Scale Adaptive Simulation (SAS; Menter and Kuntz, 2003; Menter and Egorov, 2005), the Organised Eddy Simulation (OES; Braza et al., 2006; Bourguet et al., 2008, among others). SAS adapts the Kolmogorov turbulence scale according to flow regions governed by non-equilibrium turbulence effects. OES accounts for stress–strain directional misalignment in non-equilibrium turbulence regions thanks to a tensorial eddy-viscosity concept derived from Differential Reynolds Stress Modelling (DRSM) projection on the principal directions of the strain-rate tensor.

Although significant conceptual progress has been accomplished in the last decade, there still remain open questions with regard to the quantitative prediction of the above mechanisms with the accuracy required by the design. To our knowledge, the majority of the available modelling approaches produce less thin shear-layer interfaces, even by using considerably fine grids. This is generally due to a higher turbulence diffusion level than in the physical reality, produced by the modelling approaches, which mostly employ downstream turbulence cascade assumptions. In the present paper, the motivation is to enhance the eddy-blocking effect and vortex stretching in the sense of an upscale cascade.

On view of the above elements, the objectives of the present paper are as follows: to analyse in detail the interaction between two main instabilities, the buffet and the von Kármán modes in the transonic flow around a supercritical airfoil, whose configuration is involved in the next generation of civil aircraft design. Designs aim at preserving the advantages of the shock–vortex shear-layer interaction. The content of the following sections is as follows: Section 2 presents the flow configuration and the numerical approach. Section 3 presents the results regarding the buffet instability, its interaction with the shear-layer and near-wake instabilities based on conventional URANS/OES methods. This section includes in particular wavelet analysis and Proper Orthogonal Decomposition. In Section 4, the stochastic forcing approach for the higher modes is presented and compared with other methods and experimental results. Section 5 is the conclusion of the paper.

2. Flow configuration, numerical method and turbulence modelling

2.1. Test case description

The transonic buffet over the OAT15A airfoil was investigated in the experimental work by Jacquin et al. (2005, 2009), as well as by Brunet et al. (2003), by means of both experimental and numerical study at free-stream Mach numbers in the range of 0.70–0.75 and a chord-based Reynolds number of 3 million. The OAT15A is a supercritical wing section with a thickness-to-chord ratio of 12.5%. The wind tunnel model has a chord of \(C=0.23\) m and a blunt trailing edge measuring 0.005C. The airfoil was mounted wall-to-wall and the boundary layer was tripped on both sides at \(x/C = 0.07\) from the leading edge for fully-turbulent behavior. The results showed that a periodic self-sustained shock-wave motion (buffet) was obtained for angle of attack values higher or equal to 3.5°. A detailed experimental study, for this angle of attack, is reported in Jacquin et al. (2009). The main flow features concerning buffet were essentially two dimensional, and the buffet frequency was found 69–70 Hz. The shock-wave motion was coupled with an intermittent separation of the boundary layer. In the present study, this flow configuration is considered in two dimensions at an incidence of 3.5° and a free-stream Mach number of 0.73, in order to analyse the buffet onset and the interaction with the near-wake instability.
2.2. Numerical method

The simulations of the OAT15A configuration have been carried out with the Navier–Stokes Multi-Block (NSMB) solver. The NSMB solver is the fruit of a European consortium that included Airbus from the beginning of ‘90s, as well as main European aeronautics research Institutes, as KTH, EPFL, IMFT, ICUBE, CERFACS, Univ. of Karlsruhe, ETH-Ecole Polytechnique de Zurich, among others. This consortium is coordinated by CFS Engineering in Lausanne, Switzerland. NSMB is a structured code that includes a variety of efficient high-order numerical schemes and of turbulence modelling closures in the context of LES, URANS and of hybrid turbulence modelling. A first reference of the code description can be found in Vos et al. (1998) concerning the versions of this code in the decade of ‘90s. Since then, NSMB highly evolved up to now and includes an ensemble of the most efficient CFD methods, as well as adapted fluid–structure coupling for moving and deformable structures. These developments can be found in Hoarau (2002) regarding URANS modelling for strongly detached flows, Martinat et al. (2008), in the area of moving body configurations, Barbut et al. (2010) and Grossi et al. (2014) allowing for Detached Eddy Simulation with the NSMB code.

NSMB solves the compressible Navier–Stokes equations using a finite-volume formulation on multi-block structured grids. In 3D cartesian coordinates \((x, y, z)\), the unsteady compressible Navier–Stokes equations can be expressed in conservative form as

\[
\frac{\partial W}{\partial t} + \frac{\partial f}{\partial x} + \frac{\partial g}{\partial y} + \frac{\partial h}{\partial z} = 0,
\]

where \(t\) denotes the time. The state vector \(W\) and the inviscid fluxes \(f\), \(g\) and \(h\) are given in the following for the laminar model:

\[
W = \begin{pmatrix}
\rho \\
\rho U \\
\rho V \\
\rho W \\
\rho E
\end{pmatrix}, \quad
f = \begin{pmatrix}
\rho U \\
\rho U^2 + p \\
\rho UV \\
\rho UW \\
U(\rho E + p)
\end{pmatrix}, \quad
\begin{pmatrix}
\rho V \\
\rho UV \\
\rho V^2 + p \\
\rho VW \\
V(\rho E + p)
\end{pmatrix}, \quad
\begin{pmatrix}
\rho W \\
\rho VW \\
\rho W^2 + p \\
W(\rho E + p)
\end{pmatrix}.
\]

Fig. 1. Schematic diagram of shock, shear-layer and wake dynamics, including SWBLI, showing how the shear layer of the interface remains thin as a result of eddy-blocking mechanism.

Fig. 2. Comparison of spectra of pressure signal for 2 different time steps; left: \(\Delta t = 10^{-6}\) s; right: \(\Delta t = 0.5 \times 10^{-6}\) s.
Here $\rho$ is the density, $U$, $V$ and $W$ are the cartesian instantaneous velocity components, $p$ is the pressure and $E$ is the total energy. The viscous fluxes are defined as

$$
\begin{align*}
\mathbf{f}_v &= \begin{pmatrix} 0 \\ \tau_{xx} \\ \tau_{yx} \\ \tau_{xz} \\ \tau(U)_x - q_x \end{pmatrix}, \\
\mathbf{g}_v &= \begin{pmatrix} 0 \\ \tau_{yy} \\ \tau_{yx} \\ \tau_{yz} \\ (\tau(U)_y - q_y) \end{pmatrix}, \\
\mathbf{h}_v &= \begin{pmatrix} 0 \\ \tau_{zz} \\ \tau_{yz} \\ \tau_{zz} \\ (\tau(U)_z - q_z) \end{pmatrix},
\end{align*}
$$

where $\tau_{ij}$ are the components of the stress tensor, $q_i$ the heat flux (Fourier’s law) and the work due to the viscous dissipation is expressed as $(\tau(U)_i = \tau_{xi} U + \tau_{yi} V + \tau_{zi} W$.

The third-order of accuracy Roe upwind scheme (Roe, 1981) associated with the MUSCL van Leer flux limiter scheme (van Leer, 1979) is used to discretize the convective fluxes. Implicit time integration using the dual time stepping technique with 3 Gauss–Seidel iterations has been performed. A physical time step of 0.5 $\mu$s has been adopted ($\approx 5 \times 10^{-6} C/\sqrt{U_\infty}$) after detailed tests carried out in Grossi (2010).

A study of the time step has been carried out with the grid used in this study. The Power Spectral Density (PSD) of the pressure signal on the airfoil at the location $x/C = 0.45$ for two time steps are shown in Fig. 2. The PSD spectrum on the left has been obtained from a calculation with a time step $\Delta t = 10^{-6}$ s, while the spectrum on the right comes from a calculation with a time step twice smaller and used in this study. A very similar distribution of the PSD can be observed in terms of frequency as well as of the energy level. A typical number of 30 inner iterations was necessary for the convergence in each time step. The convergence criterion at the inner step $n$ is defined by the ratio between the $L_2$-norm of the density equation residual at the inner step $n$ and the one at the initial inner step. The methodology adopted in the simulations is the same as in Grossi et al. (2014).

The grid has a C–H topology. Two different grids had been compared in previous studies (Grossi, 2014). The first is of size 110 000 cells approximately, used by Deck (2005) and provided within the partnership in the ATAAC (Advanced Turbulence Simulations for Aerodynamic Application Challengers) European program No. 233710 and a second, finer grid built in our research group, having 130,000 cells and a domain size of 80 chords. A comparison of these two grids is provided in Fig. 3. The mean value of the pressure coefficient (Fig. 3 left) and the RMS pressure distribution over the airfoil (Fig. 3 right) are very similar for the two grids. The buffet frequency is practically unchanged. The second grid has been used for the present

![Fig. 3. Grid comparison concerning the mean wall-pressure coefficient (left) and the normalized RMS of the pressure fluctuations (right); experiment by Jacquin et al. (2009).](image)

![Fig. 4. Multiblock domain.](image)
study. The $y^+$ coordinate regarding the turbulence modelling near the wall is smaller than 0.5 in the whole domain. Fig. 4 shows the grid and the computational domain.

2.2.1. Boundary conditions

On the solid wall, impermeability and no-slip conditions are employed. The far-field conditions are characteristic variables with extrapolation in time, defined by means of the experimental upstream values, the total pressure ($P_0 = 10^5$ Pa) and total temperature ($T_0 = 300$ K), as well as the upstream Reynolds number of 3 million. The upstream turbulence intensity is set equal to the experimental value of $Tu = 1\%$.

2.3. Turbulence modelling

Based on previous studies in our research group which examined the predictive ability of various turbulence models (Grossi et al., 2011, 2012a; Grossi, 2014), it was shown that the two-equation $k-\epsilon$ SST model (Menter, 1994) was not able to produce any unsteadiness at the present incidence value. The Spalart-Almaras model (SA; Spalart and Almaras, 1994) in its standard version, and its Edwards and Chandra variant (SA-E; Edwards and Chandra, 1996) with compressibility correction of Secundov (SA-E + CC; Shur et al., 1995; Spalart, 2000), underpredicted the amplitudes of the shock motion, even by tripping the flow at $x/C = 0.07$ like in the experiment (trip), which does not have a significant effect on the flow. The strain adaptive formulation of the Spalart–Almaras model (SALSA; Rung et al., 2003) gave good amplitudes but no secondary oscillations. The $k-\epsilon$-OES model (Braza et al., 2006; Bourguet et al., 2008) involving in the present study an eddy-diffusion coefficient $C_{\mu} = 0.03$, was able to produce the shock unsteadiness with a frequency close to the experimental one. Moreover,
3.1. Shock-vortex shear-layer interaction in transonic buffet conditions

The formation of secondary oscillations within the buffet cycles, mainly due to intermittent von Kármán vortex shedding, has been captured. These results can be observed in Fig. 5 for the evolution of the lift coefficient and in Fig. 6 for the evolution of the pressure versus time at $x/C = 0.45$. The latter is compared with the experimental results from Jacquin et al. (2009) where the secondary oscillations are visible both in experiment and in the simulation with the $k-\varepsilon$-OES model.

3. Results

3.1. Buffet phenomenon and trailing-edge instabilities

According to the OES method, the resolved turbulence corresponds to an ensemble-averaged flow evolution, representing the organised, coherent part of the flow. A first overview of the buffet phenomenon and of the shear-layer and trailing-edge instabilities is represented in Fig. 8, by means of the velocity divergence field $(\nabla \cdot \mathbf{U} = \partial_x U + \partial_y V + \partial_z W)$, which highlights compressibility effects around the airfoil and illustrates density gradients similar to the Schlieren visualizations. A qualitative similarity of the physical phenomena (shock waves, shock foot, wake) observed in the Schlieren visualization, for the experiment, by D.W. Holder (Fung, 2002; Fig. 7), and the field of divergence of velocity, for the CFD, is provided by the figures.

In the present study, the dimensionless time is $t^* = tU_\infty/C$. Furthermore, $t^* = 0$ was set to the maximum lift phase, with the shock wave at its most downstream position, as illustrated in Fig. 8(a). At that moment, in addition to the separation bubble at the foot of the shock, rear separation is also developed. These two regions grow simultaneously and fuse into a large separation area extending from the foot of the shock to the trailing edge. This scenario coincides with the well developed shock-wave motion towards the upstream direction, represented in Fig. 8(b). This figure shows the presence of a von Kármán instability, which quickly gives rise to alternate vortex shedding. In addition, Kutta-type waves are generated at the trailing edge of the airfoil and move upstream, at both sides of the airfoil. Upside, waves are refracted by the shock wave (Fig. 8(e)). As the shock moves towards the leading edge, the thickness of the separated region increases progressively, causing a dramatic decrease of the lift coefficient. As the shock wave comes towards its most upstream positions, the boundary layers becomes more and more detached. At the most upstream position (Fig. 8(f)), the reattachment process starts and reaches full reattachment while the shock is moving downstream (Fig. 8(g)), until $x/C = 0.60$ approximately (Fig. 8(h)). The alternate vortex shedding practically disappears, and the trailing-edge waves generation is temporarily attenuated, until the shear layer thickens again for a new cycle of buffeting.

The transonic flow around the symmetric NACA0012 airfoil (Bouhadji and Braza, 2003b), where a shock wave is observed on both upper and lower sides of the body, is cited in the introduction in order to comment the interaction between the buffet and the von Kármán modes. In the buffet regime ($M = 0.80$), the boundary layers downstream of the shock waves are alternately separated, inducing a thicker effective obstacle between the two separated shear layers that generates significant vorticity gradients in the trailing-edge region and hence creates the von Kármán mode. In the case of the supercritical OAT15A airfoil, at a slight angle of attack (3.5–3.9°), only one supersonic region exists at the upper side. In the buffet regime, the sequence of detachment and attachment still exists but only for the suction side. While the boundary layer is attached, the effective obstacle including the viscous region is thin enough to attenuate the vortex shedding which is only significant when the boundary layer is separated. It can be noted therefore that the shock wave, which thickens the boundary layer and the separated shear layers, creates favorable conditions for the von Kármán mode development, but this can happen even without buffet. In Bouhadji and Braza (2003a), where the successive stages of the von Kármán instability are analysed within a large Mach number interval including no-buffet and buffet regimes, the vortex shedding is developed according to the amplification of the von Kármán instability in the wake, as a result of the adverse pressure gradient due to the shape of the body, even without buffet appearance. Furthermore, at high Reynolds numbers ($1.4 \times 10^6 \leq Re \leq 50 \times 10^6$), the von Kármán mode amplifies under similar conditions past a hydrofoil (incompressible flow; Bourgoyne et al., 2005). However,
the buffet motion in the OAT15A test case thickens the boundary layer and hence favorizes the von Kármán mode appearance. The buffet also produces intermittently a thinning of the boundary layer when the shock moves downstream and leads to the intermittent disappearance of the von Kármán mode. Therefore, it can be mentioned that the buffet does not cause directly the von Kármán mode but it helps its appearance and disappearance.

3.2. Dynamic interaction between large-scale low-frequency shock motion and smaller-scale higher-frequency vortices

The buffeting process is analysed in more detail in terms of signal processing. Pressure signals containing 21 buffet periods and approximately 271 000 samples, have been recorded at the airfoil surface, as in the experiment of Jacquin et al.
In the present study, probe positions have been added in the wake, up to one chord downstream of the trailing edge. The sampling rate is $10^{6}$ s. The signals are plotted in Fig. 9 for 5 buffet periods, at 6 positions from $x/C = 0.10$ to $x/C = 2.00$, and along $y/C = 0.03$ in the wake.

Upstream of the SWBLI, large-scale periodic oscillations corresponding to the buffet instability are obtained. At farther downstream positions, this mode is amplified, and secondary oscillations at a higher frequency appear. These oscillations, mainly generated near the trailing edge of the airfoil, reach a maximum amplitude in the near-wake at $x/C = 1.20$, and can be also observed in the div($U$) field (Fig. 8). A significant part of these oscillations corresponds to a von Kármán mode, as will be discussed in the next section (Figs. 11 and 12). This mode presents a frequency modulation, due to the interaction with the trailing-edge and ambient turbulence, as highlighted by spectral analysis.

3.2.1. Spectral analysis

The mentioned instabilities and their interactions are studied by a spectral analysis and a time-frequency study using wavelets and auto-regressive (AR) modelling, allowing for frequency variation versus time. The spectra of the pressure fluctuations signals at four positions from $x/C = 0.10$ to $x/C = 2.00$ are presented in Fig. 10. The power spectral density is calculated by the Welch’s overlapped segment averaging estimator in order to reduce the variance of the periodogram.
An overlapping of 80\% is applied on segments of size 60\% of the total length of the signal. Each segment is filtered by a Hanning window, and zero padding is used such that the number of samples on which the PSD is calculated equals to $2^n$.

All the spectra show the appearance of the buffet frequency, at $f_B = 78.1$ Hz ($St = fC/U_{\infty} = 0.075$), and its harmonics. In the experiment, this frequency was equal to 69 Hz ($St = 0.066$). At the most upstream position ($x/C = 0.10$), the spectrum does not display any predominant frequency beyond 4000 Hz. Farther downstream ($x/C = 0.45$), the spectrum displays a more significant spectral amplitude and more rich turbulence content in the area beyond 4000 Hz. This occurs because of the influence of the separated region downstream of the SWBLI. At this position, the spectrum can be compared with the experimental results (Jacquin et al., 2009, Fig. 10). In the range of frequencies available on the spectrum from the experiment, both spectra are similar in terms of the buffet frequency and its harmonics, although the shape of the peaks are different, which is due to the number of buffet periods (order of 20) in the numerical study which is less than in the experimental study.

At this farther downstream position, the main mode is amplified and secondary oscillations at a higher frequency appear. This phenomenon becomes more pronounced for positions near the trailing edge ($x/C = 0.90$) and in the near-wake ($x/C = 1.20$; see Fig. 8). At $x/C = 0.90$, the power spectral density distribution can be compared with other URANS simulations (Brunet et al., 2003, Figs. 11 and 18). The comparison of the spectral peak amplitude and their frequency are close between the present study and the above reference. A frequency peak appears at around 2600 Hz ($St = 2.5$). This peak becomes more pronounced at $x/C = 1.20$.

We can show that this frequency corresponds to the von Kármán vortex shedding. Fig. 11 presents snapshots of the vorticity field taken at four equidistant time intervals in respect of the period 1/2600 s. These fields clearly show the alternating von Kármán vortex shedding and the periodicity of the vortex pattern from $t = 0.00962$ s to $t = 0.01$ s. In order to quantify the frequency of this vortex shedding, a tracking of the vorticity values versus time has been carried out at the locations 1 and 2 (see Fig. 11) during one buffet period. The vorticity signals and their spectra are presented in Fig. 12, where a bump is identified at 2600 Hz. This fact insures the identification of a von Kármán mode at the present frequency.

The peak localized at 2600 Hz in the spectra of the pressure signals is characterised by a spreading of frequencies (spectral ‘bump’). This is mainly due to a strong interaction of the von Kármán mode with the trailing-edge unsteadiness (appearance of grey fringes related to Kutta waves in the $\text{div}(U)$ plots, Fig. 8) and to the turbulent motion. This spectral region is studied in more details in the next section, by means of time–frequency analysis.

Moreover, the Kelvin–Helmholtz vortices shown in Fig. 8(c) in the detached shear layer downstream of the shock foot can be identified by tracking them during the time-interval of 0.24 $\mu$s. Their convection velocity has been assessed of order
202 m s⁻¹, as well as their wavelength, \( \lambda \), of order \( 1.9 \times 10^{-2} \) m. From these parameters, their shedding frequency has been assessed of order \( 10^4 \) Hz (St = 0.5) from the relation \( U_{\text{conv}} = \frac{\lambda}{f} \). This is higher than the von Kármán frequency. By considering the energy spectrum at \( x/C = 1.20 \) and \( y/C = 0.03 \) with suitable window size and zero padding in order to better visualize the region of frequencies around \( 10^4 \) Hz (Fig. 13), a predominant frequency peak at \( 10^4 \) Hz can be identified, which corresponds to the Kelvin–Helmholtz shedding frequency.

As previously mentioned, the buffet frequency is found 78.1 Hz in the current study, while the vortex shedding frequency is about 2600 Hz when this phenomenon is well established. The ratio of these two frequencies is 33.29. The closest buffet harmonic regarding the von Kármán peak is \( 78.1 \times 33 = 2577 \) Hz. This frequency slightly varies inside each buffet cycle, and from a cycle to another, which produces the bump observed in the spectra around 2600 Hz. This increases the uncertainty of this frequency value. As shown in the spectrum of Fig. 14, the higher buffet harmonics “merge” with the von Kármán subharmonics. This interaction is difficult to analyze because the amplitudes of these higher harmonics and subharmonics are somehow “hidden” in the continuous part of the spectrum between the two events, the buffet and the von Kármán frequency peaks.

It is recalled that the present study aims at analyzing the trailing-edge instabilities in association with the buffet mode. The fluctuations related to the von Kármán instability appear less explicitly in the spectra in Jacquin et al. (2009), Deck (2005), as well as in Thiery and Coustols (2005) and Brunet et al. (2003), because the main objective of these studies focused on the buffet phenomenon. Indeed, these studies measure the pressure fluctuations on the airfoil wall, with the most downstream position of the measurements located at \( x/C = 0.90 \), where the level of the von Kármán fluctuations is still very small and the experimental spectrum cut-off is lower than the expected von Kármán frequency, captured by the present numerical study, which displays existence of a spectral bump region around a predominant frequency of order 2600 Hz (Fig. 10, see spectrum at \( x/C = 0.90 \)). As has been previously shown, this frequency corresponds to the alternating vortex shedding in respect of the von Kármán mode. In this figure, concerning a more downstream position in the wake, \( x/C = 1.20 \), this spectral bump clearly appears.
In Fig. 20 of the experimental study by Jacquin et al. (2009), which displays four instants of the phase-averaged longitudinal velocity field, there is no proof of vortex shedding as identified in our study. This can be explained because a section of the wake is not visible due to the experimental setup, and also because the phase averaging, based on the buffet cycle, may have erased the marks of the vortex shedding, which has a frequency more than 30 times higher than the buffet one, and a phase which is not synchronized with the buffet. Figs. 15 and 16 of the present study show the instantaneous and the phase-averaged longitudinal velocity fields respectively, at four phases of the buffet cycle, similarly to the experimental results of Jacquin et al. (2009). These figures show the periodic motion of the accelerated region due to the buffet, as well as the boundary-layer detachment. In fact, the von Kármán vortices are visible in the instantaneous fields using a similar color scale as in the experimental results, but they are attenuated after phase-averaging over two buffet periods only (Fig. 16).

Regarding Fig. 12 of Deck (2005) that displays the divergence of the velocity field, the color scale can be adapted in order to highlight the vortex shedding structures, as the divergence of velocity is much smaller within the vortices than in the area of the shock wave and Kutta waves. However, an alternating pattern can be distinguished in this figure too. If the above mentioned studies had been interested in the near-wake region and under the condition that the experimental and numerical grids be sufficiently fine in the wake, they would have been able to capture the von Kármán instability too. However, this was not an objective of the mentioned studies. An evidence of the existence of the von Kármán mode in these experiments can be seen in the appearance of secondary fluctuations observed in the experimental measurements of the time evolution of the pressure at $x/C = 0.45$ (Jacquin et al., 2009, Fig. 8). If the spectrum of Fig. 10 in Jacquin et al. (2009) would display a frequency range beyond $10^3$ Hz, the von Kármán mode would also appear. This mode is characterised by a spectral bump, showing that it is subjected to the influence of other, more chaotic events in the time-space evolution. Moreover, small vortices in the trailing-edge region have been measured by Brunet et al. (2003), in URANS simulations of the OAT15A test case, but at a higher angle of attack ($\alpha = 5^\circ$). Their signature seems to appear as a spectral bump in Fig. 11 of this reference. These vortices can also be observed in the Schlieren visualization in Fig. 7. Von Kármán vortices were also reported in several experiments on subsonic compressible flows around airfoils (Alshabu and Olivier, 2008; Fung, 2002) as well as in the direct simulation of transonic buffet at lower Reynolds numbers by Bouhadji and Braza (2003b) and Bourdet et al. (2003).
3.2.2. Time–frequency analysis

The pressure signal in the wake at $x/C = 1.20$, a position where the amplitude of the secondary instabilities is maximum, corresponding to the bursts formed in the pressure evolution and to the spectral “bumps” (Figs. 9 and 10 respectively), are governed by the von Kármán mode and instabilities mainly coming from the trailing edge and the shear layers. This signal is filtered by a high-pass filter with a cutoff frequency of 1577 Hz, by means of Fast Fourier Transform (FFT). The filtered pressure signal, shown in Figs. 17 and 18, designated as $P_f$ (f standing for filtered), is reconstructed by the inverse FFT. The physical phenomena whose frequency is higher than 1577 Hz are conserved. The remaining signal shows now more clearly the buffet effect on the higher-frequency phenomena within each buffet cycle (burst). Each burst contains an order of 15 counter-rotating vortex-shedding pairs, as well as time intervals where the vortex shedding is considerably attenuated. The instability evolution within the burst is studied by means of time–frequency analysis, carried out by a continuous wavelet transform, and segmentation of the filtered signal. The complex Morlet wavelet (Grossmann and Morlet, 1984) is used to

![Image](image_url1)

**Fig. 15.** Instantaneous longitudinal velocity at 4 phases of a buffet cycle: (a) shock upstream; (b) shock moving downstream; (c) most upstream position of the shock; (d) shock travelling upstream.

![Image](image_url2)

**Fig. 16.** Phase-averaged longitudinal velocity at 4 phases of a buffet cycle: (a) shock upstream; (b) shock moving downstream; (c) most upstream position of the shock; (d) shock travelling upstream.

3.2.2. Time–frequency analysis

The pressure signal in the wake at $x/C = 1.20$, a position where the amplitude of the secondary instabilities is maximum, corresponding to the bursts formed in the pressure evolution and to the spectral “bumps” (Figs. 9 and 10 respectively), are governed by the von Kármán mode and instabilities mainly coming from the trailing edge and the shear layers. This signal is filtered by a high-pass filter with a cutoff frequency of 1577 Hz, by means of Fast Fourier Transform (FFT). The filtered pressure signal, shown in Figs. 17 and 18, designated as $P_f$ (f standing for filtered), is reconstructed by the inverse FFT. The physical phenomena whose frequency is higher than 1577 Hz are conserved. The remaining signal shows now more clearly the buffet effect on the higher-frequency phenomena within each buffet cycle (burst). Each burst contains an order of 15 counter-rotating vortex-shedding pairs, as well as time intervals where the vortex shedding is considerably attenuated. The instability evolution within the burst is studied by means of time–frequency analysis, carried out by a continuous wavelet transform, and segmentation of the filtered signal. The complex Morlet wavelet (Grossmann and Morlet, 1984) is used to
analyse two buffet periods:

\[ \psi(t) = \frac{1}{\sqrt{4\pi}} e^{2\text{in}(\pi f_0 - t^2/2)}, \]

where \( f_0 \) is the central frequency of the wavelet.

The wavelet transform coefficients are defined as

\[ C(a, b) = \frac{1}{\sqrt{a}} \int_{-\infty}^{\infty} x(t) \psi^* \left( \frac{t - b}{a} \right) \, dt \]

where \( a \) and \( b \) are the scaling (in frequency) and the location (in time) parameters of the wavelet respectively, \( x(t) \) the signal and \( \psi^* \) is the complex conjugate of the wavelet. The absolute value of these wavelet transform coefficients, \( |C|^2 \), is plotted in Fig. 17. The scalogram allows analysing in more details the evolution of the vortex shedding frequency versus time inside each buffet cycle. When the shock starts moving upstream (Fig. 8(b)), the vortices are shed at a frequency of 4000 Hz with low amplitudes (see beginning of the burst Fig. 17). Afterwards, this frequency diminishes to reach 2600 Hz, which is the von Kármán frequency observed in the spectra. The vortex shedding is then well established within the burst and is maintained until the shock reaches its most upstream position (see evolution of the shock motion, Fig. 8(c)–(f)). Next, the generated vortices become smaller (Fig. 8(g)) and the shedding frequency increases to reach again the initial value of 4000 Hz, before this phenomenon be significantly attenuated and vanish while the shock moves downstream and the boundary layer becomes attached (Fig. 8(h)–(a)). This frequency modulation, associated with the location and size of the alternating vortices versus time, is linked to the spectral bump appearance around the von Kármán mode (Fig. 10). The repetitiveness of this modulation is clearly observed in the scalogram. The first harmonic is also present with the same modulation. Fig. 18 presents the frequency variation of the pressure coefficient versus time during one buffet period, by using the Yule–Walker autoregressive (AR) model. This kind of model conceptually ensures a high accuracy in the estimation of the frequency values versus time (Braza et al., 2001). The Yule–Walker equations, obtained by fitting the autoregressive
linear prediction filter model to the signal, by minimizing the forward prediction error in the least squares sense, are solved by the Levinson–Durbin recursion (Durbin, 1960). This method is applied with an AR order of 210 on a signal including a one burst cycle. 14 952 samples are used and the signal is segmented in windows of 1153 points. The fundamental frequency of each segment is obtained by calculating the PSD of the modelled signal, using zero-padding giving \(2^{10}\) samples. The result of this method shows the same frequency modulation during the vortex shedding occurrence, as in case of the continuous wavelet transform.

In the next section, a POD analysis is presented which includes additional aspects of the interaction among the buffet, the von Kármán and the smaller-scale higher-frequency vortices, especially those of the shear layers.

### 3.2.2. Proper orthogonal decomposition

Based on the time-space solution from the previously mentioned simulations, a proper orthogonal decomposition (POD) has been carried out on the ensemble-averaged flow-fields, based on the separable POD method in respect of space and time (Sirovich, 1990; Aubry et al., 1991), as presented in the following relations. The POD modes are evaluated from a series of successive snapshots, which include in the present case 10 buffet periods. 646 snapshots, recorded by using a sampling rate of \(10^{-5}\) s, are used per buffet period. As the first POD mode corresponds to the time-averaged solution contained in the data, the POD modes from order 2 correspond to the fluctuating part of the velocity fields:

\[
\mathbf{U}(x, t) = \mathbf{U}(x) + \mathbf{u}(x, t) = \mathbf{U}(x) + \sum_{n=2}^{N_{POD}} a_n(t) \phi_n(x),
\]

where \(\mathbf{U}\) and \(\mathbf{u}\) denote the mean and fluctuating parts of the velocity, respectively. The fluctuation mainly includes the effects of the buffet, von Kármán and shear-layer instabilities. This fluctuation includes the following contributions:

\[
\mathbf{u}(x, t) = \mathbf{\bar{u}}(x, t) + \mathbf{\hat{u}}(x, t) + \mathbf{\tilde{u}}(x, t),
\]

where \(\mathbf{\bar{u}}\) is the phase-averaging, \(\mathbf{\hat{u}}\) is the downscale contribution of the fluctuation, and \(\mathbf{\tilde{u}}\) is the upscale one. Following a simple algebraic development for the decomposed phase-averaged Navier–Stokes equations, it can be shown that the new turbulent stresses contain a downscale part: \(\langle \mathbf{\hat{u}} \mathbf{\hat{u}} \rangle\), and a cross term: \(\mathbf{R}_g = \langle \mathbf{\bar{u}} \mathbf{\tilde{u}} \rangle + \langle \mathbf{\tilde{u}} \mathbf{\hat{u}} \rangle\). As will be discussed in the next section, \(\mathbf{R}_g\) will be modelled by a stochastic forcing. At this stage, a major contribution is due to the downscale term.

The normalized shape-functions \(\phi_n\) are spatially orthogonal, while the temporal coefficients \(a_n\) are uncorrelated in time:

\[
\langle \phi_i, \phi_j \rangle = \delta_{ij} \quad \text{and} \quad \sigma_{\phi_i} = \delta_{ij} \lambda_i
\]

The brackets and overbar indicate spatial integration and temporal averaging, respectively. \(\lambda_i\) is the eigenvalue of mode \(i\). \(\delta_{ij}\) is the Kronecker delta. The POD modes \(\phi_n\) are obtained as the eigen-modes of the two-point correlation matrix:

\[
\mathbf{C}_0 = \mathbf{u}(x, t) \cdot \mathbf{u}(x, t)
\]

where \(\mathbf{C}_0\) is the Kronecker delta. The POD modes \(\phi_n\) are obtained as the eigen-modes of the two-point correlation matrix:

\[
\mathbf{C}_0 = \mathbf{u}(x, t) \cdot \mathbf{u}(x, t)
\]

The eigenvalue \(\lambda_n\) represents the contribution of the corresponding POD mode to the total fluctuating energy:

\[
\left( \mathbf{u}(x, t) \cdot \mathbf{u}(x, t) \right) = \sum_{n=1}^{N_{POD}} \lambda_n
\]

Fig. 19 shows the energy of the POD modes as a function of the mode order. There is an energy decrease towards the higher modes. The decrease rate is slower than in DNS cases (El Akoury et al., 2008), because of the random turbulence effect, modelled by the solved transport equations. In the log–log energy diagram, a “plateau” followed by a slope change is observed. This feature represents the contribution of the organised motion and of the random turbulence effect, which
becomes more pronounced, as the mode order increases. A similar behaviour was reported in experimental studies by Perrin et al. (2006).

The POD analysis allows extracting the most energetic modes (Fig. 20) which can reconstruct the main features of the interaction between the buffet and the downstream region as shown in the following. The modes 2 and 3 of the streamwise velocity \( U \) illustrate the buffet phenomenon and the boundary-layer intermittent detachment (Fig. 20).

Modes 4 and 5 clearly illustrate the von Kármán motion. A complex interaction among the buffet region (shock), the shear layer past the SWBLI and the von Kármán mode past the trailing edge is shown by means of the higher order modes. This interaction leads to creation of a more pronounced chaotic process (modes 6 and 7), because the frequencies of the mentioned instabilities are incommensurate. Furthermore, the von Kármán mode iso-contour levels affect also the shock-motion region (modes 4–9).

The temporal POD coefficients are shown in Fig. 21. They are in accordance with the spatial mode behaviour. As the order of the modes increases, a filling-up of the temporal coefficient signal by higher frequencies is noticed, showing the increasing complexity of the dynamic system, due to turbulence.

The energy spectra of the temporal POD coefficients for modes 2–9 are presented in Fig. 22. The first spectrum indicates the buffet frequency as a predominant one and confirms the fact that mode 2 is associated with this instability. The POD modes higher than 3 start progressively to be affected by the von Kármán instability, as shown also in the spatial distribution of these modes, Fig. 20. The amplitude of the von Kármán instability (Fig. 22) increases for modes 4 and 5, to reach a practically invariant level in the higher mode spectra. Simultaneously with this variation, the buffet instability amplitude decreases on the spectra and its harmonics slightly increase but the global level of the buffet instability amplitude remains lower than in case of the third POD mode. Therefore, in the mode ranges 4 and 5, the spectral amplitudes of the von Kármán and of the buffet become comparable.
From the dynamic system theory point of view, a non-linear interaction between two incommensurate instability modes that are rather close in terms of frequency produces linear combinations of these two modes in the energy spectrum (Newhouse et al., 1978; Guzmán and Amon, 1994). In the POD spectrum of mode 2 (Fig. 22), the interaction between the higher buffet harmonics and the von Kármán subharmonics is more visible, because these two sets are neighbours. We can detect for example a predominant frequency bump, $f_{i1}$, which can be expressed as
$$f_{VK} = \frac{2}{C_0} f_B.$$ Moreover, a second interaction can be extracted, $f_{i2} = \frac{2}{C_0} 8 f_B$. These interactions, as in the aforementioned papers, do not considerably change the frequency values of the instability modes (buffet and von Kármán). They rather change the amplitudes of these modes, which become comparable between the buffet mode and the von Kármán, as shown in Fig. 22 (spectra of POD modes 4 and 5, as well as spectra of POD modes 6 and 7). This illustrates a way the buffet mode is affected by the shedding mode and vice-versa.

The spectra of modes 12 and 13 are presented in Fig. 23. They show a broadening of the von Kármán area associated with the interaction between smaller-scale higher-frequency vortices (as for example the K–H around $10^4$ Hz) and more chaotic turbulence effects. This fact persists for all the higher order modes. The corresponding spectra are plotted in Fig. 27 and they confirm this observation.
Based on the present discussion, the POD analysis illustrates in a complementary way the interaction between the buffet and the von Kármán modes as well as with the higher frequency structures, by means of the mode shape and the temporal coefficients amplitude modulations, as well as by the appearance of new frequency peaks in the spectra combining these instabilities.
3.1. Shock-vortex shear-layer interaction in transonic buffet conditions

Furthermore, the POD analysis illustrates the signature of the Kelvin–Helmholtz vortices (Figs. 24–26). In the 12th and 13th POD mode fields, the development of the lower shear-layer structure past the trailing edge can be observed. In the 24th and 26th mode fields, the impact of the upper shear-layer vortices can be seen. The higher POD modes (Fig. 26) influence all the high shearing rate regions, including also the shock area. Therefore, these figures show the filling of the shear layers by smaller-scale structures and illustrate their interactions with the shock-motion area. Indeed, the iso-contour levels of these smaller structures fill up the shock-motion region (Figs. 25 and 26).

4. Stochastic forcing by means of POD

The shear-layer interfaces between the turbulent and non-turbulent regions are now considered in association with those POD modes which particularly affect these areas as previously discussed. In order to maintain these interfaces thin and to limit the turbulent diffusion effect due to the direct cascade modelling assumptions, a small amount of kinetic energy is introduced as a “forcing” in the transport equations of the $k$ and $\varepsilon$ variables, acting as a “blocking effect” of the vorticity in the shear layer as in the schematic representation of Fig. 1, according to Westerweel et al. (2009). This small kinetic energy can be constructed from the “residual” high-order POD modes previously presented, by reconstructing fluctuating velocity components derived from the use of the last POD modes of very low energy. Therefore, an inhomogeneous stochastic forcing can be built and used as a source term in the transport equations regarding $k$ (Eq. (11)) and $\varepsilon$ (Eq. (12)). This term contains a small fluctuating velocity scale which acts within the shear layer and in the region below, without affecting the regions beyond the turbulent/non-turbulent interface. By dimensional analysis, this kind of source terms can take the form of Eq. (13), where the ambient value of the turbulent kinetic energy is $k_{\text{amb}} = k_{0} U_{\infty}^{2}$, and $k_{0} = 3/2 \ T u^{2}$, with $Tu$ the upstream
turbulence intensity and $\tilde{r}$ is taken from a random number generator varying in the interval $[0, 1]$. This form is similar, from a dimensional point of view only, to the homogeneous ambient terms introduced by Spalart and Rumsey (2007) in order to sustains the turbulent kinetic energy level specified in the upstream conditions, which usually decays towards the body due to the dissipation rate:

$$\frac{\partial k}{\partial t} = P - \varepsilon - \frac{\partial}{\partial x_i} \left( \frac{\nu_1 + \nu_2}{\sigma_k} \frac{\partial k}{\partial x_j} \right) + S_{\text{KED}}$$

(11)
### 3.1. Shock-vortex shear-layer interaction in transonic buffet conditions

**Fig. 28.** Averaged turbulent kinetic energy field, $k_{POD}$, issued from fluctuating velocity reconstruction for higher-order modes 60–99.

\[
\frac{\partial k}{\partial t} = \frac{\nu}{k} \left[ C_{t1} \left( \frac{\partial k}{\partial x} \right)^2 - \frac{\partial \bar{u}}{\partial x} \frac{\partial \bar{v}}{\partial x} \right] \left( 1 + C_{t2}^{2/3} \right) + \frac{C_{t2} S_{POD}}{\kappa_{amb}}
\]

with

\[
S_{POD} = \hat{r} C_{\mu} \left( k_{amb}^2 + k_{POD}^2 \right) / \nu_{fse}.
\]

and $\nu_{fse} = C_{\mu} k^2 / \epsilon$ is the turbulent viscosity. $\nu_{fse}$ is the freestream turbulent viscosity.

In the present study, this source term is derived from the local-scale, higher-order POD modes. In Fig. 26, the higher-order POD shape modes, $\phi_i(x)$, are maximum in the regions where the shearing rate is high (shear-layer and shock regions). In the present study, an order of the last 40 modes (from 60th to 99th) have this property, as shown in the previous section. This approach may be adapted for other cases. These POD modes are associated with the temporal coefficients by using the relation (6) in order to produce a reconstruction of the velocity components and to calculate a low-energy velocity scale, $\sqrt{\nu + \nu^2}$. This reconstruction used the whole snapshot sequence of 10 buffet periods as for the previous POD analysis. In this way, an averaged turbulent kinetic energy scale, $k_{POD}$, is calculated as: $k_{POD} = 0.5 \times (\nu^2 + \nu^2)$. As a first approximation, a time-averaged kinetic energy is evaluated. These equations are time-dependent and yield to a solution with temporal variation of the shear-layer as in Fig. 8. These source terms lead to a forcing of the turbulent stresses by means of the turbulence behaviour law and the turbulent viscosity. The new stresses act as an energy transfer from the stochastic small-scale modes to the higher ones.

As mentioned above, this stochastic forcing is simultaneously localised in the shear layer, in the wake and in the shock wave areas, thanks to the properties of the higher-order POD modes presented in the previous section, without contaminating the neighboring regions, which remain irrotational, as shown in the spatial distribution of $k_{POD}$, Fig. 28. The time-dependent evolution of these regions is taken into account. As will be discussed, the solution is now improved in respect of the shear-layer thinning.

**Fig. 29** shows the divergence of the velocity vector at eight representative instants within the buffet period, according to the simulation including the stochastic forcing detailed above. A qualitative comparison with Fig. 8 shows a reduced shock-motion amplitude, which is in good agreement with the experiment. Furthermore, the shear layer and separated regions, which remain time-dependent, are thinner than in the previous case without stochastic forcing. These facts are quantified in Figs. 30, 32 and 33.

**Fig. 30** shows a comparison of the mean surface pressure distribution between $k-e$-OES and its variants. The simulation of this interaction with the stochastic forcing. The $k-e$-OES without ambient terms provides a larger shock amplitude than in the experiment. The $k-e$-OES with the homogeneous ambient terms provides an improvement in the shock-motion motion compared to the basic $k-e$-OES simulation. In the IOES case, the pressure coefficient shows an even improved shock-motion amplitude where the shock-motion amplitude is large, as well as a better estimation of the pressure distribution in the region from the most downstream position of the shock to the trailing edge. This can be explained by the fact that the ambient terms and the stochastic forcing “add” a slight level of eddy viscosity in the OES modelling which is designed to reduce the eddy viscosity and to allow the instability development. Therefore, the instability development becomes slightly moderate by compensating the OES eddy-viscosity reduction thanks to the stochastic forcing. Moreover, the stochastic forcing improves the $C_p$ tendency to form a more horizontal “plateau”, upstream of the shock-motion area, as measured in the experiments. These improvements serve as an estimate of the lift coefficient.
The TNT (Turbulent/Non-Turbulent) interface is localized where the vorticity gradient across the interface is maximum. The phase-averaged velocity and vorticity profiles derived from the $k-\varepsilon$-OES model, as well as from the IOES at the same phase, are compared in Figs. 32 and 33 at two positions: $x/C = 0.65$ and $x/C = 0.85$.

Fig. 31 shows the two locations where the phase-averaged velocity and vorticity profiles have been extracted at the same buffet phase to compare the stochastic forcing effects to the basic simulation.

Fig. 32 shows the comparison of these velocity profiles according to both approaches. It can be seen that the simulation with the forcing (IOES) leads to a significant thinning of the shear layer. This can also be observed in Fig. 33, where the two
approaches are compared by means of the vorticity. The TNT interface, identified by a vorticity close to 0, is lowered by using the stochastic forcing. Its thickness is reduced by 30% at \( x/C = 0.65 \), and by 19% at \( x/C = 0.85 \), which has as a consequence the reduction of the drag, due to the reduction of the viscous region downstream of the shock. The present inhomogeneous forcing reproduces the blocking and thinning effect, similarly to the DNS results of Ishihara et al. (2015) regarding boundary-layer interface.

Fig. 34 left shows the velocity profile at the location \( x/C = 0.85 \), as well as the vorticity gradient profile at the same position (Fig. 34 right). Two inflexion points of the velocity profile are identified, corresponding to the change in sign of the vorticity gradient (\( \frac{d\omega}{dy} = 0 \)). The existence of the inflexion points is associated indeed with the shear-layer instability development, illustrated in Fig. 29 as well as with the small series of Kelvin–Helmholtz vortices captured by the present simulation.

Following these results concerning the improved velocity profiles, a theoretical instability study can be carried out on the basis of the present velocity profiles in a future study, in order to accurately determine the critical shear rate beyond which the mentioned instabilities are amplified.

5. Conclusion

The present numerical study analyses in detail the flow physics of the transonic shock-wave, shear-layer and wake interaction around a supercritical airfoil at high Reynolds number (3 million), incidence of 3.5° and at a Mach number of 0.73. This set of physical parameters corresponds to the onset of the buffet instability, a challenge for the prediction of this instability appearance near the critical parameters by numerical simulation including turbulence modelling in the high-Reynolds number range. This study describes a new approach highlighting the dynamics of the transonic buffet in interaction with the near-wake von Kármán instability as well as with smaller-scale vortex structures in the separated shear layers, related to the Kelvin–Helmholtz instability.

This analysis is carried out by the Organized Eddy Simulation (OES) method, which resolves the organized coherent structures and models the random turbulence by adapted statistical modelling. This method has been improved in the present study to include stochastic forcing of smaller-scale vortex structures near the outer interfaces of the boundary layer, the shear layer and in the wake. Their effects are modelled as source terms in the turbulent kinetic energy and dissipation transport equations.
By means of this modelling approach, the study contributes to complete experimental physical analysis of the transonic buffet, which was mainly interested in the shock motion and pressure-velocity distributions around the body and less in the interaction with the wake instabilities in the related literature. This study provides new results regarding the buffet interaction with the von Kármán mode and the smaller-scale vortex structures. The Proper Orthogonal Decomposition analysis has shown that this interaction creates an amplitude modulation of the buffet mode due to the von Kármán mode and vice-versa. The wavelet and autoregressive model analysis quantified a frequency modulation of the von Kármán instability due to the buffet. The predominant frequencies of these modes have been evaluated by spectral analysis and the interaction among them has been illustrated by the appearance of new frequencies in the energy spectrum, being combinations of the principal instability modes. Whereas the buffet mode is a well distinguished frequency peak in the spectrum, the von Kármán mode is characterized by a spectral 'bump' appearance around a frequency 33.3 times higher than the buffet frequency. The spectral analysis has shown the modification of the von Kármán mode 'bump' shape due to higher-order buffet harmonics and the amplification of the K–H instability peak of higher frequency.

Concerning these interactions, the POD analysis distinguished the shape modes involved in the formation of highly energetic coherent vortices and of the buffet dynamics from those of weaker energy involved in smaller-scale vortex structures appearing in the shear layers and influencing also the shock-motion area.
Inspired from the POD reconstructions, an efficient inhomogeneous stochastic forcing has been built and applied as a source term in the turbulent kinetic energy and dissipation rate transport equations in the context of an improved OES (IOES) approach. By reconstructing the fluctuating velocity field corresponding to the higher-order POD modes, a kinetic energy fluctuation has been generated and employed in the stochastic forcing source terms. This forcing led to thinning of the turbulent/non-turbulent interfaces within the separated boundary layer and the shear layers.

An improved modelling of the shock amplitudes is obtained in comparison with experiments as well as a better physical representation of the instability regions and vortex structures around the body and in the wake. Furthermore, the present IOES method merits to be tested in 3D (although the buffet dynamics of a nominally 2D airfoil configuration are essentially two-dimensional) for a more accurate evaluation of the unsteady loads and pressure fluctuations generated by the fluid–structure interaction, a crucial issue in FIV (Flow-Induced Vibration) and aeroacoustics domains.

Acknowledgements

The authors acknowledge the financial and scientific support of the ATAAC (Advanced Turbulence Simulation for Aerodynamic Application Challenges) European Collaborative research program No. 233710, coordinated by DLR-Göttingen, by Dr. D. Schwamborn and including among the industrial partners Airbus, EADS, Dassault, Rolls Royce, Alenia and Eurocopter. The authors are grateful to the ONERA partner of this project for valuable scientific discussions and for the provision of a first numerical grid (S. Deck), as well as for the discussions on the impact of the two-dimensional character of the buffet around the wing, during the ATAAC project in the years 2009–2012. The computing time allocation was provided by the national computing centers CINES (Centre Informatique National de l’Enseignement Supérieur), CALMIP (Calcul en Midi-Pyrénées), IDRIS (Institut du Développement et des Ressources en Informatique Scientifique). This study partly used a computing allocation in the context of the PRACE-Tier1 and preparatory access supercomputing European initiative. The authors thank G. Harran and A. Sévrain for their scientific support concerning the dynamic systems analysis.

References

Chapter 3. Physics and modelling around two supercritical airfoils


3.1. Shock-vortex shear-layer interaction in transonic buffet conditions

3.1.2 Upscale turbulence modelling

A stochastic forcing has been introduced in the previous section, inspired from the theoretical analysis (Hunt et al., 2008) and experimental studies (Ishihara et al., 2015) that introduced “eddy-blocking” mechanism near TNT interfaces. It is well known that the direct turbulence cascade modelling in the majority of the turbulence modelling methods, and based on turbulence hypothesis, generates excessive turbulence diffusion and as a consequence, the TNT interfaces cannot keep as thin as observed. A new decomposition of the resolved and modelled part in the context of the RANS modelling is proposed as a conjecture based on the separable POD and the introduced stochastic forcing.

The flow variables are still decomposed in an average and a fluctuating part. In this case, the ensemble average is considered:

\[ U = \langle U \rangle + U' \] (3.1)

and has the same properties as any Reynolds averaging, in particular:

\[ \langle \langle U \rangle \rangle = \langle U \rangle, \]
\[ \langle U' \rangle = 0 \] (3.2) (3.3)

Thus, the Reynolds-averaged Navier-Stokes equation (section 1.2.3 page 8) are still valid using the ensemble average, and the existence of the turbulent stress tensor remains:

\[ \tau_{ij} = -\langle \rho \rangle \langle U'_i U'_j \rangle \] (3.4)

From now, the fluctuations are decomposed in an upscale contribution \( \hat{U}_j \) and a downsacle one \( \check{U}_j \), giving:

\[ \langle U'_i U'_j \rangle = \langle (\hat{U}_i + \check{U}_i) (\hat{U}_j + \check{U}_j) \rangle \]
\[ = \langle \hat{U}_i \hat{U}_j \rangle + \langle \hat{U}_i \check{U}_j \rangle + \langle \check{U}_i \hat{U}_j \rangle + \langle \check{U}_i \check{U}_j \rangle \] (3.5)

This decomposition gives a fully ‘downscale’ contribution \( \langle \check{U}_i \check{U}_j \rangle \) which can be modelled in a usual way (e.g. Boussinesq assumption, section 1.2.4 page 9). The remaining part of the sum contains upscale contribution. This part is modelled by means of the stochastic forcing.
3.2 Laminar airfoil

The laminar airfoil studied here has been designed by Dassault Aviation in the context of the TFAST (Transition location effect on shock-wave/boundary-layer interaction) European project, where other geometries are handled such as turbine and compressor blades, as well as experimental supersonic shock-wave/boundary-layer interaction configuration (see chapter 4 page 117). Unfortunately, detailed experimental results are still not available, but all the partners of this project involved in the numerical study of the airfoil have produced a substantial set of data. Hence, our research team has carried out the study of the laminar-turbulent transition location effect on the transonic flow around the airfoil, in steady state (low angle of attack) as well as in the case of buffetting. This study have been subjected to a close collaboration between INRIA (Institut national de recherche en informatique et en automatique or French institute for research in computer science and automation) and our team in the context of an optimisation study, in the two cases. Finally, a 3D computation has been performed in terms of a hybrid RANS-LES simulation in the transonic buffet conditions. All the results of this study, as well as the details on the numerical and optimisation methods and the European project, have been gathered together in an article submitted on April 2015 to the European Journal of Mechanics - B/Fluids. This article has been included in this manuscript from the next page.
Numerical study of the turbulent transonic interaction and transition location effect involving optimisation around a supercritical airfoil

Damien Szubert\textsuperscript{a,}\textsuperscript{*}, Ioannis Asproulias\textsuperscript{a}, Fernando Grossi\textsuperscript{a}, Régis Duvigneau\textsuperscript{b}, Yannick Hoarau\textsuperscript{c}, Marianna Braza\textsuperscript{a}

\textsuperscript{a}Institut de Mécanique des Fluides de Toulouse, UMR N°5502 CNRS-INPT-UPS, Allée du Prof. Camille Soula, F-31400 Toulouse, France
\textsuperscript{b}INRIA Sophia Antipolis - Méditerranée, ACUMES Team
\textsuperscript{c}Laboratoire ICUBE, UMR N°7357, Strasbourg

Abstract

The present article analyses the turbulent flow around a supercritical airfoil at high Reynolds number and in the transonic regime, involving shock-wave/boundary-layer interaction (SWBLI) and buffet, by means of numerical simulation and turbulence modelling. Emphasis is put on the transition position influence on the SWBLI and optimisation of this position in order to provide a maximum lift/drag ratio. A non-classical optimisation approach based on Kriging method, coupled with the URANS modelling, has been applied on steady and unsteady flow regimes. Therefore, the present study contributes to the so-called ‘laminar-wing design’ with the aim of reducing the drag coefficient by providing an optimum laminar region upstream of the SWBLI.

1. Introduction

The present study has been carried out in the context of the European research program TFAST, “Transition location effect on shock-wave/boundary-layer interaction”, project N°265455. One of the main objectives of this research is to provide optimal laminarity in the boundary layer upstream of the shock-wave/boundary-layer interaction (SWBLI), in order to reduce the skin friction comparing to the fully turbulent case and therefore reduce drag, in the context of greening
aircraft transport (a major objective of the *Horizon 2020* European programme). Due to increased aerodynamic loads and aero-engine components nowadays, supersonic flow velocities are more frequent, generating shock waves that interact with boundary layers. Laminar shock-wave/boundary-layer interaction can rapidly cause flow separation, which is highly detrimental to aircraft performance and poses a threat to safety. This situation can be improved by imposing the laminar-turbulent transition upstream of the interaction, but this should be carefully done in order to keep the aerodynamic efficiency high (lift/drag ratio).

In the context of the European research program TF AST, several ways of controlling the position of the transition is carried out. To this end, a supercritical laminar wing, the so-called V2C, has been designed by Dassault Aviation. This profile allows the boundary layer to remain laminar up to the shock foot, even in the environment of transonic wind tunnels of the laboratories involved in the project, and up to the angle of attack of 7°. Experimental results for the present configuration are not yet available in the present research project. Regarding the related literature, the transonic buffet has been studied experimentally in detail since the 70s on circular-arc airfoils [1, 2], and most recently on supercritical airfoils [3]. In this latest study, a fixed transition tripping was applied at 7% of the chord. The physics governing the transonic buffet is complex and several theories have been proposed, like the effect of the feedback mechanism of waves propagating from the trailing edge, or the onset of a global instability [3, 4, 5]. Comparison of numerical results by Deck [6], Grossi et al. [7] and Szubert et al. [5] with the experimental results by Jacquin et al. [8] concerning the transonic buffet around supercritical wings with fixed transition showed the predictive capability of recent CFD methods and a physical analysis of the interaction between buffet and trailing-edge instabilities. The SWBLI involving transonic buffet and laminar wing design currently highly interests the aeronautical industries (Cleansky European project, “Advanced, high aspect ratio transonic laminar wing” [9]). Laminar wing design in transonic regimes has been studied in respect of transition control by means of Discrete Roughness Elements (DRE’s) [10].

Navier-Stokes simulations of transonic buffet as well as of the shock-vortex interaction at moderate Reynolds numbers were reported by Bouhadji and Braza [11], as well as DNS by Boudet et al. [12]. In the high Reynolds number range, typical of aerodynamic applications, the use of appropriate turbulence modelling is necessary. Concerning transonic buffet, the unsteady shock-wave/boundary-layer interaction represents a major challenge for turbulence models and the low frequencies associated with the shock-wave motion can make the simulations very expensive. Since the first simulations by Seegmiller et al. [2] and Levy Jr. [13] for a circular-
arc airfoil, Unsteady Reynolds-Averaged Navier-Stokes (URANS) computations using eddy-viscosity turbulence models have been largely used to predict the phenomenon over two-dimensional airfoils. Pure LES simulations, even combined with specific wall-models, are yet quite costly for the high Reynolds number range of real flight configurations. For this reason, hybrid RANS-LES methods have been developed in the last decade and start to be largely used in the industrial context together with adapted, advanced URANS approaches. The hybrid methods combine the robustness and near-wall physics offered by URANS in the near region, as well as LES advantages in capturing the physics of unsteady vortices and instabilities development in the detached flow regions. Among the hybrid methods, the Detached-Eddy Simulation (DES) does not need to impose the interface between the statistical and LES regions. This is provided inherently by the choice of the turbulence length scale to use in the transport equations [14]. In order to avoid approaching the near-wall region by the LES zone, the Detached-Eddy Simulation has been improved in respect of the turbulence length scale, ensuring a quite significant statistical zone around the body, in the context of the Delayed Detached-Eddy Simulation (DDES) [15]. Moreover, improvement of the nearwall modelling has been achieved by means of a suitable Wall-Modelled LES (WMLES) in order to allow the flow physics modelling in the very near wall region covering the viscous sublayer by means of finer grids (but more economic than the LES) in the context of the Improved Delayed Detached-Eddy Simulation (IDDES) [16]. Regarding the transonic buffet simulations, Deck [6] has used a successful zonal DES approach, using mostly statistical modelling in the outer regions far from the body. He provided a detailed prediction of the transonic buffet around the supercritical airfoil OAT15A. Regarding the same configuration, Grossi et al. [7] performed a Delayed Detached-Eddy Simulation in the context of the ATAAC (Advanced Turbulence Simulations for Aerodynamic Application Challenges) European programme. This study succeeded in the prediction of the shock-wave self-sustained motion near the critical angle of incidence for the appearance of buffet, based on experimental results by Jacquin et al. [3, 8]. Moreover, Szubert et al. [5] provided a detailed analysis of the buffet dynamics by means of the Organised Eddy Simulation (OES) approach, resolving the organised coherent modes and modelling the random turbulence background and using upscale turbulence modelling through stochastic forcing in order to keep the turbulent–non-turbulent shear-layer interfaces thin. In the present paper, the transonic buffet is applied on the V2C airfoil within the TFAST program, at 7.0°, the maximum angle of attack allowed by the design, upstream Mach number 0.70 and Reynolds number $3.245 \times 10^6$. The fully turbulent case is studied by differ-
ent URANS and DDES modelling in two and three dimensions respectively. The predictive capabilities of statistical and hybrid turbulence modelling approaches are discussed. A 2D study is first carried out to investigate the main flow characteristics in respect of the angle of attack as well as the influence of the transition location. The transition location effects are also studied in the buffeting regime, by imposing the laminarity at several positions. Based on these results, the main objective of the present article is to put ahead a coupling of the aforementioned CFD methods with a non-classical optimisation approach of the transition location in the steady and unsteady transonic regimes in respect of the drag reduction and lift to drag ratio maximisation.

2. Numerical method and turbulence modelling

2.1. Flow configuration

Concerning the design of the V2C wing, it was validated numerically by Dassault on a 0.25 m-chord length \( c \) profile by means of RANS computations for various angles of attack at freestream Mach numbers of 0.70 and 0.75, yielding chord-based Reynolds numbers of approximately \( 3.245 \times 10^6 \) and \( 3.378 \times 10^6 \) respectively. The study was performed using a compressible Navier-Stokes code adopting a two-layer \( k-\varepsilon \) model, with the transition location being determined from the fully-turbulent flowfield using a three-dimensional compressible boundary-layer code by means of the \( N \)-factor amplification with a parabola method. The technique employed for laminarity and an initial design in respect of the transition prediction was based on the \( e^N \) method (Ref. [17] for instance). The airfoil surface was generated in such a way that the \( N \)-factor remains small for low-to-moderate turbulence intensity levels, similar to the wind tunnel turbulence levels used for the present test-case for the experimental study currently in progress in the TFAST project. At Mach number 0.70, the flow separated between \( \alpha = 6^\circ \) and \( 7^\circ \). The amplification factor \( N \) was shown to be smaller than 3 up to the shock wave, thus guaranteeing laminar flow. At Mach 0.75, the value of \( N \) remained smaller than 2 up to \( \alpha = 7^\circ \). For this Mach number, there were not buffeting phenomenon, whatever the angle of attack. Moreover, for incidences higher than \( 1^\circ \), the shock induces a separation of the boundary layer up to the trailing edge.

2.2. Numerical method

The simulations of the V2C configuration at upstream Mach number \( M = 0.70 \) and Reynolds number \( \text{Re} = 3.245 \times 10^6 \) have been carried out with the Navier-
Stokes Multi-Block (NSMB) solver. The NSMB solver is the fruit of a European consortium that included Airbus from the beginning of 90s, as well as main European aeronautics research Institutes like KTH, EPFL, IMFT, ICUBE, CERFACS, Univ. of Karlsruhe, ETH-Ecole Polytechnique de Zurich, among other. This consortium is coordinated by CFS Engineering in Lausanne, Switzerland. NSMB solves the compressible Navier-Stokes equations using a finite volume formulation on multi-block structured grids. It includes a variety of efficient high-order numerical schemes and turbulence modelling closures in the context of URANS, LES and hybrid turbulence modelling. NSMB includes efficient fluid-structure coupling for moving and deformable structures. For the present study, the third-order of accuracy Roe upwind scheme \[18\] associated with the MUSCL flux limiter scheme of van Leer \[19\] is used for the spatial discretisation of the convective fluxes. A similar upwind scheme (AUSM) was used by Deck \[6\]. For the diffusion terms, second-order central differencing has been used. The temporal discretisation has been done by means of dual-time stepping and of second order accuracy. A physical time step of \(5 \mu s\) has been adopted for 2D simulations. For the 3D simulations, the time step has been reduced to \(0.1 \mu s\) after detailed numerical tests. A typical number of inner iterations of 30 was necessary for the convergence requirements in each time step.

The 2D grid has a \(C - H\) topology, and is of size 163,584 cells. The downstream distance of the computational domain is located at a mean distance of 80 chords from the obstacle. A grid refinement study has been carried out, by means of steady-state computations and using local time stepping, for the flow at \(M_\infty = 0.70\) and \(\alpha = 4.0^\circ\) using the \(k - \omega\) SST model \[20\] and assuming fully-turbulent boundary layer, with two other grids: one 50% coarser, and another 30% finer. Detailed results of this convergence study can be found in \[7\]. The grid retained for the present study gave a maximum value of non-dimensional wall distance \(y^+\) of about 0.55 with respect to the turbulence modelling. Fig. 1 shows the grid and the computational domain. For the 3D computations, the planar grid has been extruded to 59 cells uniformly distributed in the spanwise direction over a distance of \(0.33 \times c\). The 3D grid contains about 9.65 M cells.

**Boundary and initial conditions**

On the solid wall, impermeability and no-slip conditions are employed. The far-field conditions are the characteristic variables extrapolated in time: the total pressure \((P_0 = 10^5 \text{ Pa})\) and total temperature \((T_0 = 290 \text{ K})\), as well as the upstream Reynolds number of 3.245 million and Mach number of 0.70. The upstream turbulence intensity is \(T_u = 0.08\%\).
The initial conditions are those of a steady-state generated field in each case.

*Turbulence modelling*

In the context of URANS and hybrid turbulence modelling, the following models have been used respectively: the two-equation $k - \omega$ SST model of Menter [20] as well as the OES-$k - \varepsilon$ [5, 21] and the DDES-$k - \omega$ SST models have been used with turbulence-sustaining ambiat terms to prevent the free decay of the transported turbulence variables [22].

2.3. Optimisation method

In the context of the transition location study detailed in this paper, an optimisation of its location is proposed by employing a non-classical statistical learning approach. The principle consists in gathering a set of performance values, observed for different parameters, and construct a statistical model (Gaussian Process) on this basis, that reflects the knowledge and uncertainties related to the performance function. Then, this model is employed to determine the most interesting simulations to carry out, in a statistical sense. This approach is repeated until convergence [23].

More precisely, the statistical model for the performance function $f$ is constructed on the basis of a set of observed values $F_N = \{f_1, f_2, \ldots, f_N\}$ at some points $X_N = \{x_1, x_2, \ldots, x_N\} \in \mathbb{R}^d$ (here $d = 1$). $F_N$ is assumed to be one real-
ization of a multivariate Gaussian Process which has a joint Gaussian distribution [24]:

$$p(F_N|X_N) = \frac{\exp \left( -\frac{1}{2}F_N^T C_N^{-1}F_N \right)}{\sqrt{(2\pi)^N \det(C_N)}}, \quad (1)$$

for any collection of inputs $X_N$. $C_N$ is the $N \times N$ covariance matrix, whose elements $C_{mn}$ give the correlation between the function values $f_m$ and $f_n$ obtained at points $x_m$ and $x_n$. This is expressed in terms of a correlation function $k$, i.e.,

$$C_{mn} = \text{cov}(f_m, f_n) = k(x_m, x_n; \Theta) \quad \text{with } \Theta \text{ a set of hyper-parameters, calibrated on the basis of known points (likelihood maximisation principle).}$$

The Matérn class of covariance stationary kernels, which gives a family of correlation functions of different smoothness [24], is used for $k$.

After calculations based on conditional probabilities, the probability density for the function value $f_{N+1}$ at any new point $x_{N+1}$ is:

$$p(f_{N+1}|X_N, F_N) \propto \exp \left[ -\frac{(f_{N+1} - \hat{f}_{N+1})^2}{2\hat{\sigma}_{f_{N+1}}^2} \right], \quad (2)$$

where

$$\hat{f}_{N+1} = k_{N+1}^T C_N^{-1}F_N, \quad (3)$$

$$\hat{\sigma}_{f_{N+1}}^2 = \kappa - k_{N+1}^T C_N^{-1}k_{N+1}, \quad (4)$$

with $\kappa = k(x_{N+1}, x_{N+1}; \Theta)$ and $k_{N+1} = [k(x_1, x_{N+1}; \Theta), \ldots, k(x_N, x_{N+1}; \Theta)]^T$. Thus, the probability density for the function value at the new point $x_{N+1}$ is also Gaussian with mean $\hat{f}_{N+1}$ and standard deviation $\hat{\sigma}_{f_{N+1}}$. Therefore, the most likely value at the new point $x_{N+1}$ is $\hat{f}_{N+1}$. This value will be considered as the prediction of the Gaussian Process model. The variance $\hat{\sigma}_{f_{N+1}}^2$ can be interpreted as a measure of uncertainty in the value prediction. If the evaluation is known to be noisy, the model can account for the observation noise by modifying the diagonal terms of the covariance matrix, on the basis of the noise variance estimated for each database point [25].

At each step of the optimisation procedure, this Gaussian Process model is exploited to determine new points to be simulated. The most popular strategy is the maximisation of the Expected Improvement (EI) criterion [23]. The maximisation of this criterion is numerically reached, by solving an internal optimisation problem using an evolution strategy.
3. Results

3.1. Two-dimensional study: angle of attack effects

This study has been carried out in URANS with the two-equation $k - \omega$ SST turbulence model [20] for an upstream Mach number $M_\infty = 0.70$. The angle of attack has been varied from $1.0^\circ$ up to $7.0^\circ$, which is the maximum angle of attack for which the boundary layer is supposed to remain laminar from the leading edge to the shock wave. Initially, the computations adopt local time stepping. If convergence is not reached (i.e., a relative reduction of $10^{-6}$ in the residual), time-accurate simulations with a time step of $5 \times 10^{-6}$s are then carried out. Near the critical angle regarding the buffet, the angle of attack has been varied by an increment of $0.5^\circ$ in order to refine the critical buffet range.

Fig. 2 shows the averaged distributions of the pressure coefficient for the full range of incidences and skin-friction coefficient for the steady cases. For angles of attack up to $5.0^\circ$, the flow is steady and rear separation is always present. The shock wave can be distinguished at $2.0^\circ$. As the angle of attack is further increased, the shock initially moves downstream, then it goes upstream for $\alpha > 3^\circ$. From $\alpha = 4.0^\circ$, a separation bubble appears and develops. The size of the rear separation steadily increases with the angle of attack (Fig. 2(b)).

The buffet onset, characterized by an oscillating shock wave, has been detected from $5.5^\circ$. The main frequency increases with incidence in the range of $80 – 82$Hz.
Figure 3: Comparison of the mean wall pressure coefficient between NSMB end Edge codes, for angles of attack between 1.0° and 7.0°.

At 5.5°, the amplitude of the shock-wave motion is still small, resulting in a slight slope in the $C_p$ curve.

A detailed comparison of the results obtained in the present study by the NSMB code has been carried out by using the Edge code, an unstructured compressible finite volume CFD code developed by the FOI since 1997 in collaboration with industrial and academic partners. The wall pressure distribution is plotted in Fig. 3 for angles of attack between 1.0° and 7.0°. This comparison showed small differences close to the critical angle, but the results were very similar at lower and higher angles of attack. This ensures about the validity of the present simulations, in absence of finalised experimental results within the TFAST programme.

3.2. Transition location effect

Two flow conditions have been selected for a numerical investigation of the transition location effect on the SWBLI, due to their interesting flow physics. First, the steady interaction arising at $\alpha = 4.0°$ is addressed, featuring a reasonably strong shock just below the critical angle of attack for buffet onset. The second flow condition is the fully-established buffet regime at $\alpha = 7.0°$, which presents a large shock-wave motion region.

The transition is forced at the position $x_t$ by imposing the turbulent viscosity $\nu_t = 0$ for $x < x_t$. Its location $x_t$ is varied from the leading edge up to as close
as possible to the shock wave. The influence of the tripping point over the selected steady and unsteady transonic flow-fields is presented in the following two subsections.

3.2.1. Pre-buffet condition – Steady case

Results presented in the previous sections showed that, at $\alpha = 4.0^\circ$ and $M_{\infty} = 0.70$, the fully turbulent flow over the V2C airfoil is near critical with respect to transonic buffet. At that incidence, the shock wave is strong enough to induce a small separation bubble and the adverse pressure gradient over the rear part of the airfoil causes rear separation at about $x/c = 0.91$. The same flow condition has been recomputed considering different transition locations $x_t$ from the leading edge up to the mid-chord, remaining steady in all cases. The pressure and friction coefficients distributions over the upper surface are plotted in figure 4 for some chosen values of $x_t$. The pressure coefficient indicates an increase of the suction effect as the transition position moves downstream, while the shock position moves downstream. This fact yields an increase of lift. The trailing-edge pressure decreases, as well as the $C_p$ on both sides of the rear airfoil part. The $x/C = 0.10$ case can be qualitatively compared with the case of the OAT15A airfoil with fixed transition at $x/C = 0.07$, numerically studied by Grossi et al. [7] (Fig. 9 in this reference) and compared with the experimental data of Jacquin et al. [8], where the same order of magnitude for the upstream and downstream pressure plateau is observed. A quite good comparison with the experiment is obtained. Therefore, despite the lack of experimental results up to now for the V2C airfoil, a fairly good agreement can be expected between the present CFD and experiments under way in the TFAST project. Moreover, the DDES results of Grossi et al. [7] provide a higher trailing-edge suction than URANS, associated with more intense separation. This feature is a similar tendency to the DDES behaviour of the present study, discussed in section 3.4, as well as with the zonal DES (ZDES) of Deck [6] (Fig. 6 in this reference). The effect of the transition location on the shock-wave position $x_s$, on the location $x_b$ and length $l_b$ of the separation bubble as well as on the rear separation position $x_r$ are detailed in Table 1 for the complete set of simulations.

The tripping points can be easily identified on the friction coefficient by the sudden and high increase in the wall shear when the boundary layer becomes turbulent. They can also be distinguished on the pressure coefficient in the form of slight pressure disturbances in the supersonic region. As the transition location is shifted downstream, which induced a reduction in the boundary layer displacement thickness, the shock wave moves downstream, which can be noted in Fig. 4,
resulting in a stronger shock wave. As the laminar region increases, the progressively stronger shock wave makes the separation bubble grow continuously as indicated in Table 1 and by means of the $C_f$ distribution. On the contrary, the rear separation gets smaller, yielding a larger pressure recovery and eventually vanishing for $x_t/c \approx 0.5$.

Table 1 provides also the force coefficients as the tripping point is varied. As the length of the laminar region, and thus the shock wave position move downstream, the lift increases due to a higher pressure difference between the upper and lower surfaces. The lift-to-drag ratio $L/D$ is also provided. An optimal value is found near $x_t/c = 0.3$. However, this position of transition does not give the minimum value of the global drag coefficient, which is obtained for a transition located near $x_t/c = 0.10$, with a short laminar boundary layer region. This drag coefficient then increases with a longer laminar region, while the friction drag always diminishes as the laminar region becomes longer.

### 3.2.2. Unsteady regime

This study has been carried out to assess the influence of the transition point on the properties of the well-developed buffeting flow at $7.0^\circ$. Besides the fully-turbulent case, three tripping locations have been considered: $x_t/c = 0.09, 0.16$ and $0.24$. For the latter, the most upstream position of the shock wave during buffet has been of about $x_t/c = 0.25$. This limits the displacement of the tripping point, because imposing $v_t = 0$ inside the shock-motion region would not be an
Table 1: Transition location effect on the shock position, on separation and on the global aerodynamic coefficients

<table>
<thead>
<tr>
<th>(x_t/c)</th>
<th>fully turb.</th>
<th>0.10</th>
<th>0.20</th>
<th>0.30</th>
<th>0.40</th>
<th>0.50</th>
</tr>
</thead>
<tbody>
<tr>
<td>(x_s/c)</td>
<td>0.523</td>
<td>0.532</td>
<td>0.541</td>
<td>0.552</td>
<td>0.564</td>
<td>0.574</td>
</tr>
<tr>
<td>(x_b/c)</td>
<td>0.533</td>
<td>0.541</td>
<td>0.547</td>
<td>0.556</td>
<td>0.566</td>
<td>0.575</td>
</tr>
<tr>
<td>(l_b/c) (%)</td>
<td>1.1</td>
<td>2.4</td>
<td>4.7</td>
<td>6.8</td>
<td>8.5</td>
<td>9.4</td>
</tr>
<tr>
<td>(x_r/c)</td>
<td>0.911</td>
<td>0.925</td>
<td>0.946</td>
<td>0.965</td>
<td>0.981</td>
<td>–</td>
</tr>
<tr>
<td>(C_L)</td>
<td>0.8873</td>
<td>0.9174</td>
<td>0.9556</td>
<td>0.9919</td>
<td>1.029</td>
<td>1.061</td>
</tr>
<tr>
<td>(C_D \times 10^2)</td>
<td>0.610</td>
<td>0.574</td>
<td>0.510</td>
<td>0.460</td>
<td>0.396</td>
<td>0.334</td>
</tr>
<tr>
<td>(C_P \times 10^2)</td>
<td>2.080</td>
<td>2.069</td>
<td>2.102</td>
<td>2.171</td>
<td>2.268</td>
<td>2.365</td>
</tr>
<tr>
<td>(L/D)</td>
<td>42.7</td>
<td>44.3</td>
<td>45.5</td>
<td>45.7</td>
<td>45.4</td>
<td>44.9</td>
</tr>
</tbody>
</table>

Fig. 5(a) presents the statistical pressure distributions obtained for each boundary layer tripping position. While the most upstream limit of the shock-motion range is not much sensitive to the transition location, its most downstream limit is strongly affected by the boundary layer state. As seen for the case \(\alpha = 4.0^\circ\), a larger extent of laminar boundary layer tends to move the shock wave further downstream by altering the displacement thickness distribution around the airfoil. In fact, this effect can also be observed in the unsteady case regarding the mean shock-wave position, which roughly corresponds to the point of maximum pressure unsteadiness in Fig. 5(b). As the tripping point is placed downstream, the amplitude of shock motion becomes wider, increasing the fluctuation levels in the shock-wave region as well as the trailing edge unsteadiness. This can be observed in the series presented in Fig. 6, in terms of statistical pressure fluctuation fields. Comparing the fully-turbulent simulation with the case of the most downstream transition location \((x_t/c = 0.24)\), the pressure unsteadiness increases by approximately 20% in the shock region and gets nearly two times larger near the trailing edge. The development of the shock-motion area as a function of the transition location is clearly visible in Fig. 6. In the last section of the article, an optimisation of the transition location effect has been carried out in respect of increasing aerodynamic performance.

Table 2 gives the average lift, drag and pitching moment coefficients for the three transition cases as well as for the fully-turbulent computation. The standard deviation \(\sigma\) of the aerodynamic forces is also presented. As for the steady flow at 4.0\(^\circ\), the values of the mean lift and of the moment magnitude increase...
Figure 5: Transition location effect on the statistical wall pressure at $\alpha = 7.0^\circ$.

(a) Mean pressure coefficient  (b) RMS value of pressure on the upper surface

Figure 6: RMS pressure fields for different transition locations at $\alpha = 7.0^\circ$.
Table 2: Transition location effect on the mean global coefficients, lift, drag and moment, for the unsteady as the triggering location moves towards the trailing edge. A slight augmentation in the mean drag is also noticed. As a result of the increasing shock-motion amplitude and of the overall flow unsteadiness, the standard deviations of the lift and drag coefficients also become larger as the extent of laminar boundary layer gets longer. Therefore the mean lift over mean drag ratio doesn’t show much improvement whereas the laminar region is increased. Indeed, as the transition is located closer to the shock wave/boundary layer interaction, the boundary layer downstream detaches more easily than the fully-turbulent case, which gave here the higher lift-to-drag ratio. Moreover, due to the high angle of attack, the most upstream shock location is near 25% of the chord, which limits the flexibility on the transition position.

3.3. Optimisation of the tripping location

3.3.1. Problem description

As observed in the results above, the location of the transition point may have a significant impact on the airfoil performance, in particular when unsteady boundary-layer/shock interactions occur. From designer point of view, it would be interesting to quantify this influence for the different cases (steady and unsteady) and determine the best tripping location, which maximises the airfoil performance. In this perspective, a study is presented for the optimisation problem formulated as:

\[
\text{Maximise } f(x) = \frac{C_L}{C_D} \text{ for } x \in I,
\]

where \( x \) is the stripping location and \( I \) the allowed search interval. This is a PDE-constrained optimisation problem including a single parameter. The major difficulty arises from the computational cost related to the unsteady flow simulations and the possible noisy prediction of the performance due to the presence of nu-
meric errors (discretization, time integration). The use of a classical descent optimisation method is tedious, due to the unsteady functional gradient estimation. Alternatively, stochastic approaches like genetic algorithms or evolution strategies require too many evaluations to be practically tractable.

3.3.2. Results for the steady case

A steady flow problem is first considered, corresponding to the 2D case described above for an incidence $\alpha = 4.0^\circ$. In this context, the performance is simply the lift-to-drag ratio computed at convergence. The tripping location can vary in the interval $I = [0.1c, 0.5c]$. Five configurations, corresponding to $x_1 = 0.1c$, $x_2 = 0.2c$, $x_3 = 0.3c$, $x_4 = 0.4c$ and $x_5 = 0.5c$, are achieved independently to construct a first database. A Gaussian Process model for the lift-to-drag ratio function is then constructed according to the previous section and illustrated by Fig. 7. On this figure, one can see the model itself, its associated standard deviation and the expected improvement (EI) criterion used to drive the search and select the next point to simulate. As can be seen, after two additional simulations, the standard deviation is strongly reduced and the expected improvement almost zero. Moreover, the next point to simulate, as proposed by the EI criterion, is very close to a know point and the mesh accuracy for the tripping point location is reached. As consequence, the optimisation process is stopped. Finally, two conclusions can be drawn from this optimisation exercise: a large area, from $x = 0.25c$ to $x = 0.35c$ corresponds to a very high lift-to-drag ratio, and the best performance is obtained for a tripping location close to $x = 0.3c$. 

Figure 7: Statistical model for the lift-to-drag ratio with regards to the tripping location (steady case), for iteration 0 (left) and iteration 2 (right)
3.3.3. Results for the unsteady case

We consider then the more challenging case corresponding to unsteady flows, for which shock-wave/boundary-layer interactions generate buffets. This study has been carried at an incidence of $\alpha = 5.8^\circ$. In this case, the shock-motion amplitude is limited and allows for a wider range of transition locations than at higher incidence. Here, the performance function is the time-averaged lift-to-drag ratio, computed once a quasi-periodic flow is obtained. The admissible interval for the tripping point is moved upstream $I = [0, 0.31c]$, to avoid the shock to be located in the laminar area. Five configurations, corresponding to the fully turbulent case $x_1 = 0$, then $x_2 = 0.0825c$, $x_3 = 0.165c$, $x_4 = 0.2475c$ and $x_5 = 0.31c$, are achieved independently to construct a first database. Note that the configuration $x_5 = 0.31c$ exhibits instabilities after a long time integration. For this case, the time-averaging process has been shortened to avoid these phenomena.

Fig. 8 represents the Gaussian Process model for the time-averaged lift-to-drag ratio, at iterations 0 and 1. The initial model (iteration 0) yields an Expected Improvement criterion localized around a maximum at $x_6 = 0.2665c$. This configuration is simulated and added to the database, yielding an updated model (iteration 1). Since the lift-to-drag ratio computed by simulation is very close to the one predicted by the model, the variance of the model is strongly reduced, as well as the Expected Improvement criterion, as soon as the first iteration. Therefore, the optimum tripping value should be close to $x_6$.

To validate this result, three additional test points (TP) are simulated a posteriori, corresponding to $x_1^{TP} = 0.12c$, $x_2^{TP} = 0.2c$, $x_3^{TP} = 0.25c$ and the results
Figure 9: Statistical model for the lift-to-drag ratio as a function of the tripping location (unsteady case), accounting for the observation variance

are compared to the model prediction. It appears that the performance value for $x_T^P$ slightly differs from the model prediction, due to the fact that the unsteady flow exhibits some low frequency oscillations, which make the estimation of the time-averaged lift-to-drag ratio more difficult. To account for this uncertainty in the performance estimation, a variance estimate of the time-averaged lift-to-drag ratio is computed for all configurations, by using a classical moving average procedure. This variance is introduced into the Gaussian Process model as an observation noise. Fig. 9 shows the resulting model, that does not interpolate database points anymore, against additional test points. As can be observed, the uncertainty in the performance estimation is not negligible in this context, especially when the tripping point is close to the shock wave location, which corresponds to the best performance area ($x$ between 0.2$c$ and 0.3$c$). Nevertheless, the statistical model allows having a better analysis of the problem. In particular, one can underline that the confidence interval of the model is smaller than the standard deviation of the observations, in the zone where several points have been computed. In conclusion, for this unsteady case, the airfoil performance is better for a tripping point $x$ between 0.2$c$ and 0.3$c$, but the corresponding flows exhibit additional unsteadiness because of interaction with the existing buffet instability, that could be dommageable in real conditions.
3.4. Three-dimensional simulation of the fully-turbulent case

The DDES-$k - \omega$ SST model has been applied, using the same numerical scheme as the 2D computations and time step $\Delta t = 10^{-7}s$, in order to examine the 3D dynamics of the fully developed transonic buffet occurring over the V2C airfoil at $M_\infty = 0.70$ and $\alpha = 7.0^\circ$. The turbulence length scale provided by the RANS part is computed using local turbulence properties and is given by $\sqrt{k/(\beta^*\omega)}$. A comparison of the DDES results with the URANS $k - \omega$ SST [20] as well as the 2D and 3D OES-$k - \varepsilon$ [5, 21] is provided. Concerning the grid spacing, which has to be nearly isotropic in the LES region, in respect of the DDES choice of the turbulence length scale, 59 cells have been distributed over a 0.33$c$ spanwise length with a constant spacing, resulting in a final grid of about 9.65 M cells. The computations have been carried out in the SGI Altix supercomputer at CINES (Centre informatique national de l’enseignement supérieur), by using 1024 parallel processors in MPI.

3.4.1. Flowfield dynamics

The time-dependent lift coefficient according to the aforementioned models is presented in Fig. 10 for the fully established regimes, beyond transient phases. While in URANS $k - \omega$ SST the lift coefficient oscillates quasi-harmonically at a frequency of 82 Hz, the DDES produces sharp-like and much stronger lift fluctuations. The high slope of the curve indicates that the shock-motion speed is relatively high, especially during the lift fall when the flow separates and the shock moves upstream. The predicted buffet frequency in the DDES case is approximately 108 Hz. The large amplitude of the fluctuations suggests existence of modelled-stress depletion (MSD) [15] and indicates that shock-wave motion is wider than in case of the $k - \omega$ SST model. The OES-$k - \varepsilon$ model provides an almost sinusoidal behaviour of the oscillations at 107 Hz and a slightly higher amplitudes than the $k - \omega$ SST. This behaviour is in-between the URANS and DDES evolutions. The spectral analysis of the lift coefficient is shown in Fig. 11, where $St = f U_\infty / c$ is the non-dimensionalised frequency, with $f$ the frequency in Hz, $U_\infty = 228$ m.s$^{-1}$ the freestream velocity and $c = 0.25$ the chord of the airfoil. These spectra are similar to the experiments by Jacquin et al. [8, 3] concerning the buffet mode identification for the OAT15A supercritical airfoil configuration in the same Mach and Reynolds number range. Moreover, the OES modelling sensitised to reduce the turbulent diffusion and enhance coherent structure appearance, provides spectra of a similar shape to the study of Szubert et al [5] carried out for the OAT15A, showing the buffet frequency as well as a spectral bump related to the von Kármán mode associated with alternating vortices past the trailing edge.
Figure 10: Comparison of the time-dependent evolution of the lift coefficients between URANS $k - \omega$ SST, 2D and 3D OES-$k - \varepsilon$ and DDES-$k - \omega$ SST as shown in Fig. 17 for the V2C profile. This two-mode interaction sustains a feedback loop including also Kutta waves as shown in this figure, in qualitative comparison with experiments (Fig. 18). This aero-acoustic feedback mechanism was schematically presented in Lee [26].

Table 3 shows the values of the buffet frequency as well as the corresponding Strouhal numbers and mean and RMS values of lift coefficient per turbulence model. In the spectra, the DDES-$k - \omega$ SST provides the highest continuous spectral level, indicating a lower turbulence diffusion rate predicted by this model (also shown in the turbulent viscosity field as discussed at the end of this section, Fig. 20). The $k - \omega$ SST and OES-$k - \varepsilon$ provide in addition to the main frequency bump corresponding to the buffet instability, bumps beyond 2000 Hz, which are related to the von Kármán instability and other vortex interactions past the trailing edge as discussed in [5]. In all the spectra, the presence of the buffet mode is illustrated by a frequency bump instead of a sharp peak, because of the non-linear interactions of the buffet mode with the von Kármán, shear-layer
Figure 11: Comparison of the power spectra density of the lift coefficients time-dependent evolution between URANS $k-\omega$ SST, 2D and 3D OES-$k-\varepsilon$ and DDES-$k-\omega$ SST turb. model.

<table>
<thead>
<tr>
<th>Turb. model.</th>
<th>$k-\omega$ SST</th>
<th>OES-$k-\varepsilon$ 2D</th>
<th>OES-$k-\varepsilon$ 3D</th>
<th>DDES-$k-\omega$ SST</th>
</tr>
</thead>
<tbody>
<tr>
<td>$C_D \times 10^2$</td>
<td>6.163</td>
<td>8.119</td>
<td>8.188</td>
<td>9.106</td>
</tr>
<tr>
<td>$C_L$</td>
<td>0.942</td>
<td>1.059</td>
<td>1.061</td>
<td>0.875</td>
</tr>
<tr>
<td>$\sigma(C_L)$</td>
<td>0.084</td>
<td>0.106</td>
<td>0.106</td>
<td>0.145</td>
</tr>
<tr>
<td>RMS($C_L$)</td>
<td>0.946</td>
<td>1.067</td>
<td>1.067</td>
<td>0.886</td>
</tr>
<tr>
<td>$f_B$ (Hz)</td>
<td>82</td>
<td>107</td>
<td>108</td>
<td>108</td>
</tr>
<tr>
<td>$St = f_B \varepsilon/U_0$</td>
<td>0.09</td>
<td>0.118</td>
<td>0.12</td>
<td>0.12</td>
</tr>
</tbody>
</table>

Table 3: Comparison of the aerodynamic coefficients and buffet frequency between turbulence modelling methods for 9 periods of buffeting.
and other more random motions downstream. Therefore, the present simulations capture the dynamics of the buffet and near trailing-edge instability modes and of their interaction producing a multitude of frequencies between these modes, which sustain a feedback loop among the shock oscillation region, the separated shear layer and the near wake. These interactions and feedback loop, schematically reported in [26], have been analysed in detail by [5], using time-frequency analysis by means of wavelets and Proper Orthogonal Decomposition in addition to a spectral analysis. Fig. 12 shows the mean surface pressure coefficient. All models are in agreement in the suction side, with a slight increase of lift near the trailing edge in case of OES-$k-\varepsilon$, which corresponds to a higher averaged lift coefficient (Table 3). The $k-\omega$ SST model produces the shortest inclination of the $C_p$ within the shock region and therefore the less developed shock oscillation amplitudes. The largest amplitudes correspond to the DDES- $k-\omega$ SST, as can be implied by the high amplitude lift coefficient oscillations. This feature, accompanied by a higher trailing-edge pressure plateau, is similar to a thicker airfoil’s $C_p$, as for example in the experimental study of McDevitt et al. [1] for a circular-arc airfoil in transonic regime, as well as in the ZDES of Deck [6] (Fig. 6 in this reference) and in the DDES-Spalart-Allmaras study of Grossi et al. [7] (Fig. 9 of this reference). This common tendency occurs among these approaches using different numerical schemes (the AUSM in Deck’s study, the 3rd order Roe upwind scheme in Grossi’s study as well as in the current study). Therefore, it seems that the hybrid RANS-LES models provide a higher level of suction and flow detachment in the present family of supercritical airfoils. This behaviour can be explained by means of turbulent viscosity levels of the three modelling approaches used in the present study and by considering the frontier between the URANS and LES regions, commented in a dedicated discussion at the end of this section. The OES-$k-\varepsilon$ produces an in-between behaviour, similar to the flow simulations around the supercritical OAT15A airfoil with fixed transition at 7% (Szubert et al. [5]) which compare quite well to experimental results by Jacquin et al. [8, 3]. Therefore, it can be reasonably supposed that in the V2C case, a fairly good comparison of the present URANS studies (better than the DDES behaviour) is expected from the ongoing experimental campaign in the TFAST project.

Fig. 13 shows the mean pressure fields superimposed with streamlines according to the previous models. The DDES illustrates the largest separation area and the OES indicates a higher circulation intensity, corresponding to the lift increase. The $k-\omega$ SST and OES-$k-\varepsilon$ provide qualitatively comparable recirculation regions. The same feature stands for the mean velocity profiles shown in Fig. 14, in the near-wall region concerning the locations $x/c = 0.2, 0.4, 0.6$ and 0.8. In the

Chapter 3. Physics and modelling around two supercritical airfoils
Figure 12: Comparison of the wall pressure coefficient between URANS $k-\omega$ SST, OES-$k-\varepsilon$ and DDES-$k-\omega$ SST

Figure 13: Mean pressure fields and streamlines around the profile

intermediate region at $x/c = 0.4$, the $k-\omega$ SST shows a narrower boundary-layer thickness. The DDES illustrates the wider shock motion, yielding to a less expanded velocity profile at $x/c = 0.2$ and a much more separated one at $x/c = 0.8$ than the other two models.

A series of flow snapshots is presented in Fig. 15 for one period of buffet in the case of the DDES-$k-\omega$ SST. It helps understanding the dynamics of the flow predicted. The figures illustrate instantaneous isosurfaces of non-dimensional Q-criterion for $Q(c/U)^2 = 75$ as a function of the non-dimensional time $t^* = tU/c$, where $t^* = 0$ is an instant of maximum lift. Surfaces are colored with the Mach number. During the upstream travel of the shock (Fig. 15(a)), alternate vortex
Figure 14: Mean velocity profiles at locations $x/c = 0.2, 0.4, 0.6$ and $0.8$ for URANS $k-\omega$ SST, OES-$k-\varepsilon$ and DDES-$k-\omega$ SST.
shedding can be observed at the trailing edge. The primary structures are always three-dimensional. As the shock approaches the leading edge, the flow over the upper surface gets fully separated and the shear layer becomes unstable (Fig. 15(b)). Such intense separation generates a large wake combining the eddies produced in the shear layer and the trailing edge structures. As the shock and the separation point move downstream, the height and streamwise extension of the separation region decrease and the amount of resolved flow structures reduces as seen in the sequence in Fig. 15(c). Unlike in URANS, a considerable amount of separation always exists on the rear part of the airfoil. While the shear layer becomes stable as the shock wave approaches its most downstream position, the alternate vortex shedding at the trailing edge is always present during buffet (Fig. 15(d)).

A series of mid-span plane snapshots is presented in Fig. 16 and in Fig. 17 for one period of buffet regarding the DDES-\(k - \omega\) SST and the OES-\(k - \varepsilon\) respectively. These instantaneous fields are similar to Schlieren visualisations and illustrate the shock motion, the Kutta waves travelling from the trailing edge to upstream positions, the von Kármán vortices past the trailing edge and the smaller-scale Kelvin-Helmholtz vortices in the separated shear layers, among other more chaotic vortex structures. The DDES-\(k - \omega\) SST simulations provide a quite rich turbulence content and a large shock motion and separation regions, extended near the leading edge. The OES-\(k - \varepsilon\) provides a shorter shock-motion amplitude
Figure 16: Divergence of velocity field - DDES-$k-\omega$ SST and a visualization of the compressibility effects in qualitative agreement with D. W. Holder [27], Fig. 18.

In order to understand the DDES behaviour which provided such a large separation, the distribution of the RANS and LES regions has been monitored allowing assessment of the present DDES ability to switch between the two modes (URANS and LES) during buffet and of the size of the two regions. The instantaneous distributions of the delaying function $1 - f_d$ of the DDES at four phases of buffet are given in Fig. 19. The irregular black areas over the upper surface indicate large regions of separation, even when the shock is at its most downstream position (Fig. 19(d)), where a large amount of rear separation exists on the upper surface. This analysis shows the existence of a RANS-mode layer covering the near-wall region around the V2C airfoil. The overall height of this layer seems to be relatively small. This might cause some degree of MSD [15] due to the erroneous penetration of the LES mode into attached boundary layers, which facilitates separation. This behaviour was also observed in the DDES studies by
3.2. Laminar airfoil

Figure 17: Divergence of velocity field - OES-k – ε

(a) $t^* = 0$

(b) $t^* = 0.83$

(c) $t^* = 3.28$

(d) $t^* = 4.92$

Figure 18: Schlieren photograph of the eddying wake following a shock-induced flow separation (Courtesy of National Physical Laboratory, England; study by Duncan et al. [28]; photo by D. W. Holder)
Deck [29] improved by a zonal DES approach. In this article, Fig. 19, the development of the shear layer instabilities appear at a considerable distance past the separation point, whereas in our case they appear earlier (Fig. 15). The article also by Uzun et al. [30] has been referenced thanks to a clear representation of the \( f_d \) function delimiting the RANS region in the boundary layer around the body (Fig. 7 in their study), which is similar to the behaviour of this function in the present study and the fact that the shear layers past the cylinder are treated by LES in that study. In addition, these shear layers (Fig. 8 in that paper) display the instability development at a considerable distance downstream of the separation point in respect of the appearance of Kelvin-Helmholtz vortices. The same behaviour was reported by Mockett et al. [31] concerning the acceleration of the transition between RANS and LES in a free shear layer by various DES approaches. The present DDES behaviour illustrated by the previous flow visualisations, the mean \( C_p \) and lift coefficients can be explained as follows: the pressure near the trailing edge (Fig. 12) is underestimated in the case of DDES, displaying a significant suction comparing with the URANS cases. The DDES provides a higher shock’s excursion from the leading edge up to more than half of the chord yielding a pressure increase in this area. Therefore, the resulting lift is lower than in URANS and consequently, the corresponding circulation is lower.

In this case, the pressure aspiration effect on the suction side and the overall separated region seems to be more intense than in other cases. The related instabilities are more pronounced and start more upstream in the shear layers than in cases where the excursion of the shock has a shorter amplitude. These results are not linked to a strong delay in the formation of instabilities in the shear layer and in the overall suction region but on a too early onset of instabilities. This is viewed in the 3D plots of Fig. 15 where a strong and rich statistical content of vortices are developed in the suction area from practically the leading edge. Indeed, the difference between the “peaky” shape and the more “sinusoidal” one indicates that at the same instant, the lift is lower in the DDES case, upstream and downstream of the sharp peak. This behaviour is in accordance with the “peaky” shape of the lift coefficient displayed by the DDES-SST, comparing to the OES simulations (Fig. 10). This is in accordance with the aforementioned elements concerning the pressure distribution and the mean lift. The reasons for this can be as follows. In Fig. 19, the frontier between RANS and LES regions are shown. It can be seen that a significant part of the shear layer is handled by RANS computation (see dark zone past the separation point), but this does not inhibit the development of instabilities which are quite displayed in the upstream region. Moreover, the dark region surrounding the airfoil near the wall is associated with RANS computation.
within the boundary layer. Therefore, the LES approaches drastically the wall region. This would need a finer grid in this area. Moreover, the reason for the DDES behaviour, also depicted by another partner (URMLS) within the TFAST European program (M. Bernardini, S. Pirozzoli, private communication), by using DDES-SA and a different numerical code, may be due to the turbulent viscosity produced by the model in association with the grid. In order to illustrate the effect of the turbulent viscosity produced by the turbulence model, the ratio $\frac{\nu_t}{\nu}$ is plotted in Fig. 20. It can be seen that the DDES produces a much lower turbulence viscosity (order of 200 in the separated regions) than the URANS-OES (order of 1800), leading to a lower dissipation level which excessively amplifies smaller-scale structures in the separated area and a more intense separation. In the OES case, the higher $\nu_t$ level improves this feature. The use of the Spalart-Allmaras model instead of the $k-\omega$ SST in the DDES provided even higher shock amplitude oscillations because the maximum ratio $\frac{\nu_t}{\nu}$ was of order 250 [32], Fig. 6.15 in this reference. This behaviour was shown for the lift oscillation in [33], Fig. 13. As can be shown in the lift oscillations, the ‘peaky’ behaviour disappears on the benefit of a more sinusoidal shape with a higher pressure plateau up to 30% of the chord, a shorter excursion of the shock as well as an improved effect on the pressure ‘plateau’ near the trailing edge with less suction (see Fig. 12).

In a study in progress, the OES-$k-\varepsilon$ model results will be analysed in detail, in order to take benefit from the more regular buffet oscillations and simultaneously from the formation of the additional frequency bumps shown in Fig. 11, as in the study by Szubert et al. [5].

(a) Maximum lift ($t^* = 0$)  (b) Shock upstream ($t^* = 1.46$)
(c) Minimum lift ($t^* = 2.96$)  (d) Shock downstream ($t^* = 6.02$)

Figure 19: RANS and LES regions around the V2C airfoil according to the DDES-$k-\omega$ SST
Figure 20: Comparison of the turbulence viscosity field between URANS $k-\omega$ SST (a), 2D (b) and 3D (c) OES-$k-\varepsilon$ and DDES-$k-\omega$ SST (d) at minimum (left) and maximum (right) lift.
4. Conclusion

The present study analysed the SWBLI in the case of the transonic flow around the V2C-Dassault Aviation profile in two and three dimensions by means of statistical and hybrid RAND-LES turbulence modelling in the high Reynolds number regime of 3.245 million. The critical range of angle of attack for the buffet appearance has been investigated by means of 2D URANS computations and found near 5.5°. The different flow phenomena occurring around the airfoil for various angles of attack at Mach number 0.70 have been analysed. The pressure and skin friction distributions have shown the angle of attack effect on the shock wave position, as well as on the state of the boundary layer interaction with the shock foot. The influence of a fixed transition location on the flow physics has been studied in the steady and unsteady cases and particularly on the buffet dynamics. Based on these results, a major outcome is a non-classical optimisation procedure coupling the CFD results with a Kriging method, applied to the transition location regarding the averaged aerodynamic coefficients. In the steady case, an optimal position of the fixed transition has been found near $x_t/c = 0.30$ regarding the averaged lift/drag ratio. Particularly, the transition location effect on the unsteady case with buffeting conditions (angle of attack of 5.8°) has been analysed with the same method and yields an optimum position at $x_t/c = 0.2665$. These elements contribute to the improvement of laminar wing design for future generation of aircraft’s wings, in respect of the greening requirements of the Horizon 2020 objectives. Furthermore, the flow dynamics of a fully developed buffet case at angle of incidence of 7.0° have been investigated in respect of the predictive abilities of statistical and hybrid turbulence modelling. The DDES simulations displayed a rich content of resolved flow structures and provided a strongly detached flow and a large shock amplitude, extended from the leading to the trailing edge. This behaviour has been analysed and discussed in respect the MSD and eddy-viscosity levels induced by this modelling associated to the present grid and numerical parameters. The URANS simulations based on the $k - \omega$ SST model have indicated a high turbulence diffusion level and a decrease in the appearance of instabilities pas the trailing edge, as well as a short shock amplitude. The OES approach provided an intermediate behaviour between the two mentioned with a reasonably extended shock amplitude and capturing of the von Kármán and shear-layer vortices downstream of the SWBLI and of the trailing edge. In a study in progress, the association of DDES with OES will be examined in order to take relative benefits from both approaches.
Acknowledgements

The present work was supported by the TFAST European project No 265455 – Transition location effect on shock-wave/boundary-layer interaction. The research team thankfully acknowledges the French computing centers CINES (Centre informatique national de l’enseignement supérieur) and CALMIP (Calcul en Midi-Pyrénées) for the allocated resources as well as for their availability. They thank Matteo Bernardini and Sergio Pirozzoli for their valuable discussions about the turbulence modelling behaviour in the context of the TFAST collaboration.

References


Chapter 4

Numerical study of an oblique-shock/boundary-layer interaction

This study is also carried out in the context of the TFAST European project. The oblique-shock/boundary-layer interaction in one of the test cases handled by the programme, among with normal-shock/boundary-layer interaction, turbine and compressor blades and a laminar airfoil in transonic speed presented and studied in the previous chapter (section 3.2 page 3.2). The Center for Turbulence Research summer program 2014 was a great opportunity for a collaboration between the researchers and students working there and our team, exchanging our knowledge, skills and opinion on the methods and strategies handled by each team, as well as other invited researchers. This programme leads to an substantial number of proceedings available online\(^1\). The paper presenting the results from wall-modelled LES on the CTR side, and from delayed-detached eddy simulation on our side (Szubert et al., 2014b), has been included in this manuscript, from the following page.

\(^1\) ctr.stanford.edu/publications.html

117
Numerical simulations of oblique shock/boundary-layer interaction at a high Reynolds number

By D. Szubert†, I. Jang, G. I. Park and M. Braza†

This study investigates numerical analysis of the oblique shock/boundary-layer interaction (OSBLI) in a Mach 1.7 flow with a unit Reynolds number of 35 million. Two methods of simulations are performed and compared with an experiment. While two different delayed detached-eddy simulations (DDES) are performed to simulate the full-span geometry, a wall-modeled large-eddy simulation (WM-LES) is carried out to study the physics near the mid-span area. In the experiment, the boundary layer is tripped at the leading edge of the flat plate to ensure fully turbulent boundary layer at the interaction zone. The tripping device in the WM-LES computations was simulated by artificial blowing and suction, while in the DDES simulation turbulence is generated by a Reynolds-Averaged Navier-Stokes (RANS) model and its intensity is adjusted to match the experimental one. Challenges to simulate this test case as well as comparison between the two numerical studies with the experimental results are highlighted in this paper.

1. Introduction

Research for more effective transport systems and the reduction of emissions, which places severe demands on aircraft velocity and drag reduction, is intense. In order to diminish the shock-induced separation, the boundary layer at the point of interaction should be turbulent. However, the greening of air transport systems means a reduction of drag and losses, which can be obtained by keeping laminar boundary layers on external and internal airplane parts. Therefore, it is very important to develop predictive capabilities of shock-wave/boundary-layer interaction (SBLI) corresponding to new generation of flight conditions and of turbomachinery applications. For example, oblique shock/boundary-layer interaction (OSBLI) has been intensively studied in the European program TFAST (Giepman et al. 2014; Szubert et al. 2014).

Although computational fluid dynamics (CFD) tools have been frequently used to understand the physical dynamics of OSBLI, the existing computational techniques are in need of further improvement. In their review on the topic, Knight & Degrez (1998) conclude that traditional eddy-viscosity-based Reynolds averaged Navier-Stokes (RANS) approaches may provide unsatisfactory predictions of important features of OSBLI. While interest in higher-fidelity simulations such as DNS or wall-resolved LES is growing, the computational costs quickly become extremely expensive for such complex flows at large Reynolds numbers. Therefore, an optimal compromise between predictive accuracy and computational cost is required to support the design process of supersonic applications. A possible candidate could be a hybrid RANS-LES modeling (for example, delayed-detached eddy simulation (DDES) by Spalart et al. 2006). Another candidate is LES

† Institut de Mécanique des Fluides de Toulouse, UMR 5502 (CNRS, INPT, UPS), France
coupled with wall modeling that directly models wall shear stress $\tau_w$ and wall heat flux $q_w$ (Kawai & Larsson 2012). Unlike DDES, this wall-modeled LES (WM-LES) resolves the flow all the way down to the wall, but instantaneous $\tau_w$ and $q_w$ are provided by the wall model as a wall boundary condition.

The objective of this study is to evaluate the performance of DDES and WM-LES in the context of a fully turbulent boundary layer interacting with an oblique shock wave in a supersonic flow. More specifically, the test case treated by the computational techniques is an experimental Mach 1.7 oblique shock wave configuration studied by Giepman et al. (2014).

2. Methodology

2.1. Geometry and conditions

The geometry of interest for this study is taken from the experiment performed in a transonic/supersonic wind tunnel at the Technical University of Delft (Giepman et al. 2014). The cross-sectional area of the test section is 270 mm (height) × 280 mm (width), and the tunnel was operated at a Mach number of 1.7 with a unit Reynolds number of 35 million. The total pressure and the total temperature were 2.3 bar and 278 K, respectively. The free-stream turbulence level was about 0.5%.

The setup consists of two models, a full-span flat plate with a sharp leading edge ($R \approx 0.15$ mm) and a symmetric partial-span shock generator whose deflection angle is $3^\circ$, as shown in Figure 1 (left). The length of the flat plate ($L$) is 120 mm, and the leading-edge shock of the flat plate itself was very weak ($\theta \approx 0.1^\circ$). The span-wise width of the flat plate ($W$) is 272 mm, whereas the shock generator has a partial span of 180 mm ($0.66W$). The oblique shock from the shock generator impinges at $x_{LE} = 71$ mm on the flat plate, where $x_{LE}$ is the distance from the leading edge of the flat plate.

In the experiment, the flow is tripped at $x_{LE} = 5$ mm by a zig-zag strip to ensure the presence of a fully turbulent boundary layer entering the shock/boundary-layer interaction. The zig-zag strip is 0.2 mm thick and located in the zone between $x_{LE} = 5$ mm and $x_{LE} = 16$ mm. The span-wise period of the zig-zag shape is 6 mm, and the traversal length of the strip, from the leading edge to the trailing edge of the strip, is 5.8 mm. Without this tripping device, the natural transition is located approximately at $x_{LE} = 71$ mm.

2.2. Hybrid RANS-LES modeling (DDES)

The DDES simulations of the oblique-shock configuration have been performed with the Navier-Stokes Multi-Block (NSMB) solver. The NSMB solver is the fruit of a European consortium coordinated by CFS Engineering in Lausanne, Switzerland. NSMB is a structured, finite-volume based, compressible code that includes a variety of efficient high-order numerical schemes and of turbulence modeling closures in the context of LES, URANS and of hybrid turbulence modeling. In this study, a third-order Roe upwind scheme associated with the MUSCL van Leer flux limiter scheme has been used for spatial discretization of the convective fluxes.

The DDES formulation used in this study (Spalart et al. 2006) is based, for the unsteady RANS part, on the Edwards-Chandra (Edwards & Chandra 1996) modified Spalart-Allmaras model (Spalart & Allmaras 1994). The Edwards-Chandra modifications result in smooth and faster convergence. A recent application of the DDES method with the NSMB solver can be found in Grossi et al. (2014). Implicit time integration us-
Numerical simulations of OSBLI at high Re

Figure 1. Left: Side view of the experimental geometry; right: computational grid for the DDES (mid-span plane) and main dimensions

<table>
<thead>
<tr>
<th>N_{total}</th>
<th>\Delta^+_x</th>
<th>\Delta^+<em>y</em>{min}</th>
<th>\Delta^+_z</th>
<th>\Delta_x/\delta_o</th>
<th>\Delta_y_{min}/\delta_o</th>
<th>\Delta_z/\delta_o</th>
<th>h_{wm}^+</th>
<th>h_{wm}/\delta_o</th>
</tr>
</thead>
<tbody>
<tr>
<td>DDES</td>
<td>31 \times 10^6</td>
<td>296.0</td>
<td>0.04</td>
<td>1006.4</td>
<td>0.42</td>
<td>5.7 \times 10^{-5}</td>
<td>1.42</td>
<td></td>
</tr>
<tr>
<td>WM-LES</td>
<td>4.7 \times 10^6</td>
<td>63.0</td>
<td>8.2</td>
<td>46.3</td>
<td>0.089</td>
<td>0.011</td>
<td>0.065</td>
<td>31.0</td>
</tr>
</tbody>
</table>

Table 1. Grid properties: the grid sizes are normalized by \(\delta_{+o}\) or \(\delta_o\), where the wall viscous unit \(\delta_{+o} = \mu_w/\left(\rho_w u_{e,o}\right) = 1.35 \times 10^{-3}\) mm calculated from the flow values.

The dual-time stepping technique has been performed. Typically, 70 inner iterations were necessary for convergence in each time step.

The DDES computations are performed on a full-span domain \((272\,\text{mm}, W_{DDES}/W = 1)\) using symmetry conditions. Two hundred cells are distributed along the span-wise direction. Far-field conditions using the Riemann invariant are imposed at the inlet and outlet, as well as at the top and bottom boundaries. The boundary conditions of the two geometrical elements are adiabatic solid walls. Figure 1 (right) shows a vertical sliced plane of the grid used for the DDES computation. Details of the resolution of this grid are indicated in Table 1. Two DDES calculations are performed. Since previous 2D RANS calculations (Szubert et al. 2014) showed an early transition, the first DDES calculation uses no treatments to simulate the effect of the zig-zag tripping in the experiment. A second DDES computation has been carried out by conditioning the flow in a region of short length from the leading edge of the flat plate. This conditioning consists in imposing the turbulent viscosity \(\nu_t\) to be equal to zero in a defined area of the flow, forcing laminarity in this area, while everywhere else \(\nu_t\) is evolved from the inlet boundary, based on the experimental value, through the RANS modeling. The rectangle conditioning zone has a height of 1.5 mm from the flat-plate surface and a length of \(x_{LE} = 23\,\text{mm} (0.20L)\) from the leading edge, which corresponds to the onset location of the transition in this new simulation. In this case, the development of the turbulent boundary layer is spatially delayed and shows a better agreement with the experiment. This simulation is referred in this study as transitional DDES. All the other simulation parameters remained the same as those in the initial DDES computation.

2.3. Wall-modeled LES

We use the unstructured compressible LES solver CharLES\textsuperscript{r}, developed at the Center for Turbulence Research (Bodart & Larsson 2012). CharLES\textsuperscript{r} utilizes energy-conserving
Figure 2. WM-LES mesh: (left) computational grids near flat-plate and shock-generator models; (right) enlarged image in the middle of the flat plate

numerics and shows nearly second-order spatial errors for unstructured grids. It also has the ability to detect shocks and switch its central scheme to a 2nd-order ENO method near the detected shocks. For time integration, we use a 3-stage Runge-Kutta method. The Vreman model (Vreman 2004) is applied to model the sub-grid scale motions.

The wall model implemented in CharLES was initially proposed by Kawai & Larsson (2012) and generalized by Bodart & Larsson (2012). Since the LES grids do not resolve the inner layer of boundary layers, the wall model calculates the wall shear-stress vector $\tau_w$ and the wall heat-flux $q_w$ and provides them to the LES solver as wall boundary conditions. The model equations are derived from the momentum and energy equations in boundary layers. Based on the assumption of equilibrium boundary layers, all the other terms in the boundary layer equations except the diffusion terms are neglected, which results in a coupled set of ordinary differential equations. A matching location $h_{wm}$ is specified, at which the solution from the LES grid, $(\rho, u, T)$, is imposed as the upper boundary condition to the wall-model equations. As discussed in Kawai & Larsson (2012), there are at least four LES grid points below $h_{wm}$.

The WM-LES were performed on a domain whose total stream-wise length is $2.16L$, where again $L = 120$ mm is the stream-wise length of the flat plate. The leading edge of the flat plate is located $0.32L$ from the supersonic inlet, and the domain ends $0.84L$ from the trailing edge of the flat plate. The domain height is the same as the wind-tunnel height of the experiment (0.255 mm). The span-wise domain length ($W_{WM-LES}$) is 3 mm ($W_{WM-LES}/W = 0.011$, $W_{WM-LES}/L = 0.025$), and periodic boundary conditions are used. The LES grids are locally refined in the flat-plate boundary layer ($0 \text{ mm} \leq x_{LE} \leq 98.25$ mm) and near the shocks. Figure 2 shows a close view of the refined mesh. The resolutions of the LES mesh and the matching location height are indicated in Table 1.

The inflow turbulence is generated by the digitally filtered synthetic turbulence by Touber & Sandham (2008) that is implemented in CharLES by Bermejo-Moreno et al. (2011). The turbulent intensity of the synthesized turbulence is the same as the experiment. A supersonic characteristic boundary condition is imposed at the outlet boundary. The top and bottom boundaries are slip walls, and thus the flow cannot penetrate through those boundaries. The walls of the flat plate and the shock generator are adiabatic. As previously explained, periodic boundary conditions are enforced in the span-wise direction. The flow field is initialized with a steady-state two-dimensional RANS simulation.
Numerical simulations of OSBLI at high Re

result, and the simulation runs for a total run time of 634.3T (statistics are taken after 422.9T), where the time scale T is defined as $T = \delta_o/u_{\infty}$.

In the experiment, the flow is tripped at the leading edge by a 0.2 mm thick zig-zag strip to generate a fully turbulent boundary layer. In the WM-LES simulation, turbulence is triggered by blowing-and-suction at the wall. Following Huai et al. (1997), the blowing and suction boundary condition has the form of the following oblique-wave function,

$$v(x, z, t) = A_1 f(x) \sin(\omega t) + A_2 f(x) g(z) \sin\left(\frac{\omega}{2} t\right).$$

The stream-wise mode $f(x)$ is taken from Fasel & Konzelmann (1990), which is given as

$$|f(x)| = 15.1875 \zeta^5 - 35.4375 \zeta^4 + 20.25 \zeta^3,$$

where

$$\zeta = \begin{cases} \frac{x-x_s}{x_e-x_s} & \text{for } x_s \leq x \leq x_m \\ \frac{x-x_m}{x_e-x_m} & \text{for } x_m \leq x \leq x_e \end{cases},$$

and the stream-wise coordinates are $x_s = 7.75$ mm, $x_m = 10.5$ mm, and $x_e = 13.25$ mm from the leading edge of the flat plate. The span-wise mode $g(z)$ is defined as $g(z) = \cos(2\pi z/\lambda_z)$. The wave amplitudes are $A_1 = 0.05 U_{\infty}$ and $A_2 = 0.005 U_{\infty}$. In order to obtain a strong response from the blowing-and-suction boundary condition similar to that in the experimental tripping device, the amplitudes $A_1$ and $A_2$ are taken to be much greater than those in the H-type transition studies such as Fasel & Konzelmann (1990), Huai et al. (1997), and Sayadi et al. (2013). The non-dimensional frequency is $F = 5.42 \times 10^{-4}$, where $F = 2\pi \omega (\nu_{\infty}/\rho_{\infty} U_{\infty}^2)$, and the span-wise wavelength $\lambda_z$ is 3 mm. Since the other frequencies and magnitudes except the given values are not investigated in this study, the effects of different blowing-and-suction parameters are not clear.

3. Results and discussion

Since turbulence is generated by mechanisms different from those in the experiment, it is important to verify that the upstream laminar boundary layer becomes the equilibrium turbulent boundary layer by the time when it reaches the shock impingement point ($x_{LE} = 71$ mm). In order to compare compressible results against incompressible skin-friction correlations, we transformed the skin-friction coefficient by using the van Driest II transformation (van Driest 1951), which is given as

$$C_f^{VD} = \frac{T_w/T_{\infty} - 1}{\arcsin^2 \psi} C_f, \quad \psi = \frac{T_w/T_{\infty} - 1}{\sqrt{T_w/T_{\infty} (T_w/T_{\infty} - 1)}}, \quad \text{Re}_{VD} = \frac{\mu_{\infty}}{\mu_w} \text{Re}_{\theta}.$$ 

The transformed skin-friction coefficient $C_f^{VD}$ is then compared with the Blasius laminar profile and the turbulent theory by von Kármán & Shoenherr (Hopkins & Inouye 1971) given as

$$C_f^B = 0.26 \text{Re}_{\theta}^{-0.25}$$

and

$$C_f^{KS} = \left\{17.08 (\log_{10} \text{Re}_{\theta})^2 + 25.11 \log_{10} \text{Re}_{\theta} + 6.012\right\}^{-1}.$$

Figure 3 shows the skin-friction coefficients in the simulations compared with the two theoretical profiles. The WM-LES data are taken in the region of $x_{LE} = 18 - 65$ mm. The turbulent boundary layer in WM-LES matches very well with the theoretical curve after it becomes turbulent ($\text{Re}_{\theta} > 1000$) by using blowing and suction. The DDES result first
follows the laminar Blasius profile but undergoes transition to turbulence much earlier than WM-LES. After transition, a significant discrepancy between the DDES and the theoretical skin friction for equilibrium boundary layers is observed. With regard to the transitional DDES, the boundary layer is not free to develop in terms of turbulence, which explains the unusual aspect of the curve up to \( \text{Re}_\theta < 1150 \). Downstream of this location, outside the conditioning area, the skin-friction coefficient confirms that the boundary layer is fully turbulent, matching well with the theoretical and the WM-LES values, which endorses the use of the boundary-layer conditioning. A qualitative comparison of the stream-wise and wall-normal velocity fields are provided in Figure 4. In the figures, the horizontal axis is the distance from the shock impingement point \( x_{sh} \), where \( x_{sh} \) is 71 mm from the leading edge of the flat plate. The vertical axis of the figures is the distance from the flat plate. The averaged fields from DDES and WM-LES are compared with the steady experimental PIV measurements. Despite extra waves generated by the WM-LES and visible in the \( v/U_\infty \) field from the SBLI, the two numerical methods compare well with the experiment.

In Figure 5, the mean stream-wise velocity profiles of the boundary-layer, around \( x_{sh} \), are provided at eight different stream-wise locations and allow a more detailed comparison. The velocity profiles are normalized by the corresponding local free-stream velocities in the experiment at each location. In the DDES case, the mean stream-wise velocity is underestimated compared to the experiment, which can be understood as an overestimation of the development of the turbulence in the boundary layer. The Spalart-Allmaras model induces a quasi-instantaneous laminar-turbulent transition from the leading edge in the RANS layer (Figure 3), while in the experiment, the transition is triggered in
Chapter 4. Numerical study of an oblique-shock/boundary-layer interaction

Numerical simulations of OSBLI at high Re

Figure 5. Velocity profiles at 8 stream-wise locations: normalized by experimental $u_\infty$ at each location: DDES, WM-LES, and experiment

the zone of $x_{LE} = 5 - 16$ mm by the zig-zag tripping. The result of the transitional DDES matches better with the experiment by using the conditioning of the boundary layer, which delays its development to the turbulent state, until the flow approaches the interaction zone where the decrease in velocity observed in the experiment is underpredicted. WM-LES profiles matches well with the experiment, especially in the upstream and downstream directions of the OSBLI zone. In the interaction zone ($x - x_{sh} = 0.1$ and $4.8$ mm), however, there are noticeable discrepancies from the experiment, similar to the transitional DDES. Since an equilibrium WM-LES formulation is used in this study, non-equilibrium effects such as strong pressure gradient and flow recirculation cannot be achieved in the wall model. Dawson et al. (2013) also observed poor predictions through interaction in their study of a supersonic compression ramp using a WM-LES. By investigating the magnitude of each term in a wall-resolved LES in the same configurations, they concluded that the convective and pressure gradient terms are dominant in near interaction zone. However, previous attempts to include dominant terms measured at the matching location ($h_{wm}$) in the equilibrium formulation such as that by Hickel et al. (2012) not only had difficulties in showing a satisfactory result but also suffered from numerical stability problems. As the flow goes downstream of the interaction and recovers equilibrium behavior, the WM-LES profiles is getting close to the experiment. Therefore, it may be necessary to solve the full non-equilibrium equations in the wall model. However, the accuracy of the PIV measurements in the SBLI region is reduced compared to that of the other regions of the boundary layer.

Figure 6 shows the distributions of boundary-layer thickness ($\delta_{99}$), displacement thickness ($\delta^*$), momentum thickness ($\theta$), and shape factor ($H = \delta^*/\theta$) as a function of $x_{LE}$. For $\delta_{99}$, DDES and WM-LES match relatively well with the upstream of the SBLI, given the fact that in general $\delta_{99}$ cannot be accurately defined for such complex flows. For $\delta^*$ and $\theta$, however, the DDES slightly overestimates the integral values, which confirms the remarks of the previous paragraph: without any conditioning, the DDES generates an early development of the turbulent boundary layer compared to the experiment. This can be corrected by imposing the transition at $x_{LE} = 23$ mm, as explained above. In this case, the development of the boundary layer is delayed, as shown in all the graphs, and the integral values downstream of the transition location get closer to the WM-LES and the experiment. In the interaction zone, none of the numerical methods can predict
Figure 6. Boundary layer thicknesses: (top left) 99% boundary-layer thickness ($\delta_{99}$) (top right) displacement thickness ($\delta^*$) (bottom left) momentum thickness ($\theta$) (bottom right) shape factor ($H$); DDES, DDES (transitional), WM-LES, experiment.

accurately the quantities. In the downstream of the interaction, the WM-LES approaches the experimental values as well as the transitional DDES, as observed in Figure 5. For the shape factor ($H$), both the transitional DDES and the WM-LES are reasonably close to the experimental value in $x_{LE} < x_{sh}$. In the interaction zone, the transitional DDES and the WM-LES follows the general trend of the experiment but shows noticeable discrepancies from the experiment. In the downstream of the interaction zone, the transitional DDES shows a better agreement with the experiment. Interestingly, the DDES results are closer to the experiment for $x_{LE} \geq x_{sh}$ than for the other two calculations despite its poor predictions of the upstream flow for the other quantities without conditioning. We briefly recall that the PIV measurements are less accurate in the SBLI region than in the other regions of the boundary layer.

4. Concluding remarks and future work

Two different simulation tools (a hybrid RANS-LES (DDES) and an equilibrium WM-LES) are used to predict an OSBLI problem in a Mach 1.7 flow. The flow is tripped very close to the leading edge in the experiment to insure a turbulent interaction, and both numerical approaches use different techniques to simulate the tripped fully turbulent boundary layer. All calculations compare reasonably well with the overall features in the experiment. While the results of the DDES modeling show an overestimation of the integral values of the boundary layer, the transitional DDES and the WM-LES match well with the boundary-layer characteristics found in the experiment for the supersonic equilibrium flows. The results of DDES show an overestimation of the development of the boundary layer compared to the reference results. Therefore, DDES requires a pre-
Numerical simulations of OSBLI at high Re

conditioning of the upstream boundary layer in an analogy with the WM-LES that used blowing and suction for the tripping in the experiment.

Despite the good agreement with the experiment in the upstream equilibrium boundary layer, all the numerical methods show discrepancies in the zone of the OSBLI. Strong pressure gradient and complex flow features near the wall at the interaction cannot be represented in the numerical methods. Similar to the findings of Dawson et al. (2013), the WM-LES needs to incorporate non-equilibrium dynamics for strong non-equilibrium regions. A possible future approach is the non-equilibrium WM-LES formulation suggested by Park & Moin (2014), which uses a full non-equilibrium formulation to calculate the transient wall shear stress $\tau_w$ and heat flux $q_w$. However, even the full non-equilibrium WM-LES formulation cannot guarantees a more exact prediction in some strongly separated flows (see Balakumar et al. (2014), this volume).

Moreover, in the context of the original TFAST project, a study of the laminar-turbulent transition location can be carried out to analyze the effects of this location on the SBFI and the downstream shear layer properties such as characteristic sizes, coefficients, unsteadinesses.

Acknowledgments

The authors acknowledge use of computational resources from the Certainty cluster awarded by the National Science Foundation to CTR. The authors acknowledge underwrote the French Supercomputing Centers CINES and CALMIP for the CPU allocation that permitted the DDES study. Y. Hoarau (ICUBE - Université de Strasbourg, France) and Technical University of Delft (R. Giepman, F. Schrijer, B. van Oudheusden) for providing the experimental results. This study has been carried out in the context of the TFAST European programme (Transition Location Effect on Shock Wave Boundary Layer Interaction).

REFERENCES


Chapter 5

Conclusion

The present thesis investigated by numerical simulation and turbulence modelling the following unsteady turbulent flows in the high-Reynolds number regime, interesting the domain of industrial applications in the hydrodynamics and aerodynamics domains, covering low subsonic, transonic and supersonic regimes:

1. Unsteady separation and fluid-structure interaction in the incompressible flow around a tandem of cylinders: application in marine hydrodynamics and oil and gas platforms, as well as aerodynamic configuration of the landing gear cylindrical supports.

2. Unsteady separated flows around airfoils in the high-transonic regime involving buffet instability and shock/boundary-layer interaction: application in aircraft flows at cruise speeds with the aim of producing optimal laminar wing design with reduced drag and maximum aerodynamic efficiency. Two configurations characterised by normal shock interaction have been investigated: the flow around the OAT15A (ONERA) and V2C (Dassault-Aviation) airfoils, ATAAC and TFAST European projects test-cases respectively.

3. Supersonic shock reflection and shock/boundary-layer interaction over a profiled plate: application to the future aircraft in supersonic speeds and in flows arising in turbomachinery aero-engines. This test case is also handles by the TFAST European project.

The simulations have been carried out with the NSMB (Navier Stokes Multi-block) code in which we have implemented in the present thesis the $\gamma-\text{Re}_\theta$ transition model (Langtry and Menter, 2009). It is recalled that the present Hi-Fi simulations already demanded a high grid refinement near the walls, leading to grid sizes going up to an order of 30 million points and that the unsteadiness capturing demanded considerable computing times in the national supercomputing centres CINES$^1$ and IDRIS$^2$ and consequently, long ‘human’ times for the results restitution.

---


The main contributions of the thesis are as follows:

1. In the first case, the unsteady loads and complex turbulence structures around and between the tandem cylinders has been predicted by means of statistical and hybrid approaches among which: URANS $k$-$\omega$-SST, OES (Organized Eddy Simulation) and DDES (Delayed Detached Eddy Simulation) involving SST or OES in the statistical part (DDES-SST and DDES-OES). The prediction by the DDES-OES method was able to provide the frequency peak of the Kelvin-Helmholtz instability, responsible for acoustic noise past the downstream cylinder in agreement with the physical experiments carried out in the NASA Langley research Center. Moreover, a good agreement has been obtained in respect of the time-averaged flow structure in comparison with these experiments at Reynolds number 166,000. In the case of vertical motion of the downstream cylinder, the fluid-structure interaction (FSI) was investigated by means of the ALE (Arbitrary Lagrangian Eulerian) method in the NSMB code. It is the first study to our knowledge in which the FSI is predicted in the high-Reynolds number range. The synchronisation (“lock-in”) phenomenon between the lift force and the cylinder’s displacement has been predicted in the low range of the reduced velocity [1, 3] and for a Scruton (mass-damping) number of 1. The progressive increase of the phase-lag between force and displacement has been also predicted in the higher reduced velocity range [4, 10], illustrating the passage from VIV (Vortex Induced Vibration regime) to MIV (Movement Induced Vibration), which has been also an original aspect in the state of the art. These aspects are included in an article under final redaction for the Journal of Fluids and Structures.

2. In the second case, the contribution of this thesis is as follows: URANS one and two-equation turbulence models as well as OES two-equation modelling have been previously investigated concerning their predictive ability of the normal shock and of the buffet phenomenon in the transonic flow around supercritical aerofoils at Reynolds number of 3.3 million. In this case, it has been shown that the OES method was able to predict the evolution of the buffet instability and of the interaction with the von Kármán mode and other trailing-edge instabilities in the wake. This leaded to a detailed analysis of the flow fields by means of wavelets, autoregressive modelling and POD. The interaction of the wake instabilities as for example the von Kármán one on the buffet mode and vice-versa have been clearly pointed out as an original contribution in the state of the art Szubert et al. (2015b). Indeed, most of the studies around buffet were focused on the near-wall dynamics and less on this kind of interactions, able to be suitably used in order to control the buffet instability. These aspects are currently contributing in ongoing studies in the present research group, by manipulating the shear-layer and trailing-edge vortex structures and turbulence by means of electroactive morphing for smart wing design, in collaboration with Airbus “Emerging Technologies and Concepts-Toulouse”. Moreover, a contribution of the present thesis in improved prediction of these instability modes, of pressure and forces is based on an upscale turbulence modelling, investigated in the context of the OES method (the so-called IOES - Improved OES), based on stochastic forcing of the separated shear layer by means of the high-range POD modes. This method is able

---

3 www.smartwing.org
to constrict the turbulent/non-turbulent (TNT) interfaces and to keep them thin against the well known excessive turbulence diffusion tendency produced by direct turbulence cascade modelling in the majority of the turbulence modelling methods, from URANS including DRSM (differential Reynolds stress model) up to LES and hybrid ones. This principle has been inspired from the “eddy-blocking” effect in TNT interfaces, studied by Eames et al. (2011) as well as Ishihara et al. (2015). Therefore, the present approach can be beneficial in a more wide context too. In the present thesis, as a further conjecture similar to the one advanced in the JFM paper by Cantwell and Coles (1983) concerning decomposition of the flow field in phase-averaging and fluctuation, we can suggest a decomposition to an ensemble average and fluctuation. The ensemble average can be described by POD reconstruction by considering a first set of most energetic POD modes, covering the coherent organized motion and the high-energy flow properties. The fluctuation regroups the low-energy POD modes. This fluctuation can be split into two parts, the downscale and upscale ones; the downscale turbulent stresses can be modelled by an advanced URANS or OES approach or similar, ensuring a low eddy-viscosity level. The upscale ones can be modeled by the present stochastic forcing, represented as a source term in the transport equations of the kinetic energy and dissipation rate (Szubert et al., 2015b). Concerning the studies towards a ‘laminar’ wing shape in the transonic regime, the Dassault-V2C aerofoil, the present thesis illustrated the effect of the transition to turbulence position on the ratio lift/drag and depicted the optimal region of the transition position. Thanks to collaboration with INRIA-Sophia Antipolis (research group ACUMES, J. A. Desideri and R. Duvigneau), the transition location was further optimised, based on the present Hi-Fi simulations by using a Kriging approach (cf. Szubert et al., 2015a, under review). The 3D Hi-Fi simulations around the V2C wing (Reynolds number of 3 million) by means of DDES using the Spalart-Allmaras and $k-\omega$-SST models in the statistical part of this hybrid approach, indicated a higher amplitude of the buffet instability than in case of URANS and OES modelling and a strong separation starting practically at the leading edge. The same behaviour with similar hybrid approaches has been reported by the partner of University Roma - “La Sapienza” by M. Bernardini and S. Pirozzoli, in the context of the TFAST European project. The experiments in this project did not yet provide finalised results ready for comparison in the Mach number and incidence range carried out by the present simulations corresponding to the buffet development. Therefore, these simulations have been accomplished as a ‘blind’ test case. The URANS Spalart-Allmaras and $k-\omega$-SST models reached steady state, where the OES-$k$-epsilon model provided, as in the case of the OAT15A, moderate amplitudes of buffet comparing to the DDES results, as well as separation starting downstream than the leading edge. This investigation, including also the DDES-OES-$k-\varepsilon$ modelling, are under continuation within the TFAST project in comparison with the experiments, where IMFT will exploit the experimental pressure signals with the same tools (wavelets, autoregressive modelling, spectral analysis), as in the simulations of Szubert et al. (2015b) in a similar effort as in the previous UFAST European programme concerning the IoA (Institute of Aviation of Warsaw) airfoil. From the 3D physics point of view, the DDES simulations provided a clear representation of the buffet dynamics in
interaction with the complex vortex structure in the separation region, in the shear layers (Kelvin-Helmholtz vortices) and in the wake (3D undulation of the von Kármán vortices), illustrating the development of the well known secondary instability since DNS studies in the same research group (Haase et al., 2002; Braza et al., 2001, among others). Furthermore, a 3D-POD analysis is being in progress based on the present thesis DDES simulations, in order to spatially ‘filter’ this complex vortex dynamics and provide a description of the principal organised modes governing the shock/boundary-layer interaction. An efficient 3D-POD reconstruction is an important step towards building Reduced Order Modelling for the present complex transonic interaction, as previously in our research group in much lower Reynolds number based on DNS in the context of the Ph.D. thesis of R. Bourguet (Bourguet et al., 2009) and in collaboration with INRIA (Bourguet, Braza, and Dervieux, 2011).

3. The contribution of the present thesis in the test-case in the supersonic oblique shock reflection has been carried out in collaboration with the experimental studies carried out in TFAST and coordinated by IUSTI (J. P. Dussauge, P. Dupont). More specifically, the comparisons concern the experiments carried out by the University of Delft partner (TUD) because of several early-stage results provided by this University, as well as comparisons with the LES studies carried out by the group of P. Moin in Stanford University, CA, where this test-case participated in collaboration of IMFT with this Stanford team (P. Moin, I. Jang, G. I. Park et al.) in the bi-annual CTR meeting in July-August 2014 (Szubert et al., 2014b). The principal contribution of this thesis has been the effect of the transition location on the SWBLI. An optimum transition location has been indicated, offering a good comparison with the experiments particularly concerning the velocity profiles of the DDES-Spalart-Allmaras approach with the experiments and the LES results of Stanford, which used a blowing/suction technique in order to trigger the boundary-layer laminar/turbulent transition as in the experiment. Spectral analysis of the pressure signals have depicted predominant frequencies in the range $[10^4, 10^5]$ also reported in previous oblique shock reflection studies by IUSTI (Doerffer et al., 2011; Dussauge et al., 2006). Furthermore, an improved version of the DDES approach suggested by (Shur et al., 2008), the so-called IDDES method, has been used and provided a higher turbulence level in the boundary layer within the SWBLI with a detailed view of the honey-comb and ‘horse-shoe’ vortex structures, similar to experimental visualisations by Cambridge Univ., reported in the book “An Album of Fluid Motion” of M. van Dyke. The IDDES allowed providing details of this complex structure, because the level of resolved turbulence conceptually ensured by this method is higher and closer to the viscous sublayer than in case of DDES, but it appears that the integral parameter levels within the SWBLI are higher than the experimental results and those of the URANS and DDES simulations in this thesis. Therefore, an even finer grid in the boundary layer and along the span is being employed in order to compare the results with the IDDES, as well as with DDES-OES-$k$-$\varepsilon$ methods.

On view of the present concluding discussion, a general comment can be made on the use of more ‘standard’ turbulence models, whose behaviour varied upon the test case used, from the practically incompressible to the supersonic regimes. It has
been seen that no general preference on using DDES over URANS can be stated, because it depends on the test case and Mach number range. The DDES approaches captured and enhanced separation and strong vortex dynamics and turbulence levels within the separated regions around the bodies. The OES and IOES have proved quite successful amplitudes of the global instability, where all methods provided approximately the same order of low frequency instability modes whenever the URANS methods were able keep up with no considerable damping these instabilities. Concerning the spontaneously moving solid structures under the effect of vibrational instability, as well as for analysis of the complex vortex structures in case of normal shock interaction, the POD modal analysis indicates a potential interest and a successful capturing of the dynamic regimes in FSI, offering a realistic flow filed reconstruction, useful for further ROM studies in the design.
Appendix A

Turbulence models

Contents

A.1 One-equation eddy-viscosity models ........................................... 135
  A.1.1 Spalart-Allmaras model ................................................. 135
  A.1.2 Modified Spalart-Allmaras models ................................... 137
    A.1.2.1 Edwards-Chandra model ...................................... 137
    A.1.2.2 Secundov’s compressibility correction ..................... 137
A.2 Two-equation eddy-viscosity models ......................................... 138
  A.2.1 Chien’s $k$-$\varepsilon$ model ....................................... 138
  A.2.2 Wilcox’ $k$-$\omega$ model .......................................... 139
  A.2.3 Menter’s $k$-$\omega$ models ......................................... 139
    A.2.3.1 Baseline model .................................................. 139
    A.2.3.2 Shear Stress Transport model ................................. 141

A.1 One-equation eddy-viscosity models

A.1.1 Spalart-Allmaras model

The Spalart-Allmaras (SA) model (Spalart and Allmaras, 1994) is based on a single
transport equation of a modified eddy viscosity variable $\tilde{\nu}$. It was developed for
aerodynamic flows based upon empiricism and dimensional analysis. In its most
common formulation assuming fully turbulent flow, the non-conservative form of
the transport equation of $\tilde{\nu}$ reads:

$$
\frac{D\tilde{\nu}}{Dt} = c_{b1}\tilde{S}\tilde{\nu} + \frac{1}{\sigma} \left[ \nabla \cdot ((\nu + \tilde{\nu})\nabla\tilde{\nu}) + c_{b2}(\nabla\tilde{\nu})^2 \right] - c_{w1}f_w(r) \left( \frac{\tilde{\nu}}{d_w} \right)^2
$$

(A.1)

where $d_w$ is the distance to the wall.
The eddy viscosity is computed as:

\[ \nu_t = \tilde{\nu} f_{v1}. \]  

(A.2)

The damping function \( f_{v1} \) is a correction for the buffer and viscous layers and is calculated from the local variable \( \chi = \tilde{\nu} / \nu \) as follows:

\[ f_{v1} = \frac{\chi^3}{\chi^3 + c_{v1}^3}. \]  

(A.3)

This function allows the transported variable \( \tilde{\nu} \) to reach the value of \( \nu_t \) in the logarithmic layer.

In the production term, \( \tilde{S} \) is defined as:

\[ \tilde{S} = S + \frac{\tilde{\nu}}{(\kappa d_w)^2} f_{v2} \]  

(A.4)

where \( S \) is a scalar measure of the deformation tensor \( \partial U_i / \partial x_j \), which was originally chosen as the magnitude of the rotation tensor (Spalart and Allmaras, 1994):

\[ S = \Omega = \sqrt{2\Omega_{ij}\Omega_{ij}} \quad \text{where} \quad \Omega_{ij} = \frac{1}{2} \left( \frac{\partial U_i}{\partial x_j} + \frac{\partial U_j}{\partial x_i} \right). \]  

(A.5)

The magnitude of the strain-rate tensor \( S_{ij} = (\partial U_i / \partial x_j + \partial U_j / \partial x_i)/2 \) can be used instead as a measure of the deformation tensor.

The quantity \( \tilde{S} \) involves a second damping function defined as:

\[ f_{v2} = 1 - \frac{\chi}{1 + \chi f_{v1}}. \]  

(A.6)

The destruction term depends on the wall distance and on \( f_w \) which is a non-dimensional function that adjusts the skin friction:

\[ f_w(r) = g \left( \frac{1 + c_w^3}{g^6 + c_w^3} \right)^{1/6} \]  

(A.7)

where

\[ g = r + c_{w2} \left( r^6 - r \right) \quad \text{et} \quad r = \frac{\tilde{\nu}}{\tilde{S} (\kappa d_w)^2} \]  

(A.8)

\( g \) acts as a limiter that prevent large values of \( f_w \) and \( r \) is a near-wall parameter that involves the square of the mixing length \( \sqrt{\tilde{\nu}/S} \). In this way, the destruction is annihilated outside of the boundary-layer region.

The closure constants of the model are:

\[ c_{b1} = 0.1355, \quad c_{b2} = 0.622, \quad \sigma = 2/3, \quad \kappa = 0.41, \quad c_{v1} = 7.1, \]

\[ c_{w1} = \frac{c_{b1}}{\kappa^2} + \frac{1 + c_{b2}}{\sigma}, \quad c_{w2} = 0.3, \quad c_{w3} = 2. \]  

(A.9)

The SA model is robust and low-sensitive to the freestream condition of \( \tilde{\nu} \). It uses trivial Dirichlet boundary conditions and allows \( \tilde{\nu} = 0 \) in the freestream. Spalart and Rumsey (2007) suggest using \( \tilde{\nu}_\infty / \nu \) between 3 and 5 in fully-turbulent computations.
A.1. One-equation eddy-viscosity models

Treatment of laminar region

To allow the simulation of laminar zone as well as to ensure smooth transition to turbulence, the function $f_{t2}$ is introduced and is defined as:

$$f_{t2} = c_{t3} e^{-c_{t4} \chi^2}. \quad (A.10)$$

This function is included in the turbulence model by multiplying the production term of equation A.1 by $(1 - f_{t2})$, resulting in a better stability of the solution when $\tilde{\nu} = 0$. The destruction term is also modified to include $f_{t2}$ in order to balance the budget near the wall, becoming:

$$\left( c_{w1} f_{w}(r) - \frac{c_{b1}}{\kappa^2} \right) \left( \frac{\tilde{\nu}}{d_w} \right)^2. \quad (A.11)$$

The coefficients of the additional function are $c_{t3} = 1.2$ and $c_{t4} = 0.5$.

A.1.2 Modified Spalart-Allmaras models

A.1.2.1 Edwards-Chandra model

Edwards and Chandra (1996) propose a modified version of the Spalart-Allmaras model to fix stability problems related to the original formulation of $\tilde{S}$ (Eq. A.4). This quantity is modified as follows:

$$\tilde{S} = S \left( \frac{1}{\chi} + f_{\nu1} \right) \quad \text{where} \quad S = \left[ \left( \frac{\partial U_i}{\partial x_j} + \frac{\partial U_j}{\partial x_i} \right) \frac{\partial U_i}{\partial x_j} - \frac{2}{3} \left( \frac{\partial U_k}{\partial x_k} \right)^2 \right]^{1/2}. \quad (A.12)$$

Furthermore, the near-wall parameter becomes:

$$r = \frac{\tanh \left[ \frac{\tilde{\nu}}{\left( \tilde{S} \kappa^2 \frac{d^2}{w} \right)} \right]}{\tanh(1.0)} \quad (A.13)$$

According to Edwards and Chandra (1996), such modifications result in a better robustness of the solution in the sublayer, as well as a smooth and rapid convergence while preserving the near-wall accuracy of the original SA model.

A.1.2.2 Secundov’s compressibility correction

As suggested by Spalart and Allmaras (1994), the behavior of the SA model in compressible mixing layers can be improved by using the Secundov’s compressible correction used in the $\nu_t$-92 model (Shur et al., 1995). Effects of the work of compression can be taken into account by adding to the right hand of Eq. A.1 the term:

$$- c_5 \left( \frac{\tilde{\nu}}{a} \right)^2 \frac{\partial U_i}{\partial x_j} \frac{\partial U_i}{\partial x_j}, \quad \text{(A.14)}$$

where $a$ is the local speed of sound and $c_5 = 3.5$ an empirical constant. This correction acts as a destruction term, lowering the eddy-viscosity levels in turbulent region of high deformation to account for the reduced spreading rates of compressible shear layers and can be significant in supersonic flows.
A.2 Two-equation eddy-viscosity models

A.2.1 Chien’s $k\-\varepsilon$ model

The $k\-\varepsilon$ was one of the most popular two-equation turbulence model until the nineties (Spalart, 2000). The $k\-\varepsilon$ of Chien (1982) is one variation frequently used in aerodynamics. It has been developed in order to improve the near-wall flows, in particular the friction coefficient, the heat transfers and the kinetic energy of the fluctuations. In conservation form, the transport equation read:

\[
\frac{D\rho k}{Dt} = \tau_{ij} \frac{\partial U_i}{\partial x_j} + \frac{\partial}{\partial x_j} \left[ \left( \mu + \frac{\mu_t}{\sigma_k} \right) \frac{\partial k}{\partial x_j} \right] - \rho \varepsilon - \frac{2\mu k}{d_w^2} \]  \hspace{1cm} (A.15)

\[
\frac{D\rho \varepsilon}{Dt} = C_{\varepsilon 1} f_1 \frac{\varepsilon}{k} \tau_{ij} \frac{\partial U_i}{\partial x_j} + \frac{\partial}{\partial x_j} \left[ \left( \mu + \frac{\mu_t}{\sigma_\varepsilon} \right) \frac{\partial \varepsilon}{\partial x_j} \right] - C_{\varepsilon 2} f_2 \rho \varepsilon^2 \frac{1}{k} - \frac{2\mu \varepsilon e^{-0.5p_U d_w/\mu}}{d_w^2} \] \hspace{1cm} (A.16)

The eddy viscosity is then computed as:

\[
\nu_t = C_\mu f_\mu \frac{k^2}{\varepsilon} \] \hspace{1cm} (A.17)

This model is based on the equations of Jones and Launder (1972), accounting for the effects of the molecular diffusion of $k$ and $\varepsilon$ on the turbulence structure, and who introduced the three functions $f_1$, $f_2$ and $f_\mu$. $f_1$ is generally equals to the unity. The production/destruction ratio near the wall is adjusted by the $f_2$ function, which is defined as: $1 - (0.4/1.8)e^{-(k^2/6\nu\varepsilon)^2}$. In Eq. A.17, $C_\mu = 0.09$ is the turbulent diffusivity coefficient and $f_\mu$ accounts for the wall damping effect:

\[
f_\mu = 1 - e^{0.0115d_w^+}\] \hspace{1cm} (A.18)

where $d_w^+ = d_w u_r/\nu$ is the normal wall distance, which is not a local variable.

The last term of Eq. A.15 represents the true finite rate of energy dissipation at the wall and is used to balance the molecular diffusion term. The last term of Eq. A.16 acts similarly.

The closure constants of the model are:

\[
C_{\varepsilon 1} = 1.35, \quad C_{\varepsilon 2} = 1.80, \quad (A.19)
\]

\[
\sigma_k = 1.0, \quad \sigma_\varepsilon = 1.3. \quad (A.20)
\]

As boundary conditions, $k = 0$ and $\varepsilon = 0$ at solid wall, $\partial k/\partial x_i = 0$ and $\partial \varepsilon/\partial x_i = 0$ in the farfield.

The variables computed by the models can be used to calculate the turbulence length scale $l$:

\[
l = C_\mu \frac{k^2}{\varepsilon} \] \hspace{1cm} (A.21)
A.2. Two-equation eddy-viscosity models

A.2.2 Wilcox’ $k$-$\omega$ model

This model is not directly used in this study. However, the $k$-$\varepsilon$ presented in previous section and the $k$-$\omega$ SST model (subsection A.2.3.2) have been used instead, among others. As the latest involves the $k$-$\varepsilon$ and the Wilcox’ $k$-$\omega$ models, it is useful to present its equations.

In their first formulation, the two transport equations of the $k$-$\omega$ model of Wilcox (1988) are defined as follows:

$$\frac{D\rho k}{Dt} = \tau_{ij} \frac{\partial U_j}{\partial x_i} + \frac{\partial}{\partial x_j} \left[ (\mu + \sigma_k \mu_t) \frac{\partial k}{\partial x_j} \right] - \beta^* \rho k \omega$$  \hspace{1cm} (A.22)

$$\frac{D\rho \omega}{Dt} = \frac{\omega}{k} \tau_{ij} \frac{\partial U_j}{\partial x_i} + \frac{\partial}{\partial x_j} \left[ (\mu + \sigma_\omega \mu_t) \frac{\partial \omega}{\partial x_j} \right] - \beta \rho \omega^2$$  \hspace{1cm} (A.23)

The turbulent eddy viscosity is computed from:

$$\nu_t = \frac{k}{\omega}$$  \hspace{1cm} (A.24)

The values of the constants are:

$$\beta^* = 0.09, \quad \beta = 3/40, \quad \gamma = 5/9, \quad \sigma_k = 0.5, \quad \sigma_\omega = 0.5.$$  \hspace{1cm} (A.25)

The relation between $\varepsilon$, $\omega$ and $k$ is:

$$\varepsilon = \beta^* \omega k$$  \hspace{1cm} (A.26)

A.2.3 Menter’s $k$-$\omega$ models

In the early nineties, Menter (1994) introduced two new eddy-viscosity models constructed upon an empirical approach and combined the best properties of the Wilcox’ model (see previous section A.2.2 and Wilcox, 1988) with those of a standard $k$-$\varepsilon$ model.

A.2.3.1 Baseline model

The $k$-$w$-transformed equations from the $k$-$\varepsilon$ model are as follows:

$$\frac{D\rho k}{Dt} = \tau_{ij} \frac{\partial U_j}{\partial x_i} - \beta^* \rho k \omega + \frac{\partial}{\partial x_j} \left[ (\mu + \sigma_k \mu_t) \frac{\partial k}{\partial x_j} \right]$$  \hspace{1cm} (A.27)

$$\frac{D\rho \omega}{Dt} = \frac{\omega}{\nu_t} \tau_{ij} \frac{\partial U_j}{\partial x_i} - \beta \rho \omega^2 + \frac{\partial}{\partial x_j} \left[ (\mu + \sigma_\omega \mu_t) \frac{\partial \omega}{\partial x_j} \right] + 2 \rho \sigma_\omega \frac{1}{\omega} \frac{\partial k}{\partial x_j} \frac{\partial \omega}{\partial x_j}$$  \hspace{1cm} (A.28)

After the transformation, the main differences with the original $k$-$\omega$ are the value of the constants and the appearance of an additional cross-diffusion term in the $\omega$ equation. The blending function $F_1$ is introduced to smoothly switch between the
Appendix A. Turbulence models

two formulations and the corresponding variables value. The two sets of equations are added and the formulation of the \( k-w \)-BSL model becomes:

\[
\begin{align*}
\frac{D\rho k}{Dt} &= \tau_{ij} \frac{\partial U_j}{\partial x_i} - \beta^* \rho k \omega + \frac{\partial}{\partial x_j} \left[ (\mu + \sigma_k \mu_t) \frac{\partial k}{\partial x_j} \right] \\
\frac{D\rho \omega}{Dt} &= \frac{\gamma}{\nu_t} \tau_{ij} \frac{\partial U_j}{\partial x_i} - \beta \rho \omega^2 + \frac{\partial}{\partial x_j} \left[ (\mu + \sigma_\omega \mu_t) \frac{\partial \omega}{\partial x_j} \right] + 2(1 - F_1) \rho \sigma_\omega \frac{1}{\omega} \frac{\partial k}{\omega x_j} \frac{\partial \omega}{\partial x_j} 
\end{align*}
\] (A.29) (A.30)

The blending function is defined as:

\[
F_1 = \tanh \left( \arg_1^4 \right),
\] (A.31)

where

\[
\arg_1 = \min \left[ \max \left( \frac{\sqrt{\kappa}}{\beta^* \omega d_w}, \frac{500 \nu}{\beta^*, d_w} \right), \frac{4 \rho \sigma_\omega k}{\kappa} \right]
\] (A.32)

and \( CD_{k\omega} \) is the positive value of the cross-diffusion in Eq. A.30:

\[
CD_{k\omega} = \max \left( 2 \rho \sigma_\omega \frac{1}{\omega} \frac{\partial k}{\omega x_j} \frac{\partial \omega}{\omega x_j}, 10^{-20} \right)
\] (A.33)

In \( \arg_1 \), the first argument is the ratio between the turbulence length scale and the distance to the nearest wall. The second argument forces \( F_1 \) to be 1 in the viscous sublayer whereas the third one ensures that the solution remains insensitive to the freestream. All arguments vanish far from the wall. In this way, \( F_1 \) is equal to one in the viscous and logarithmic layers: the original \( k-\omega \) is activated in these regions. As the wall distance increases, the transformed \( k-\varepsilon \) is progressively activated as \( F_1 \) goes to 0.

The constants of the two models are used and the switch between the “inner” (Wilcox’ \( k-\omega \)) and “outer” (transformed \( k-\varepsilon \)) values is performed the same way as for the transport equation by using the \( F_1 \) blending function:

\[
\phi = F_1 \phi_1 + (1 - F_1) \phi_2
\] (A.34)

\( \phi_1 \) corresponds to the “inner” values (Wilcox, 1988) while \( \phi_2 \) corresponds to the “outer” ones (Launder and Sharma, 1974).

<table>
<thead>
<tr>
<th>( \phi )</th>
<th>( \sigma_k )</th>
<th>( \sigma_\omega )</th>
<th>( \beta )</th>
<th>( \beta^* )</th>
<th>( \kappa )</th>
<th>( \gamma )</th>
</tr>
</thead>
<tbody>
<tr>
<td>( \phi_1 )</td>
<td>0.5</td>
<td>0.5</td>
<td>0.0750</td>
<td>0.09</td>
<td>0.41</td>
<td>( \beta / \beta^* - \sigma_k \kappa^2 / \sqrt{\beta^*} )</td>
</tr>
<tr>
<td>( \phi_2 )</td>
<td>1.0</td>
<td>0.856</td>
<td>0.0828</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Table A.1:** Constant values used in the \( k-\omega \) Baseline model

In that case, \( \sigma_\omega = 0.856 \).

The recommended freestream conditions are:

\[
1 < \frac{\omega L}{U_\infty} < 10 \quad \text{and} \quad 10^{-5} < \frac{k \text{Re}_L}{U_\infty^2} < 10^{-1}
\] (A.35)
where \( L \) is the length of the computational domain. The combination of the two farfield values yields: \( 10^{-5} < \nu_{\infty}/\nu_{\infty} < 10^{-2} \). At solid walls:

\[
\omega = 10\frac{6\nu}{\beta_1 (\Delta d_1)^2} \quad \text{and} \quad k = 0
\]  

(A.36)

with \( \Delta d_1 \) the first-cell height, which should verify \( d^+ \leq 3 \) for \( k-\omega \) models for a correct representation of the boundary layer.

### A.2.3.2 Shear Stress Transport model

This version of \( k-\omega \) model is the same as the Baseline formulation except that \( \sigma_{k1} = 0.85 \) instead of 0.5 and the definition of the turbulent viscosity based on the transported variables is different (Menter, 1994):

\[
\nu_t = \frac{a_1 k}{\max(a_1 \omega, \Omega F_2)}
\]  

(A.37)

where \( \Omega \) is the absolute value of the vorticity (strain can also be used) and \( a_1 = 0.31 \). The function \( F_2 \) is defined as:

\[
F_2 = \tanh \left( \arg_2 \right) \quad \text{with} \quad \arg_2 = \max \left( \frac{2 \sqrt{k}}{\beta^* \omega d_w}, \frac{500 \nu}{d_w^2 \omega} \right).
\]  

(A.38)

The \( F_2 \) function is equal to 1 in the boundary layer and 0 in the free-shear region. In adverse wall pressure gradient, \( \Omega \) is usually larger than \( a_1 \omega \) and the proportionality between the turbulent shear stress and \( k \) is preserved, which is often the case in the boundary-layer region. Other two-equation models, for which the standard definition \( \nu_t = k/\omega \) is used, usually overpredict the eddy viscosity in non-equilibrium adverse pressure gradient flows where the production \( k \) becomes much larger than dissipation. For the rest of the flow, Eq. A.37 reduces to \( \nu_t = k/\omega \).
Appendix B

$\gamma - R_\theta$ laminar/turbulent transition model

Direct Numerical Simulation (DNS) would be the best method in terms of CFD to get the finest estimation of flows. However, due to the limits in the computation speed, it is not yet possible to benefit this method in a satisfactory time, particularly around complex geometries involving wall flows in the industrial context. On the contrary, RANS/URANS methods, involving laminar/turbulent transition modelling, are suitable in most cases.

Many studies have been carried out to develop and include laminar/turbulent transition modelling in RANS codes. A part of them are built from experimental correlations (Granville, 1953; Abu-Ghannam and Shaw, 1980; Mayle, 1991). In that case, the momentum-thickness Reynolds number is correlated to the local flow conditions (pressure gradient or freestream turbulence level) that are easy to calibrate and precise enough to get the main transition phenomena. These criteria have been widely checked. Another part of the transition criteria are the $e^N$ methods and are based on the theory of linear stability (Arnal, 1993). It is used to calculate the increase of the perturbations amplitude between the critical point in the laminar boundary layer and the transition point. When this increase of amplitude $N$ is higher than a threshold, transition goes off. The main issue of these methods is that $N$ is not the amplitudes themselves but the amplification factor of these amplitudes that are a priori unknown (Warren and Hassan, 1998). Moreover, this $N$ factor is not universal and needs to be determined in real conditions (flight, wind tunnel).

In all cases, the laminar boundary layer has to be evaluated up to the transition point. In this way, a dedicated boundary-layer code can be used and coupled to a Navier-Stokes solver to determine the whole flow. This approach allows to compensate the possible low precision of the integral parameters due to the grid resolution near the wall. However, it shows its limits when transition is triggered by a bubble detachment or in 3D, where hypotheses need to be applied to the outer flow. Another strategy consists in implementing these criteria directly in the Navier-Stokes solver without using a separate boundary-layer code, avoiding the possible difficulties of coupling two codes. However, integral values related to the boundary layer still need to be estimated and their calculations are not suitable for massively parallelised code. Finally, several “low-Reynolds” models have been introduced, able to generate transition. However, the position of this transition is often estimated
mush more upstream than the physical results. Moreover, when these models are numerically robust, they are not well sensitive to the pressure gradient and are not able to predict the transition in detached boundary layers.

To overcome the limits of the aforementioned approaches and to benefit the main Navier-Stokes codes structure that are fully parallelised and use local cell values, Menter et al. (2002) first introduced a transport equation of the intermittency based on criteria and flow values already used or calculated by the existing transport equation models and necessary to evaluated the transition location. The intermittency factor $\gamma$ is injected in the transport equation of the turbulent kinetic energy $k$ of the $k$–$\omega$ SST model of Menter (1994). It is equal to 0 in the laminar region of the boundary layer (production of $k$ is annihilated) et 1 everywhere else ($k$ is free to be calculated by the turbulence model). The transport equation of $\gamma$ is based on the vorticity Reynolds number $Re_{\nu}$ (van Driest and Blumer, 1963; Eq. B.1) and can be used to provide a relation between the transition onset Reynolds number $Re_{\theta t}$ from an empirical correlation and the local boundary-layer quantities. Indeed, contrary to $Re_{\theta}$, $Re_{\nu}$ depends only on variables local to each cell.

$$Re_{\nu} = \frac{\rho y^2 \Omega}{\mu} \quad \text{(B.1)}$$

where $y$ is here the distance to the wall. The vorticity Reynolds number is scaled to match the value of the momentum-thickness Reynolds number in the boundary layer, and needs to be compared with the transition onset momentum-thickness Reynolds number. In this case, $Re_{\theta t}$ is evaluated from experimental correlations (e.g. criterium of Abu-Ghanam and Shaw, 1980: $Re_{\theta t}(\lambda_{\theta}, Tu)$ where $\lambda_{\theta}$ is a pressure gradient parameter, and $Tu$ the freestream turbulence level). As this Reynolds number is estimated at the boundary layer interface (by definition), its value needs to be communicated inside the boundary layer to be compared with $Re_{\nu}$. This is achieved by introducing a second transport equation initially described in Menter et al. (2004) and Langtry et al. (2004) and summarized in (Langtry and Menter, 2005). The second transported variable $Re_{\theta t}$ is equals to $Re_{\theta t}$ in the freestream as a function of the local conditions. Its value is then transported inside the boundary layer (where conditions are different).

Several empirical correlations involved in this model, including $Re_{\theta t}(\lambda_{\theta}, Tu)$ and $Re_{\theta c}(Re_{\theta t})$, were not initially published as they were proprietary ($Re_{\theta c}$ is the critical momentum-thickness Reynolds number and used to compare with $Re_{\nu}$ to calculate the location(s) where the instabilities start to grow in the boundary layer upstream the transitional and fully turbulent state). The enthusiasm regarding this transition model was great due to its numerous advantages and several research teams tried to discover or to established themselves these correlations (e.g. Toyoda et al., 2007; Content and Houdeville, 2010) applying in specific situations (bypass transition, low speed wings, high speed flow around compressor and turbine blades, 2D/3D, etc). These correlations have finally been published in 2009 (Langtry and Menter, 2009).

In the context of the TFAST project, among others, it has been decided to implement this correlation-based transition model in the code NSMB. For this work, I summarized all this equations of the model in a single page and has been included in this thesis on the next page. This model have finally been implemented with the precious help from Yannick HOARAU (Laboratoire ICube, IMFS, Strasbourg)
and Jan VOS (CFS Engineering, EPFL, Lausanne). Unfortunately, while there are no more bugs in execution of the model, no final results nor validation are available as this manuscripted is written. However, I find this page of equations useful to anybody who would like to implement the model in a code or to have an overview of it. Nevertheless, for more details about the relation between the equations, their effects and the definition of the symbols, it is highly advised to read the aforementioned references, as well as Langtry (2006) and Content (2011).
Appendix B. $\gamma - R_{\theta}$ laminar/turbulent transition model

$\gamma - R_{\theta}$ LAMINAR-TURBULENT TRANSITION MODEL IN NAVIER-STOKES COMPUTATIONS

ROBIN B. LANGTRY & FLORIAN R. MENTER

EQUATIONS

\begin{align*}
\text{Intermittence } \gamma & \quad & \text{Intermittence with separation } \gamma_{\text{eff}} \\
\frac{\partial (\rho \gamma)}{\partial t} + \frac{\partial (\rho U_i \gamma)}{\partial x_j} &= P_f - E_{\text{length}} + \frac{\partial}{\partial x_j} \left[ \left( \mu + \frac{\mu_t}{\sigma} \right) \frac{\partial \gamma}{\partial x_j} \right] \\
P_f &= \frac{\text{Fonset} \cdot e_{\text{eff}} \rho S(\gamma) \left( F_{\text{onset}} \right)^{0.5}}{\theta_{\text{eff}}} \\
F_{\text{onset1}} &= \frac{2.193 R_{\theta} \left( \theta_{\text{eff}} \right)}{\text{Re}_u} \\
F_{\text{onset2}} &= \max \left( \text{max} (F_{\text{onset1}}, \text{F}_{\text{stage}}), 2.0 \right) \\
F_{\text{onset3}} &= \max \left( 1 - \frac{R_{\theta}}{2.5}, 0 \right) \\
F_{\text{onset}} &= \max \left( F_{\text{onset2}} - F_{\text{onset3}}, 0 \right) \\
\theta_{\text{onset}} &= \min \left( 0, 1.623 \times 10^{-6} \text{Re}_{\theta} - 1.228 \times 10^{-3} \text{Re}_{\theta} + 0.849 \right) \\
\text{Fonset} &= \exp \left( 1.325 \times 10^{-8} \text{Re}_{\theta}^{-3} + 7.42 \times 10^{-7} \text{Re}_{\theta}^{-3} \\
&\quad + 8.16 \times 10^{-7} \left( \text{Re}_{\theta} - 2.5652 \right) \right) \\
\text{Fonset} &= \begin{cases} 
3.9819 \times 10^{-1} - 119.276 \times 10^{-4} \text{Re}_{\theta}^{-1} \\
-132.567 \times 10^{-4} \text{Re}_{\theta}^{-1} \\
263.404 - 123.39 \times 10^{-3} \text{Re}_{\theta}^{-1} \\
+194.548 \times 10^{-4} \text{Re}_{\theta}^{-1} \\
-101.695 \times 10^{-5} \text{Re}_{\theta}^{-1} \\
400 \leq \text{Re}_{\theta} < 506 \\
0.5 - \left( \text{Re}_{\theta} - 506.0 \right) \times 3.0 \times 10^{-26} \text{Re}_{\theta}^{-3} \\
506 \leq \text{Re}_{\theta} < 1200 \\
0.5388 \end{cases} \\
\text{F} = \text{Fonset} \cdot e^{-\left( \frac{\theta}{\theta_{\text{onset}}} \right)^2} \\
\rho_{\text{eff}} &= \frac{\text{F} \cdot \sigma_f \rho \mu_t}{\sigma} \\
\theta_{\text{eff}} &= \frac{\text{F} \cdot \sigma_f \rho \mu_t}{\sigma} \\
\text{F} &= \left( \rho \frac{U}{\mu} \right) \\
\text{Re}_{\theta} &= \left[ 1173.51 - 589.42TU + \frac{0.2196}{T^2} \right] \cdot F(\lambda_0) \\
\text{F} &= 331.50 \left( T - 0.5658 \right) - 0.671 \cdot F(\lambda_0) \\
\text{F} &= 1 - \left[ -12.986 \lambda_0 - 123.66 \lambda_0^2 - 405.689 \lambda_0^3 \right] e^{-\left( \frac{\theta}{\theta_{\text{onset}}} \right)^2} \cdot \lambda_0 \leq 0 \\
\text{F} &= 1 + 0.275 \times \left[ 1 - e^{-35.0 \lambda_0} \right] e^{-\left( \frac{\theta}{\theta_{\text{onset}}} \right)^2} \cdot \lambda_0 > 0
\end{align*}

\begin{align*}
\text{Boundary conditions} & \quad \text{Constants} \\
\text{For } \gamma \text{ equation:} & \quad \sigma_f = 1.0 & \sigma_\theta = 2 (= 10 \text{ in CH2010}) \\
\text{Walls: zero normal flow} & \quad c_{\gamma 1} = 1.0 & c_{\theta 1} = 0.03 \\
\text{Inlet: } \gamma = 1 & \quad c_{\gamma 1} = 1.0 & c_{\theta 1} = 2.0 \\
y^+ & \approx 1 (\leq 1 ?) & c_{\theta 2} = 50.0 & c_{\theta 3} = 0.06
\end{align*}

\begin{align*}
\text{References} & \\
\text{Robin B. Langtry, A Correlation-Based Transition Model using Local Variables for Unstructured Hybrid CFD codes, PhD thesis, 2006} \\
\text{Robin B. Langtry and Horans R. Menter, Correlation-Based Transition Modelling for Unstructured Parallelised Computational Fluid Dynamics Code, AIAA Journal, Vol 47, No 12, december 2009} \\
\text{C. Content and B. Houzeville, Application of the } \gamma - R_{\theta} \text{ laminar-turbulent model in Navier-Stokes computations, AIAA Fluid Dynamics Conference and Exhibit, Chicago, Illinois, 2010} \\
\end{align*}
Appendix C

Tecplot 360

Contents

C.1 Quick start ......................................................... 148
   C.1.1 Load data ................................................. 148
   C.1.2 2D data .............................................. 148
   C.1.3 3D data .............................................. 150
   C.1.4 XY lines ............................................. 151
   C.1.5 Export and save .................................... 151
C.2 In more details .................................................. 152
C.3 Scripting ......................................................... 154
   C.3.1 Overview .............................................. 154
   C.3.2 Examples ............................................. 154

Tecplot 360 is one of the Tecplot family software tools developed by Tecplot, Inc. It is a powerful post-processing software that is widely used in CFD and numerical simulation in general. ParaView is an equivalent software, which is available under BSD license, imposing minimal restrictions on the redistribution of the software, and allowing to include and reuse part or all of it in a free or proprietary software, contrary to Tecplot. Paraview is able to load Tecplot data file.

The aim of this appendix is to give some hints to use Tecplot, based on my experience, in order for new users to start to use it quickly to plot 2D and 3D fields as well as XY lines and have basis to explore the menus, understand the philosophy of the software and develop their own scripts. Many more possibilities, options, parameters, compositions are available in Tecplot and the user is highly invited to read the documentation to produce high quality graphs and field images, static or animated. Only Tecplot format files are considered here.
Appendix C. Tecplot 360

C.1 Quick start

C.1.1 Load data

Data are loaded via the menu File > Load data file(s). Then, the format of the data file has to be selected in the list (Tecplot 2013). It is the Tecplot one by default. The file(s) is (are) selected in the next window. In Tecplot 2013, to load multiple files, click on the corresponding button in the Tecplot data loader window. Select the files in the corresponding list, then click on the Add button, and finally on OK. The next step is for choosing the initial plot type. This depends on the data to be displayed. Specific menus and tools will be available depending on this plot type, which can be changed later.

Data can also be directly loaded while opening Tecplot in a terminal:

```
tecplot data_file.dat
```

After having loaded the data, the white rectangle that appears and that contains the axis and all the elements of the visualization is the frame. Its properties will be modified later.

C.1.2 2D data

While 2D fields can be displayed in the 3D cartesian mode, this 2D mode is the most suitable to deal with this type of data.

- After having loaded the data, Tecplot might not identify correctly the axis variables from the data file, or the user might want to choose other than the default ones (XZ instead of XY for example). This can be modified in the menu Plot > Assign XY.

- Zoom can easily be modified by clicking on the middle/3rd button of the mouse and holding it down while moving the cursor up or down. Similarly, the data can be translated by using the right button of the mouse.

- The frame defines the aspect ratio of the image that is exported. This aspect ratio might not be adapted to the content of the plot. It can be modified in the menu Frame > Edit active frame. In the Edit active frame window, the width and height of the frame can be changed. In the same window, the border of the frame (and thus, the border of the exported image) can be removed, as often envisaged.

- On the left sidebar, several layers can be displayed (mesh, blocks edges...). The field of the physical variables can be displayed by toggling-on Contour. The properties of the contour plot are modified by clicking on the button just near the Contour box. The contour variable is selected at the top of the Contour & Multi-coloring Details window. The other properties are defined in specific tabs:

  - Coloring: when Banded color distribution is selected, color levels are discrete and defined by the levels selected in the corresponding tab (see
C.1. Quick start

However, when **Continuous** is selected, the whole colormap is continuously distributed between minimum and maximum values, independently of the contour levels. These two values can be defined manually, or set to the Min/Max values of the current contour variable, or set to the Min/Max values of the defined contour levels. The latest choice is often the best. The colormap distribution can be reversed by ticking the box at the bottom of the window.

- **Levels**: the entries of the legend are defined in this tab. When **Banded** color distribution is selected in the **Coloring** tab (see previous point), it defines also the color levels. However, it has no effect at all on the color distribution when **Continuous** is selected in the **Coloring** tab. By clicking on the **New levels** button, a new levels distribution is defined between minimum and maximum values, and by the number of levels between these two values or by a step value (**Delta**).

**Procedure to define the levels (suggestion):**

1. Select **Banded** color distribution in the **Coloring** tab.
2. Defined the levels in the **Levels** tab.
3. When you are satisfied with the levels distribution go back to the **Coloring** tab, toggle-on **Continuous** and reset the color limits to Min/Max contour levels to have a continuous color distribution (if needed).

Another way consists in defining first the Min/Max values of the continuous color distribution, and then to define the levels distribution between these Min/Max values.

- **Legend**: the orientation of the legend can be changed from vertical to horizontal (**Alignment** parameter). Its position can also be precisely defined (**X** and **Y** parameters, as a percentage of the frame size, depending of the anchor alignment). The space between the levels defined in the legend is modified with the **Line spacing** parameter. The header and number font properties are also defined in this window. Finally, it is common to have the legend in a white **filled** box without edge (set **Legend box** to **filled**, and **Box color** to white). The parameter to change the internal margin between the box edges and its content is **Margin**.

- **Probing** data in the contour field can be helpful to have precise values of the field at specific locations, but also to define the contour levels and the color distribution limits. Probe tool is activated by clicking on the corresponding button in the tool bar, just below the menu bar. Then, the user can click anywhere in the field: the **Probe** window opens and displays all the field values at the specific points, including the coordinates. By selecting **Zone/Cell info** at the top of this window, it gives information of the block where the data has been probed, as well as the **I**, **J** (and **K**) coordinates in the context of structured grids. This can be helpful to determine the orientation of the grid, block by block. Finally, by clicking twice on the same tool button (or menu **Data > Probe at**), data can be probed at specific axis coordinates (**Position** tab in the small **Probe at** window; this is useful to find block number and **I**, **J**
Appendix C. Tecplot 360

and K coordinates of a point to monitor the time-dependent evolution of the physical field at this point) or at grid coordinates (Index tab).

- **Axis properties** are modified via the menu Plot > Axis. Properties of each axis can be modified separately, by selecting the corresponding axis at the top of the Axis Details window. Axis can also be deactivated by unselecting the corresponding tick box, as often in 2D and 3D plots. However, a white space is remaining around the plot zone, between this zone and the border of the frame. This margin can be removed or modified in the Area tab. By entering 0% for left and bottom, and 100% for right and top, the margin is totally removed and the plot zone occupies the whole frame. As observed, the size of this area can be adapted side by side to fit the labels and title position and size, that should be modified (increased font size; see corresponding tabs) in purpose to export the plot as an image for publication. By default, Tecplot chooses automatically the more suitable step in labels. However, if the user wants to specify another step, this can be done in the Labels tab, by unselecting Auto Spacing and entering a specific value just after. A fixed line (to identify one specific value) can be drawn by selecting Marker gridline in the Grid tab and choosing Constant as the Position marker. This function was not found in version 2014. Other properties are quite straightforward and will not be developed here.

C.1.3 3D data

Most of the commands presented for 2D data are also available in 3D mode. However:

- Tecplot sometimes adapts the aspect ratio of the whole domain when loading data when it is far from 1. The aspect ratio can be redefined to the original one in the menu Plot > Axis.... In the Dependency section of Range tab, XYZ Dependent has to be selected and X to Y and X to Z ratios have to be set to 1. The original shape of the geometry is recovered.

- In 3D, contours are plotted on slices. Slices are activated in the left sidebar and their properties can be modified by clicking on the corresponding "..." (details) button. The orientation and the location of the slice(s) are defined in the first tab. The contours properties are defined as in 2D mode, by opening the Contour & Multi-Coloring Details window ("...") (details) button on the left sidebar, near Contour activation box, or in the Contour tab).

- **Isosurfaces** are a suitable way of displaying data in 3D. They are activated in the left sidebar, similarly to slices, and their properties are modified by clicking on the details button nearby. This opens the Iso-surfaces details window. The variable used to define the isosurfaces as well as the isosurface level(s) (1, 2 or 3 specific values or the levels in the contour properties can be used; see the Draw iso-surfaces at parameter) are chosen in the first tab. Many style options are available in the second tab. Isosurfaces are colored by contours (flood). In this case, another variable can be used to color the isosurfaces (see parameter Flood by). Another contour group needs to be defined (C1, C2...).
Remark: In 3D mode, Tecplot 2014 might display orange dashed lines that define boxes containing the blocks of the domain. They are supposed to not be displayed in exported images. These lines are also deactivated when blocks edges are displayed (but these edges are printed in exported images).

C.1.4 XY lines

In XY Line mode, most of the lines properties are defined in the Mapping style window. This window is opened by clicking on the corresponding button on the left sidebar. In this window, one row in the array corresponds to one line (one map) in the graph. To modify the properties of specific line(s), the corresponding row(s) need(s) to be selected. Then, the user have to click on the header of the column (Tecplot 2013) or right-click directly on the cell (Tecplot 2014) to modify the corresponding property.

- In the first tab, the X and Y variables as well as the zone of the data can be chosen. Each zone corresponds to a data set. When several data sets are imported, new zones are created and have to be properly selected in this array. The map name defines the entry in the legend. By default, it is set to the Y variable. However, this is often not the best choice. An alternative is to set it to zone name and, if necessary, change the name of the zone(s) (menu Data > Data set info).

- Lines properties are modified in the Lines tab. Same for Symbols, in their dedicated tab. To be displayed, Lines and Symbols needs to be activated in the left sidebar.

- The legend is activated via the menu Plot > Line legend.

- Extra axis can be added in the Definitions tab, column Which Y-Axis (or Which X-Axis if needed). Properties of each axis can be modified via the menu Plot > Axis (see more detailed explanation for 2D fields, subsection C.1.2). To plot the grid border (usually on top and on the right of the axis zone), the user needs to activate them in the Lines tab (Show grid border parameter).

Remark: the rendering of exported image (lines pattern in particular) is sometimes no satisfying and does not correspond to what is displayed on the screen. The reason may come from a huge density of data (too many data points in a small X interval). In this case, the density of displayed points can be reduced in the Indices tab in Mapping style (column I-Index Range; change Skip parameter from 1 to 100, 1000... for instance).

C.1.5 Export and save

- The frame can be exported to a vectoriel or a bitmap image, via the menu File > Export. The format can be selected from the list at the top of the Export window. For each format, specific options are proposed. By default, the EPS images are exported in black and white. They can be exported in colors simply by ticking the corresponding option. This vector graphics format
Appendix C. Tecplot 360

is typically used to export XY lines (graphs). It should not by used to export 2D and 3D fields. Raster graphics formats like PNG are recommanded instead. For this format, the width of the image in pixels should be given (the default resolution is quite low). The height is given by the aspect ratio of frame size. Antialiasing should be used (the default factor, 3, is often sufficient).

• The plot can be saved in a layout file (menu File > Save layout). It is an ASCII file linked to the data file(s) (its (their) name(s) is (are) given at the beginning of the layout). Tecplot finds in the layout file all the necessary properties to be able to plot the data as it has been saved, including colormap definition as well as equations and functions used to alter data or calculate new variables (see section C.2). When opening a layout file, Tecplot loads the corresponding data and applies all the properties saved in the layout. Layouts can be used to load other data files, as long as these data have the same structure as the original one (number and position of variables, grid size, etc...).

Frame style files have a similar role, except that they don’t contain the data file(s) name(s), nor any altering equations of the data, nor information concerning the colormap. However, they are very useful in scripting (see section C.3). The frame style is saved in the menu Frame > Save frame style.

C.2 In more details

• Information about the loaded data (number of zones/blocks, variables, number of elements...) can be found in the menu Data > Data set info. From this menu, the name of the variables and of the zones can be changed. This can have an influence on the axis title, the legend header, etc...

• Superscript characters can be inserted by using <sup>...</sup>. Similarly, the markups <sub>...</sub> are used to insert subscript characters. For greek characters, the markups <greek>...</greek> are used (for example, <greek>\omega</greek> gives \(\omega\)).

• The user can alter data by entering equations, in the menu Data > Alter data. Existing variables can be refered by their exact name, into braces (e.g. \{u\}). The second way is to use the position of the variables in their list (e.g. V1, V2). The first method allow to not take in account the order of the variables, but their name have to be exactly the same from a dataset to another one if they need to be reused. However, variables names can become very complex (e.g. \{<greek>\omega</greek><sub>z</sub><sub>(s^{-1})</sub>\}) and the second method is prefered in this situation. Several equations can be entered (one line per equation), and they can be saved in a file (ASCII) and loaded later. For more complex usage of equations (derivatives, internal variables...), the user is invited to read the documentation.

Remark: equations are saved in layouts, but not in frame style files. If the user wants to use frame style files to plot calculated variables, these variables

\[^1\) This expression gives \(\omega_z (s^{-1})\)
C.2. In more details

need to be calculated before. However, they are automatically calculated when opening layouts.

- **New variables** related to the field or the grid can also be directly calculated by Tecplot in a very simple way. To process these new variables, Tecplot may need to know some field variables. They are defined in the menu Analyse > Field variables. Don’t forget to select Velocity instead of Momentum in the new window, if this applies. Once data are indentified, a series a new variables are calculated via the menu Analyse > Calculate variables. Calculate on demand should be deactivated when there is enough memory (RAM). New variables are added at the end of the list of the existing ones.

- A set of many predefined colormaps is available in Tecplot. In version 2014 of Tecplot 360, the colormap is selected directly in the list at the top of the Coloring tab in the Contours details/properties (see subsection C.1.2). In version 2013, the user needs to click on the "..." button. This opens the Color map window and allows to change the current colormap, but also to change its distribution and the colors defined at specific control points (click on the ▲ and ▼ buttons to select the control point, then change the red, green and/or blue levels).

- When time dependent data are loaded (by loading multiple files for example; see subsection C.1.1), specific information need to be given to Tecplot, via the menu Data > Edit time strands. In the case of 2D or 3D fields, Multiple zones per time steps needs to be selection, and the number of zones per time step have to be given (usually the number of block in the domain). Specific information on time is given in the Solution time zone. Select Constant delta and change the Initial and the Delta (physical time step) values as desired, and click on the Apply button. The animation controls appear in the left sidebar.

Remark: Time dependent data can be exported in a video format by clicking on the "..." (details) button near the animation controls. In the Time animation details window, select To file in Destination, then click on Animate to file. In the Export window that just opens, the format of the file can be selected, as well as the size of the images and the animation speed. Flast (SWF) format is suitable of the web. AVI and MPEG-4 formats can give codec problems. This is the reason why it is preferable to process and export data time step by time step in image format (e.g. PNG), using scripts with internal loop (see section C.3), and then using an external program to build a video file from the series of images.

- Tecplot can be executed in a terminal in batch mode (i.e. without launching the graphical user interface), by using the option -b. This mode is very useful to process big amount of data on a remote computer having enough memory (RAM). Scripts are executed in batch mode using the option -p. The complete command is:

        tecplot -b -p script_file.mcr

Remark: antialiasing is not available in batch mode.
Appendix C. Tecplot 360

C.3 Scripting

C.3.1 Overview

Tecplot allows for using scripts to simplify the repetition of data post-processing and accelerate it. A specific language is used and documentation on Tecplot scripting is available. Two examples are given here. However, if the user needs more functions or commands, scripts can be recorded while manipulating the Tecplot interface. The recording is launched in menu Scripting > Record macro and by specifying a script file name. All the user operations will be saved step by step in the script file, and the corresponding commands can be reused and adapted.

C.3.2 Examples

The two examples given here are a good basis to start to use scripts, in particular when processing a series of data set by using loops.

In the first example (listing C.1), data are loaded and altered explicitly, the colormap is modified to apply a frame style. Then, a text is insert (containing here the current time step in the case of time dependent data with edited time information; see section C.2). Finally, the current frame is exported in PNG and deleted to load a new data set at the next loop step.

The second example (listing C.2) shows the interest of using frame styles when several variables needs to be displayed and exported to images, by loading data once (with the layout) and then applying one or several frame styles.

All examples are well commented to understand each step.

<table>
<thead>
<tr>
<th>Listing C.1: Tecplot script example</th>
</tr>
</thead>
</table>
| #!MC 1400
| # Define new variables.
| $!VARSET |FILENBR| = 20
| $!VARSET |FIRSTINDEX| = 10
| $!VARSET |IDXSTEP| = 2
| # The loop goes from 1 to |FILENBR| (here, 20).
| $!LOOP |FILENBR|
| # Inside the loop, the variable |LOOP| is the current step (1, 2, 3...).
| # To do arithmetics, parenthesis are required.
| $!VARSET |INDEX| = ((|FIRSTINDEX|+(|LOOP|-1)*|IDXSTEP|))
| ### Read data.
| $!READDATASET '"AIRFOIL_|INDEX%05d|.plt"' ,
| READDATAOPTION = NEW
| RESETSTYLE = YES
| INCLUDETEXT = NO
| INCLUDEDGEOM = NO
| INCLUDEDCUSTOMLABELS = NO
| VARLOADMODE = BYNAME
| ASSIGNSTRANDIDS = YES
| INITIALPLOTTYPE = CARTESIAN2D
| VARNAMELIST = '"X" "Y" "Z" "VELOx" "VELOy" "VELOz" "MACH" "PRES"', |
### Modify data by means of new variables and equations. Variables can be identified by their name (inside braces) and their number in the variables list (V1, V2...).

```plaintext
$!ALTERDATA
  EQUATION = '{u}={u}/|umax|'
$!ALTERDATA
  EQUATION = 'V1=V1-0.034'
```

### Define or change the colormap.

```plaintext
$!GLOBALCOLORMAP 1 CONTOURCOLORMAP = SMRAINBOW
```

### Read and apply a frame style.

```plaintext
$!READSTYLESEXIT "AIRFOIL_Mach.sty"
  INCLUDEPLOTSTYLE = YES
  INCLUDETEXT = YES
  INCLUDEGEOM = YES
  INCLUDEAUXDATA = YES
  INCLUDESTREAMPOSITIONS = YES
  INCLUDECONTOURLEVELS = YES
  MERGE = NO
  INCLUDEFRAMESIZEANDPOSITION = YES
```

### Insert text at X=2% of the data area, from the left, and Y=97% from the top.

```plaintext
$!ATTACHTEXT
  ANCHORPOS
  {
    X = 2
    Y = 97
  }
  TEXTSHAPE
  {
    ISBOLD = YES
    HEIGHT = 14
  }
  ANCHOR = HEADLEFT
  TEXT = 't = &(SOLUTIONTIME%.5f) s'
```

### Export to a png image of width 1024 pixels, applying default antialiasing.

```plaintext
$!EXPORTSETUP EXPORTFORMAT = PNG
$!EXPORTSETUP IMAGEWIDTH = 1024
$!EXPORTSETUP USESUPERSAMPLEANTIALIASING = YES
$!EXPORTSETUP EXPORTFNAME = 'AIRFOIL_Mach_|INDEX%05d|.png'
$!EXPORT
  EXPORTREGION = CURRENTFRAME
```

### Delete the active frame and data to load a new set of data in a new frame.

```plaintext
$!FRAMECONTROL DELETEACTIVE
```

---

155
Listing C.2: Tecplot script example: frame style interest

```plaintext
# !MC 1400
$!VARSET |FILENBR| = 20

# The loop goes from 1 to |FILENBR| (here, 20).
$!LOOP |FILENBR|

### Open layout (Load data once, calculate normalised coordinates, plot the Mach field with a specific colormap).
$!OPENLAYOUT "layout_AIRFOIL_Mach_|LOOP%05d|.lay"

### Export Mach field to a png image.
# Here, |LOOP%05d| gives 00001, 00002...  
$!EXPORTSETUP EXPORTFORMAT = PNG  
$!EXPORTSETUP IMAGEWIDTH = 1024  
$!EXPORTSETUP USESUPERSAMPLEANTIALIASING = YES  
$!EXPORTSETUP EXPORTFNAME = 'AIRFOIL_Mach_|LOOP%05d|.png'  
$!EXPORT
  EXPORTREGION = CURRENTFRAME

### Read and apply a frame style to plot pressure field.
# Data have already been loaded and data altered by opening the layout. It is not necessary to do these operations again, saving time, particularly when loading 3D data.
$!READSTYLESHEET "AIRFOIL_pressure.sty"
  INCLUDEPLOTSTYLE = YES  
  INCLUDETEXT = YES  
  INCLUDEGEOM = YES  
  INCLUDEAUXDATA = YES  
  INCLUDESTREAMPOSITIONS = YES  
  INCLUDECONTOURLEVELS = YES  
  MERGE = NO  
  INCLUDEFRAMESIZEANDPOSITION = YES

### Export pressure field to a png image.
$!EXPORTSETUP EXPORTFORMAT = PNG  
$!EXPORTSETUP IMAGEWIDTH = 1024  
$!EXPORTSETUP USESUPERSAMPLEANTIALIASING = YES  
$!EXPORTSETUP EXPORTFNAME = 'AIRFOIL_pressure_|LOOP%05d|.png'  
$!EXPORT
  EXPORTREGION = CURRENTFRAME

### Delete the active frame and data to load a new set of data in a new frame.
$!FRAMECONTROL DELETEACTIVE

$!ENDLOOP

$!REMOVEVAR |FILENBR|
```

156
Appendix D

Monitoring files extractor GUI

I created a Matlab graphical user interface (Fig. D.1) that allows for processing the ASCII monitoring files generated by NSMB in a fast and easy way. The user needs to give the path of these data files and select the appropriate parameters from the computation. The programme identifies the files (one file per monitoring point), displays a progression bar while reading the data, and concatenate them in Matlab or ASCII format (one file per variable), for a faster post-processing. The programme can also save the time evolution of the variables as graphs in png or pdf format.

Figure D.1: Matlab graphical user interface of the programme to extract data from NSMB monitoring files.
Appendix D. Monitoring files extractor GUI
Bibliography


URL https://dx.doi.org/10.1016/S0045-7930(02)00100-7.


URL https://dx.doi.org/10.1023/B%3AAPPL.0000014932.28421.9e.

URL https://dx.doi.org/10.3166/remn.16.451-476. [10]

URL https://dx.doi.org/10.1017/S0022112005004076.

URL http://ethesis.inp-toulouse.fr/archive/00000705. [36]


URL https://dx.doi.org/10.1063/1.3234398. [132]


CONTENT, C. and HOUDEVILLE, R. Application of the $\gamma - r_0$ laminar-turbulent transition model in Navier-Stokes computations. In 40th Fluid Dynamics Conference and Exhibit, Chicago, IL, 28 June - 1 July 2010. URL https://dx.doi.org/10.2514/6.2010-4445. [144]


GIRIMAJI, S., HAASE, W., PENG, S., and SCHWAMBORN, D., editors. Progress in Hybrid RANS-LES Modelling, Papers Contributed to the 5th Symposium on Hybrid RANS-LES Methods, Vol. 130 of Notes on Numerical Fluid Mechanics and Multidisciplinary Design, College Station, A&M University, TX, 19-21 March 2014. URL https://dx.doi.org/10.1007/978-3-319-15141-0. [2]


Holmes, P., Lumley, J. L., and Berkooz, G. *Turbulence, coherent structures, dynamical systems and symmetry*. Cambridge Univ. Press, 1996. [27 and 31]


URL https://dx.doi.org/10.2514/1.30190.


URL https://dx.doi.org/10.2514/6.2006-3202. [16]


URL https://dx.doi.org/10.2514/3.12292. [9 and 10]

URL https://dx.doi.org/10.1023/A:1008306431147.

URL https://dx.doi.org/10.1016/0017-9310(72)90076-2. [138]


URL https://dx.doi.org/10.2514/1.23690. [15]


166


Research, Stanford, CA, July - August 2014b.

URL https://dx.doi.org/10.1016/j.euromechflu.2015.09.007. [131]

URL https://dx.doi.org/10.1016/j.jfluidstructs.2015.03.005. [11, 16, 45, 52, 130, and 131]


URL https://dx.doi.org/10.1007/s10494-005-0557-z.


URL https://dx.doi.org/10.2514/6.2007-4286. [144]


URL https://dx.doi.org/10.2514/3.1784. [144]


Les objectifs de cette thèse sont d'étudier les capacités prédictives des méthodes statistiques URANS et hybrides RANS-LES à modéliser des écoulements complexes à haut nombre de Reynolds. Ces travaux traitent de configurations étudiées dans le cadre des projets européens AT AAC (Advanced Turbulent Simulation for Aerodynamics Application Challenges) et T FAST (Transition Location Effect on Shock Wave Boundary Layer Interaction). Premièrement, l’écoulement décollé autour d’une configuration cylindre en tandem, positionnés l’un derrière l’autre, est étudié à un nombre de Reynolds de 166000. Un cas statistique, correspondant schématique aux supports de train d’atterrissage, est d’abord considéré. L’interaction fluide-structure est ensuite étudiée dans le cas dynamique, dans lequel le cylindre aval possède un degré de liberté en translation dans la direction perpendiculaire à l’écoulement. Une étude paramétrique est menée afin d’identifier les différents régimes d’interaction en fonction des paramètres structuraux. Dans un deuxième temps, la physique du tremblement transsonique est étudiée au moyen d’une analyse temps-fréquence et d’une décomposition orthogonale en modes propres (POD), dans l’intervalle de nombre de Mach 0.70–0.75. Les interactions entre le choc principal, la couche limite décollée par intermittence et les tourbillons se développant dans le sillage, sont analysées. Un forçage stochastique, basé sur une réinjection de turbulence synthétique dans les équations de transport de l’énergie cinétique et du taux de dissipation générée à partir de la reconstruction POD, a été introduit dans l’approche OES (organised-eddy simulation). Cette méthode introduit une modélisation de la turbulence “upscale” agissant comme un mécanisme de blocage par tourbillons capable de prendre en compte les interfaces turbulent/non-turbulent et de couches de cisaillement autour des géométries. Cette méthode améliore grandement la prédiction des forces aérodynamiques et ouvre de nouvelles perspectives quant aux approches de type moyennes d’ensemble pour modéliser les processus cohérents et aléatoires à haut nombre de Reynolds. Enfin, l’interaction onde de choc/couche limite (SWBLI) est traitée, dans le cas d’un choc oblique à nombre de Mach 1.7, contribuant aux études de “design d’ailes laminaires” au niveau européen. Les performances des modèles URANS et hybrides RANS-LES ont été analysées en comparant, avec les résultats expérimentaux, les valeurs intégrales de la couche limite (épaisseurs de déplacement et de quantité de mouvement) et les valeurs à la paroi (coefficients de frottement). Les effets de la transition dans la couche limite sur l’interaction choc/couche limite sont caractérisés.